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Определение физических констант материалов участвующих в решении 

задач в ANSYS 

Общая характеристика 

Построение геометрической модели - процесс достаточно трудоемкий. 

Однако для дальнейшей работы с существующей моделью следует задать 

физические постоянные, необходимые для решения задачи. В этом разделе 

мы несколько отступим от сложившейся практики приведения и пунктов 

главного меню совместно с командами. Это обусловлено тем, что, с одной 

стороны, команды определения свойств гораздо сложнее графических 

команд, а с другой стороны, если использование команд при создании 

геометрии модели, ее редактировании и разбиении зачастую оправдано, то 

использование команд при определении свойств материала будет только 

затруднять понимание. 

Выбор типа решаемой задачи 

Тип определяет физическую задачу (теплообмена, механики твердого 

тела и др.), которая будет решаться. Это позволяет активизировать лишь те 

пункты главного меню, которые соответствуют указанному типу, и делает 

недоступными пункты главного меню, которые не будут использоваться при 

решении данной задачи.  

Выбор типа осуществляется с использованием пункта главного меню: 

Main Menu> Preferences … 

При использовании данного пункта, появляется диалоговое окно 

Preferences for GUI Filtering (Рисунок 1), в котором необходимо установить 

флаг напротив типа решаемой задачи и подтвердить выбор с помощью 

кнопки OK или отказаться от сделанного выбора с помощью кнопки Cancel. 
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Рисунок 1. Выбор типа решаемой задачи 

 

После выполнения указанных действий остаются доступными только 

пункты главного меню, непосредственно связанные с выбранным типом 

решаемой задачи. 

 

 

Выбор физической модели 

Определение физических свойств материалов 

Определение физических свойств материалов можно осуществить с 

помощью следующего пункта главного меню: 

Main Menu> Preprocessor> Material Props> Material Models 

С помощью этого пути пользователь получает доступ к главному окну 

Define Material Model Behavior (Рисунок 2), с помощью которого он получает 

возможность не только определить физическое поведение материала, но и 

указать конкретные значения необходимых констант.  
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Рисунок 2. Окно Define Material Model Behavior 

 

Указанное диалоговое окно разделено на две  части: 

Material Models Defined и Material Models Available. В 

Material Models Defined указывается список номеров моделей материалов 

определенных к настоящему времени. Если пользователь только приступил к 

определению физической модели и ее постоянных, то «по умолчанию» 

определено только одно имя материала Material Model Number 1.  

В Material Models Available перечисляются все физические модели 

доступные при решении типов задач, указанных в диалоговом окне 

Preferences for GUI Filtering. Из перечисленных в окне 

Material Models Available моделей необходимо выбрать интересующий 

материал. Это осуществляется с помощью пунктов окна 

Material Models Available. 
В ANSYS существует большое количество моделей материалов, 

поэтому для облегчения работы с ними пункты окна 

Material Models Available представлены в виде древовидной структуры, 

перемещаясь по которой пользователь переходит от общих пунктов к более 

частным. В нашем случае имеются три корневых пункта Favorites, Structural 

и Thermal, раскрывая которые пользователь получит доступ к параметрам 

конкретных моделей. Для того чтобы развернуть пункт или свернуть его, 

следует сделать на нем двойной щелчок мышью. 

Например, если пользователь собирается решить задачу механики 

твердого тела, то в пункте Structural имеются подпункты Linear (линейное 

деформирование материалов), Nonlinear (нелинейное деформирование 

материалов) и д.р. 
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Если у пользователя возникает необходимость использовать несколько 

материалов с различными физическими свойствами, то, используя меню 

главного диалогового окна Define Material Model Behavior, он получает 

возможность сделать это следующим образом: 

Define Material Model Behavior> Material> New Model … 

При этом в появившемся окне Define Material ID (Рисунок 3) и 

одноименном поле ввода необходимо ввести порядковый номер нового 

материала («по умолчанию» следующий по порядку номер) и подтвердить 

выбор, нажав OK или отказаться от выполнения операции, нажав Cancel.  

 

 
Рисунок 3. Окно назначения номера материала 

 

Если новый материал создан, то в окне Material Models Defined 

(определенные модели материалов) главного окна 

Define Material Model Behavior появится новая строка 

Material Model Number 2. После этого можно осуществить выбор физической 

модели для второго материала и ввод значений физических констант. 

Удаление материала 

Для удаления ненужного материала необходимо в окне 

Material Models Defined с помощью «мыши» выбрать материал с 

необходимым номером и использовать пункт меню: 

Define Material Model Behavior> Material> Delete 

 

Понятие о задачах теплообмена, решаемых в ANSYS 

Наиболее простым из физических явлений, которые позволяет решать 

ANSYS являются задачи теплообмена. Их решение играет важную роль в 

многих инженерных расчетах, включая расчеты двигателей внутреннего 

сгорания, турбин, трубопроводов и д.р. При их решении представляет 

интерес расчет распределения температур. Кроме того, можно использовать 

термический анализ для вычисления термических напряжений, т.е. 
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напряжений, возникающих благодаря температурному расширению или 

сжатию. 

 

Общие сведения 

Понятие «теплообмен» охватывает совокупность таких явлений, суть 

которых заключается в переносе некоторого количества тепла из одной 

области пространства в другую. Общая теория теплообмена обычно 

разделяется на два раздела: перенос тепла в твердом теле и перенос тепла в 

жидкости. Перенос в общем случае может осуществляться в трех, 

совершенно различных по своей природе формах: теплопроводности, 

конвекции и излучении. Вместе с тем необходимо подчеркнуть, что 

распространение тепла в твердом теле происходит благодаря только 

теплопроводности. Поэтому в настоящем пособии рассматриваются, главным 

образом, процессы распространения тепла, объясняющиеся 

теплопроводностью. 

Перенос тепла посредством теплопроводности обусловлен наличием 

вещественной среды, и тем, что теплообмен совершается только между 

непосредственно соприкасающимися частицами тела. Этот процесс можно 

представить как распространение тепла от частицы к частице.  

Теория теплопроводности полностью отвлекается от молекулярного 

строения вещества и соответственно рассматривает вещество как континуум 

– непрерывную среду. 

ANSYS проводит два типа термического анализа:  

1. Термический анализ установившихся (стационарных) процессов  

определяет распределения температур и остальных величин при 

установившихся условиях на границе. Установившиеся условия на 

границе это ситуация, когда их изменение во времени может 

игнорироваться (стационарная задача). 

2. Термический анализ краткосрочных процессов определяет 

распределение температур и других величин при условии их 

существенного изменения во времени. 

Стационарные задачи теплообмена вычисляют эффекты при 

стационарных термических условиях, как на границах системы компонент, 

так и внутренних сосредоточенных источниках (усилиях). Инженеры и 

исследователи часто решают стационарные задачи в качестве первого 

приближения. Поэтому в этой книге уделено внимание первому типу анализа, 

т.е. решению стационарных задач. 
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Простейшие тепловые свойства 

Тепловые свойства определяются с помощью выделенного 

элементарного объема в сплошной среде (Рисунок 4). 

 
Рисунок 4. Схема теплообмена через одну из граней параллелепипеда 

 

Если оси координат (Рисунок 4) совпадают с главными направлениями 

теплопроводности, то известно, что количество тепла, проходящей через 

выделенную изотермическую площадку (например, грань параллелепипеда, 

перпендикулярную оси ОХ) в единицу времени, определяется величиной 

коэффициента теплопроводности в указанном направлении.  

Разделы, касающиеся выбора физических моделей теплопроводности и 

ввода их числовых значений расположены в разделе Conductivity. Его 

составляющие становятся доступны пользователю при использовании 

следующего пункта в окне Define Material Model Behavior (Рисунок 5). 

Define Material Model Behavior> Material Models Available> Thermal> 

Conductivity 

 
Рисунок 5. Выбор характеристик теплопроводности 

 

З а м е ч а н и е! Составляющие подпункты пунктов Thermal и 

Conductivity в окне Material Models Available открываются двойным 

щелчком «мыши». 
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Тело с изотропной теплопроводностью 

Если коэффициенты теплопроводности совпадают во всех 

направлениях, то тело называется изотропным, и необходимо ввести один 

коэффициент. Для ввода коэффициента теплопроводности следует 

воспользоваться первым пунктом (Isotropic) раздела Conductivity: 

Define Material Model Behavior> Material Models Available> Thermal> 

Conductivity> Isotropic 

При его использовании появляется окно 

Conductivity for Material Number 1 (Рисунок 6). После этого необходимо 

заполнить поле с меткой KXX значением коэффициента теплопроводности 

для изотропного тела. Окончание ввода необходимо подтвердить нажатием 

кнопки OK или отказаться от ввода нажатием кнопки Cancel.  

 

 
Рисунок 6. Окно определения теплопроводности для изотропного 

материала 

 

З а м е ч а н и е! Если коэффициент не зависит от температуры, то нет 

необходимости заполнять поле Temperatures. 

 

Тело с ортотропной теплопроводностью 

Тело называется ортотропным, если оно имеет три различные значения 

теплопроводности по разным направлениям. При его использовании 

необходимо определить значения всех коэффициентов, используя пункт окна 

Define Material Model Behavior: 
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Define Material Model Behavior> Material Models Available> Thermal> 

Conductivity> Orthotropic 

При его использовании появляется окно 

Conductivity for Material Number 1 (Рисунок 7). После этого необходимо 

заполнить поля с метками KXX, KYY, KZZ соответствующие вводу 

коэффициентов теплопроводности для ортотропного тела. Окончание ввода 

необходимо подтвердить нажатием кнопки OK или отказаться от ввода 

нажатием кнопки Cancel. 

 

 
Рисунок 7. Окно поределения характеристик теплопроводности 

ортотропного материала: KXX – поле ввода значений коэффициента 

теплопроводности в элементе в 0Х-направлении; KYY - поле ввода значений 

коэффициента теплопроводности в элементе в 0Y-направлении; KZZ - поле 

ввода значений коэффициента теплопроводности в элементе в 0Z-

направлении 

З а м е ч а н и е! Если коэффициенты не зависят от температуры, то 

нет необходимости заполнять поле Temperatures. 

 

Задачи механики твердого тела 

Механические свойства материалов 

Обычные детали (твердые тела) обладают комплексом свойств: 

тепловыми, механическими и др. В этом разделе рассмотрим механические 

свойства. 
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Различные материалы ведут себя по-разному при различных уровнях 

нагрузки, т.е. в каком-то диапазоне напряжений определенный материал 

ведет себя как линейно-упругий, в другом диапазоне он деформируется 

пластически и т.д. (различия будут рассмотрены ниже). В тоже время, другой 

материал может практически во всем диапазоне нагрузок вести себя как 

нелинейно-упругое тело. Если при этом учесть, что границы диапазонов 

меняются в зависимости от температуры, то становится очевидным, что 

установить универсальный закон деформирования для всех материалов нет 

возможности.  

С другой стороны все эти особенности поведения материалов привели к 

тому, что в настоящее время применяются различные модели для описания 

связи напряжений и деформаций при различных условиях. Следует отметить, 

что при решении задач механики сплошной среды, инженер часто 

отвлекается от неоднородности материала. Это оправданно тем, что в 

подавляющем числе практических задач представляет интерес не поведение 

каждой молекулы (атома), а общее состояние тела. 

Инженер, заранее зная, что именно ему необходимо исследовать для 

какой-либо конструкции в рамках реального диапазона нагрузок, делает 

предположение о характере деформирования ее элементов. И таким образом 

выбирает, какая физическая модель деформирования будет использоваться.  

При этом для получения конкретного результата, инженер должен 

определить численные значения ряда физических параметров характерных 

для выбранной модели. 

Кратко рассмотрим основные возможности ANSYS при использовании 

тех или иных моделей и способов задания соответствующих констант. 

 

Понятие о тензоре напряжений 

Как известно из курса сопротивления материалов, детали меняют свои 

размеры и форму (деформируются) под действием внешних сил. В них 

возникают внутренние усилия, величина и распределение которых зависит от 

действующей нагрузки и геометрии (формы) тел.  

Рассмотрим деталь произвольной формы, находящуюся в равновесии, 

под действием внешних нагрузок (Рисунок 213). Предположим, что 

воображаемое сечение плоскостью Z0Y делит тело на два объема – V1 и V2 . 

Можно условно отбросить один из объемов, заменив его действие 

соответствующими усилиями на поверхности сечения. В нашем случае в 

окрестности с площадью ΔS любой точки А поверхности сечения действуют 

сила величиной ΔP и момент величиной ΔM. Будем предполагать, что 
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направление нормали в точке А и направление действия силы ΔP совпадают 

(в общем случае это не так). Кроме того, положение системы координат 

выбрано так, что направление вектора нормали ν к поверхности сечения 

(граница объема V2) в данном случае совпадает с единичным направляющим 

вектором ex оси 0X.  

 

 
Рисунок 8. Сечение твердого тела с приложенными нагрузками 

 

Тогда можно определить вектор напряжений, действующих в точке A 

вдоль нормали ν: 

 

  






S

Plim
0S

. 

 

В соответствии с предположениями, сделанными выше (Рисунок 8), 

получаем, что в данном случае σν = σx. Таким образом, определяется 

напряжение, действующее на площадку, перпендикулярную оси OX. 

Отметим, что если напряжения положительные, то в данной точке тела 

происходит растяжение вдоль выбранной нормали, а если отрицательные – то 

сжатие.  

Напряжения в точке в других направлениях вдоль осей 0Y, 0Z 

глобальной системы координат определяются аналогично. Однако следует 

отметить, что в пространственном случае, для удобства вокруг точки A, 

находящейся в объеме тела, вырезается прямоугольный параллелепипед, 

грани которого перпендикулярны осям глобальной системы координат, а 

ребра параллельны им и имеют малые длины (Рисунок 9). При этом 

нормальные напряжения (напряжения, действующие перпендикулярно 
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выбранной грани) обозначаются σиндекс индекс (в ANSYS обозначается 

S«постфикс»), где индекс («постфикс») указывает направление глобальной 

системы координат, на площадке перпендикулярно которой действует данное 

напряжение, например σxx (в ANSYS - SX) (Рисунок 9).  

Касательные напряжения обозначаются σиндекс1 индекс2 (в ANSYS 

обозначается S«Постфикс1 Постфикс2»). Они действуют в плоскости 

выбранной грани, например σxz (в ANSYS - SXZ) (Рисунок 9). 

Учитывая условие симметричности σij = σji, то получаем для любой 

точки A твердого тела 6 компонент тензора напряжений: σxx, σyy, σzz, σxy, σyz, 

σxz. Либо обозначив оси координат x1, x2, x3 получим следующие компоненты: 

σ11, σ22, σ33, σ12, σ23, σ13. 

 

 
Рисунок 9. Выбор элементарного прямоугольного параллелепипеда с 

центром в точке A твердого тела 

 

Понятие о тензоре деформаций 

Если рассмотреть элементарный прямоугольный параллелепипед, 

находящийся в равновесии только под действием приложенных к его двум 

противоположным граням нормальных напряжений (например, σxx), то его 

длина в направлении действия нагрузки изменится по сравнению с размером 

до приложения нагрузки (увеличится, если приложенные напряжения 

являются растягивающими или уменьшится, если напряжения - сжимающие). 

Это явление называется деформированием, а мера изменения размера – 

деформацией.  
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Рисунок 10. Элементарный параллелепипед с приложенными к его 

граням нагрузками 

 

Деформации определяют, в частности, относительное изменение 

размеров параллелепипеда вдоль осей системы координат и часто 

обозначаются в литературе εxx, εyy, εzz. Например, εxx = ΔLx/Lx, где Lx - длина 

ребра параллелепипеда в направлении действия нагрузки до момента ее 

приложения, а ΔLx - изменение длины ребра в указанном направлении после 

прикладывания нагрузки (Рисунок 10). В ANSYS для деформаций 

используется обозначение EP«постфикс», где постфикс указывает какие 

именно деформации исследуются. Кроме того, изменение прямых углов 

параллелепипеда под действием нагрузки обычно обозначается через εxy, εyz, 

εxz. В последнем случае индексы указывают, в какой проскости происходит 

сдвиг.  

Аналогично компонентам тензора напряжений получаем шесть 

компонент тензора деформаций: εxx, εyy, εzz, εxy, εyz, εxz. Либо обозначив оси 

координат x1, x2, x3, получим следующие компоненты: ε11, ε22, ε33, ε12, ε23, ε31. 

 

Основные физические законы деформирования твердых тел 

Для решения задачи механики твердого тела необходимо установить 

физическую связь между деформациями и напряжениями, учитывающими 

особенности поведения материала детали (твердого тела), находящегося под 

воздействием внешних нагрузок. 

В разделе, посвященном решению задач твердого тела, 

рассматриваются следующие физические модели деформирования:  

 Линейное деформирование (упругость); 
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 Нелинейное деформирование материала (нелинейная упругость, 

пластичность); 

 

Модель линейного деформирования при постоянной температуре. 

Общие сведения 

Традиционно наиболее широко используемой моделью является модель 

упругого линейного деформирования материалов (закон Гука). В рамках этой 

модели решается подавляющее большинство конструкторских задач. 

Объясняется это тем, что после снятия нагрузки любая деталь должна 

приобрести первоначальную форму. Это является залогом ее 

работоспособности в дальнейшем. 

Традиционно пояснение особенностей деформирования твердых тел 

осуществляется на хорошо известной зависимости напряжений от 

деформаций для цилиндрических образцов при одноосном растяжении. В 

рассматриваемом случае диаграмма имеет наиболее простой вид (Рисунок 

11). 

Стрелками указывается направление изменения напряжений при 

увеличении (стрелка сверху) и уменьшении (стрелка снизу) деформации. При 

упругом деформировании, деформация является обратимой, т.е. после снятия 

нагрузки деформация полностью исчезает. 

Вернемся к рисунку параллелепипеда с приложенными напряжениями 

(Рисунок 10). В рассматриваемом случае связь деформаций и напряжений в 

любом направлении системы координат подчиняется линейному закону. 

Дополнительно предположим, что при деформации вследствие действия на 

гранях только равномерно-распределенных нормальных напряжений прямые 

углы элементарного параллелепипеда не искажаются.  

 

 
Рисунок 11. Зависимость напряжений от деформаций при одноосном 

растяжении образца 
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Прикладывая поочередно одинаковую нагрузку к двум 

противолежащим граням можно определить величины деформаций 

(удлинений) в трех взаимно перпендикулярных направлениях. При этом 

будем предполагать, что касательные напряжения оказывают влияние только 

на изменение углов прямоугольного параллелепипеда, а не его длины. Тогда:  

 Если деформации (удлинения) во всех направлениях равны при 

одинаковой величине равномерно распределенных нормальных 

напряжений, то говорят, что тело является изотропным.  

 Если деформации (удлинения) равны только в двух 

направлениях, то говорят, что тело имеет плоскость изотропии.  

 Если нормальные деформации различны по всем направлениям, 

то говорят, что это ортотропное тело (или тело, имеющее три 

плоскости упругой симметрии).  

Однако когда существует направление, при котором касательные 

напряжения, действующие на любых гранях параллелепипеда, оказывают 

влияние не только на изменение углов прямоугольного параллелепипеда, но и 

на изменение длины в каком-либо направлении, или наоборот, нормальные 

нагрузки оказывают влияние на деформации сдвига, то говорят, что это 

анизотропное тело. 

Запись обобщенного закона Гука в пространственном случае не 

отличается от одномерного, если использовать тензорную форму (т.е. запись 

с использованием векторов и матриц): 

 

σij = Eijkl εkl, 

 

где σij - тензор (вектор) напряжений, εkl - тензор (вектор) деформаций, Eijkl - 

тензор (матрица) модулей упругости. Тензор модулей упругости – это 

симметрическая матрица 6 – го порядка (6 столбцов на 6 строк). Она 

содержит коэффициенты упругости, описывающие деформацию в 

соответствующем направлении. 

Условие симметричности тензора относительно главной диагонали 

матрицы иммеет следующее выражение: 

 

Eijkl = Eklij. 

 

Обобщенный закон Гука можно обратить, выразив деформации через 

напряжения, тогда 
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εij = Dijkl σkl, 

 

где Dijkl - тензор упругих податливостей (жесткостей). 

В н и м а н и е! Только для упругого изотропного тела коэффициенты 

тензора не зависят от ориентации выделенного параллелепипеда 

относительно системы координат. 

Вид тензора и, соответственно, количество независимых 

коэффициентов, которые должен определить инженер для решения 

поставленной задачи, существенно зависит от того, какая физическая модель 

твердого упругого тела рассматривается. 

Разделы, касающиеся выбора физических моделей линейной 

деформации твердого тела (изотропной, ортотропной или анизотропной) и 

ввода их числовых значений расположены в разделе Elastic. Ее составляющие 

становится доступны пользователю при использовании следующего пункта в 

окне Define Material Model Behavior (Рисунок 12): 

 

Define Material Model Behavior> Material Models Available> Structural> 

Linear> Elastic 

 

 
Рисунок 12. Выбор раздела, касающегося определения свойств линейных 

материалов 
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Изотропные материалы. Пункт главного меню 

Исходя из вышесказанного, деформацию (удлинение) параллелепипеда 

из изотропного материала в любом направлении определяет один модуль 

Юнга (EX в обозначениях ANSYS), а деформацию в поперечном направлении 

при растяжении/сжатии - коэффициент поперечной деформации Пуассона 

(PRXY в ANSYS - главный коэффициент Пуассона). Изменение же прямых 

углов параллелепипеда при приложении касательных усилий определяет 

модуль сдвига (GXY), вычисляемый через модуль упругости и коэффициент 

Пуассона: EX/(2(1+PRXY)).  

Таким образом, для решения задачи для изотропных тел, достаточно 

задать пару постоянных: модуль Юнга (EX) и коэффициент поперечного 

расширения Пуассона (PRXY). Это можно сделать с помощью пункта в окне 

Define Material Model Behavior: 

Define Material Model Behavior> Material Models Available> Structural> 

Linear> Elastic> Isotropic 

При его использовании появляется окно 

Linear Isotropic Properties for Material Number … (Рисунок 13), в котором 

следует определить требуемые значения (EX, PRXY). После этого 

необходимо подтвердить окончание ввода нажатием кнопки OK или 

отказаться от проведения данной операции нажатием кнопки Cancel. 

Многоточие в названии окна указывает на номер материала, который 

определяет пользователь.  

В данном случае нет необходимости обращаться к коэффициентам 

тензора модулей упругости либо упругих податливостей. Важно лишь 

помнить, что значение тензора определяют только два коэффициента. При 

этом для удобства использования остальные члены тензора (кроме этих двух) 

не доступны пользователю и автоматически вычисляются.  

 

 
Рисунок 13. Окно определения свойств линейных изотропных 

материалов 
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Для того, что бы сделать переход к ортотропным или анизотропным 

телам более наглядным, приведем явный вид тензора упругих податливостей 

Dijkl в обозначениях принятых в ANSYS: 

 
1 0 0 0

1 0 0 0

1 0 0 0

0 0 0 1 0 0

0 0 0 0 1 0

0 0 0 0 0 1

/ EX PRXY / EX PRXY / EX

PRYX / EX / EX PRXY / EX

PRYX / EX PRYX / EX / EX

( PRXY ) / EX

( PRXY ) / EX

( PRXY ) / EX

  
 
 
 
  
 

 
 
 

  

 

 

 

Ортотропные материалы. Пункт главного меню 

В этом случае нормальную деформацию параллелепипеда из 

ортотропного материала в любом направлении определяет три модуля Юнга 

(EX, EY, EZ), деформацию в поперечном направлении при 

растяжении/сжатии – три коэффициента поперечной деформации Пуассона 

(PRXY; PRYZ; PRXZ; где PRXY, PRYZ, PRXZ – главные коэффициенты 

Пуассона), а изменения прямых углов параллелепипеда модули сдвига (GXY, 

GYZ и GXZ).  

Определить упругие постоянные, соответствующие применению 

ортотропной модели, можно с использованием следующего пункта в окне 

Define Material Model Behavior: 

 

Define Material Model Behavior> Material Models Available> Structural> 

Linear> Elastic> Orthotropic 

 

При его использовании появляется окно Linear Orthotropic 

Properties for Material Number … (Рисунок 14), в котором следует ввести 

требуемые значения. После этого необходимо подтвердить окончание ввода 

нажатием кнопки OK или отказаться от проведения данной операции 

нажатием кнопки Cancel. Многоточие в названии окна указывает на номер 

материала, который определяет пользователь. Выбор коэффициента Пуассона 

(главного или младшего) осуществляется с помощью кнопки 

Choose Poisson’s Ratio в указанном окне. 
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Рисунок 14. Окно определения свойств линейных ортотропных 

материалов 

 

В ортотропном случае также приведем тензор упругих податливостей 

Dijkl в обозначениях принятых в ANSYS: 

 
1 0 0 0

1 0 0 0

1 0 0 0

0 0 0 1 2 0 0

0 0 0 0 1 2 0

0 0 0 0 0 1 2

/ EX PRYX / EY PRZX / EZ

PRXY / EX / EY PRZY / EZ

PRXZ / EX PRYZ / EY / EZ

/( GYZ )

/( GXZ )

/( GXY )

  
 
 
 
  
 

 
 
 

  

 

 

Как видно из представления тензора упругих податливостей, в нем 

фигурируют шесть различных коэффициентов Пуассона. Но независимых 

только три PRXY, PRYZ, PRXZ. Остальные коэффициенты вычисляются 

автоматически, при решении через указанные величины и заданные значения 

модулей упругости, следующим образом: 

 

PRYX=PRXY*EY/EX,   PRZY=PRYZ*EZ/EY,   PRZX=PRXZ*EZ/EX. 
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З а м е ч а н и е! Если необходимо решать задачу для ортотропного тела, 

то все 9 независимых значений должны быть введены. Однако, если будет 

введены все одинаковые значения для модулей Юнга (EX, EY и EZ), 

коэффициентов Пуассона (PRXY, PRYZ, PRXZ) и модулей сдвига (GXY, 

GYZ и GXZ) и, при этом значения последних будут вычисляться по 

правилу EX /(2(1 + PRXY)), то в этом случае будет рассматриваться 

изотропное тело. Это следует из вида соответствующих тензоров. 

 

Анизотропные материалы в ANSYS 

В ANSYS версии 10 ввод коэффициентов тензора податливости Dijkl 

Flexibility Form, так же как и определение коэффициентов тензора жесткости 

Eijkl Stiffness Form, может быть осуществлен с помощью определения 

членов матрицы с использованием команд. В более поздних версиях это 

можно сделать также с использованием пункта главного меню.  

Матрица (тензор) должна быть симметрической и положительно-

определенной (определитель матрицы должен быть больше нуля). Поэтому 

полная 6 x 6 матрица упругих податливостей Dijkl имеет только 21 

независимое значение упругих констант, приписанных к напрявлениям x, y, z, 

xy, yz, xz и т.д. Приведем вид тензора Dijkl: 
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Эта 21 независимая константа обычно компактно располагаются 

располагаются либо в нижнем «треугольнике» (выделена полужирным 

шрифтом), либо в верхнем «треугольнике» тензора Dijkl, а остальные значения 

доопределяются из условия симметричности относительно главной 

диагонали.  

З а м е ч а н и е! В зависимости от версии выбор треугольника тензора 

для заполнения может изменяться, так в версии ANSYS 10 ED 

заполняется верхний «треугольник» тензора. 
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В ANSYS используется несколько упрощенное представление тензора 

упругих податливостей (но вполне корректное). Это упрощение касается 

индексирования элементов тензора: 
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Можно заметить, что, используя тензор упругих податливостей, 

описывающий деформацию анизотропного тела, можно в качестве частного 

случая получить тензор упругих податливостей изотропного или 

ортотропного тел. Для этого нужно соответствующим образом расставить 

значения. 

З а м е ч а н и е! К сожалению, в ANSYS используется только одно 

обозначение для тензоров жесткости и податливости. В обоих случаях 

он обозначается [D]. 

Как и ранее при задании свойств материалов ограничимся 

комментариями к меню графического интерфейса. 

Пункт главного меню 

Определить упругие постоянные, соответствующие применению 

анизотропной модели, можно с использованием следующего пункта в окне 

Define Material Model Behavior: 

Define Material Model Behavior> Material Models Available> Structural> 

Linear> Elastic> Anisotropic 

При его использовании появляется окно 

Anisotropic Elasticity for Material Number … (Рисунок 15), в котором следует 

определить требуемые значения тензора жесткости. После этого необходимо 

подтвердить окончание ввода нажатием кнопки OK или отказаться от 

проведения данной операции нажатием кнопки Cancel. Многоточие в 

названии окна указывает на номер материала, который определяет 

пользователь. 
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Рисунок 15. Окно определения свойств анизотропных материалов 

 

Особенности решения плоских задач теории упругости 

Отдельно остановимся на особенностях численного решения плоских 

задач теории упругости. В этом случае должен быть создана плоская модель в 

рабочей плоскости X0Y. Существует две опции решения плоских задач 

механики твердого тела: плоское напряженное состояние (Plane Stress) и 

плоская деформация (Plane Deformation). Выбор этих опции возможен 

только для конкретных типов плоских элементов и выбираются в 

выпадающем меню Element Behavior окна ...element type options. Многоточие 

указывает, что вместо него будет подставлен тип конкретного элемента, для 

которого будут указаны опции. Это окно вызывается нажатием кнопки 
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Options… окна Element Types. Последнее появляется с использованием 

пункта главного меню: 

Main Menu> Preprocessor> Element Type> Add/ Edit/ Delete 

Модели плоского напряженного состояния и плоской деформации 

широко используются при расчете конструкций. Рассмотрим более подробно, 

в чем состоит различие между плоским напряженным и плоским 

деформированным состоянием. Предположим, что произвольная плоская 

модель имеет единичную толщину.  

При плоском напряженном состоянии в направлении оси 0Z, 

перпендикулярной плоскости X0Y рисунка (экрана), нет напряжений, но есть 

строго определенные деформации. Например, если сжать монету 

равномерной нагрузкой, приложенной к ее ребру, то в центре, благодаря 

коэффициенту Пуассона, она станет толще. 

При плоском деформированном состоянии (или плоской деформации) в 

направлении оси 0Z, перпендикулярной плоскости X0Y рисунка, деформация 

отсутствуют, но есть строго определенные напряжения. Например, если 

приложить равномерное давление к внутренней или внешней поверхности 

длинной трубы, то у любого поперечного фрагмента единичной толщины 

(исключая края трубы) будут отсутствовать деформации, т.к. труба не 

удлиняется, но будут присутствовать напряжения, появление которых 

объясняется воздействием на данный фрагмент соседних фрагментов трубы. 

При решении плоских задач теории упругости, так же, как и при 

решении пространственных, необходимо задать упругие постоянные. 

Далее для изотропного тела они указываются способом, указаным 

выше. Необходимо запомнить, что для ортотропного тела вводятся только EX 

и EY (с различными значениями) при этом значения GXY и PRXY также 

необходимо определить. В случае анизотропного тела для двумерных задач, 

тензор приобретает размерность 4 x 4 с коэффициентами, приписанными к 

направлениям x, y, z, xy. В этом случае необходимо определить только 10 

констант {D11, D12, D13, D14, D22, D23, D24, D33, D34, D44}. Порядок 

(последовательность значений) вектора предполагается как {x, y, z, xy, yz, xz}.  

З а м е ч а н и е! Плоские задачи необходимо решать только с помощью 

соответствующих элементов. 

Дополнительные замечания о некоторых линейных константах 

Коэффициент демпфирования материала (DAMP) является 

дополнительным средством учета демпфирования для динамического 



 

 

25 

анализа. Вводить значение коэффициента необходимо только тогда, когда 

различные части модели имеют различные значения коэффициента 

демпфирования. Это осуществляется с помощью следующего пункта в окне 

Define Material Model Behavior (Рисунок 16): 

Define Material Model Behavior> Material Models Available> Structural> 

Damping> Constant 

При его использовании появляется окно 

Damping for Material Number … (вместо многоточия указывается номер 

материала, для которого в настоящий момент вводится коэффициент 

демпфирования). В нем необходимо указать значение коэффициента DAMP. 

 

 
Рисунок 16. Окно определения коэффициента демпфирования 

 

При решении некоторых задач в частности необходимо указывать 

плотность вещества (DENS), из которого выполнено тело. Она имеет 

следующую размерность: Единица веса/ единицу объема. Указать плотность 

вещества можно с использованием следующего пункта в окне 

Define Material Model Behavior: 

Define Material Model Behavior> Material Models Available> Structural> 

Density 

При его использовании появляется окно Density for Material Number … 

(вместо многоточия указывается номер материала, для которого в настоящий 

момент вводится коэффициент демпфирования). В нем необходимо указать 

значение коэффициента DENS (Рисунок 17). 
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Рисунок 17. Окно определения плотности материалов 

 

 

Нелинейно-деформируемые изотропные материалы 

Несмотря на то, что наиболее употребляемой моделью в 

конструкторских расчетах является модель линейного деформирования 

материала (закон Гука). Однако существует достаточно много технических 

задач, в которых необходимо провести анализ, не укладывающийся в рамки 

этого простейшего случая. Наиболее интересными с прикладной точки зрения 

вариантами деформирования материалов, являются нелинейная упругость и 

пластичность. 

Далее рассмотрены следующие физические модели (с указанием их 

названий) поведения изотропных материалов. используемые в ANSYS. 

 Упругость (MELAS - мультилинейная упругость); 

 пластичность, независящая от скорости деформирования:  

1. BKIN - билинейное кинетическое упрочнение (учитывает 

эффект Баушингера); 

2. MKIN - многолинейная кинематическая пластичность 

(учитывает эффект Баушингера);  

3. BISO - билинейное изотропное упрочнение (не учитывает 

эффект Баушингера); 

4. MISO - многолинейное изотопное упрочнение (не 

учитывает эффект Баушингера); 

Для того чтобы выбрать конкретную модель поведения материала 

можно, как и в случае с упругими материалами, использовать пункты 
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главного меню. Все перечисленные модели находятся в пункте Nonlinear> в 

окне Define Material Model Behavior: 

Define Material Model Behavior> Material Models Available> Structural> 

Nonlinear> 

 

Многолинейная упругость 

Многолинейная упругость определяется опцией MELAS. Физическая 

сторона вопроса состоит в том, что в данном случае у материала на 

диаграмме растяжения участок, на котором можно было приближенно 

использовать линейную связь между деформациями и напряжениями, мал 

(Рисунок 18). И практически при любой значительной деформации 

напряжения выходят сразу за пределы этого участка. 

 

 
Рисунок 18. Зависимость напряжений от деформаций при одноосном 

растяжении образца для нелинейного материала 

 

Стрелками указывается направление изменения напряжения при 

увеличении (стрела сверху) и уменьшении (стрелка снизу) деформации. Как 

видно из рисунка, при упругом деформировании формоизменение является 

обратимым, разгрузка в этом случае происходит по тоже кривой, что и 

нагружение, и после снятия нагрузки деформация полностью исчезает, как и 

в линейном случае, т.е. тело полностью восстанавливает свою 

первоначальную форму. 

Следует отметить, что эта опция представляет достаточно широкие 

возможности для описания нелинейно деформируемых материалов. В 

качестве первого приближения эту опцию можно использовать и для 

моделирования деформирования изделий из резины и т.д. Выражение «первое 

приближение» для резин употребляется в том смысле, что для этих 

материалов есть особая опция и, соответственно, физическая модель 

(Mooney-Rivlin), рассмотрение которой выходит за рамки данной книги. Она 
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более точно описывает физическую сторону поведения резин и содержит 

константы характерные для данного вида деформирования. 

С помощью графического интерфейса можно указать, что модель 

деформирования материала с определенным номером описывается как 

многолинейная упругость. Для версии 10 это можно выполнить 

воспользовавшись следующим пунктом в окне 

Define Material Model Behavior: 

Define Material Model Behavior> Material Models Available> Structural> 

Nonlinear> Elastic> Multilinear Elastic 

При этом пользователь получает возможность определить узловые 

значения деформаций и напряжений при одноосном напряженном состоянии 

в окне Multilinear Elastic for Material Number …. (Рисунок 19). В этом окне 

сразу присутствует три поля ввода для определения: температур Temperatures 

(не участвует в рассмотрении в рамках данного пособия и сразу не доступно 

для заполнения), деформаций (Strain) и напряжений (Stress).  

 

 
Рисунок 19. Окно определения свойств упругих нелинейных материалов 

 

С их использованием можно определить первую пару значений 

деформации и соответствующего ей напряжения. Добавление строки в 

таблицу деформации/напряжения осуществляется нажатием кнопки 

Add Point. Удаление строки нажатием клавиши Delete Point. 

 



 

 

29 

 
Рисунок 20. Моделирование зависимости напряжений от деформаций с 

помощью ломаной линии 

 

Поведение материала в этом случае описывается линейно-ломанной 

деформационной кривой (Рисунок 20), начинающейся в начале координат с 

положительными значениями деформаций и напряжений. Кривая является 

непрерывной и проходит через определенное пользователем число точек 

(пар) (деформация, напряжение).  

З а м е ч а н и е! Каждая диаграмма растяжения может содержать до 

100 узловых точек (пар деформация / напряжение). 

ANSYS представляет возможность просмотра графика диаграммы 

растяжения. Для того, чтобы убедиться в правильности введенной 

информации необходимо в окне Multilinear Elastic for Material Number … 

нажать кнопку Graph и сделать активным основное окно ANSYS Graphics, в 

котором будет отображен график диаграммы растяжения. 

 

Пластичность материалов. Общие сведения. 

Задачи связанные с необратимыми деформациями, т.е. деформациями 

за пределами выполнения закона Гука - один из наиболее распространенных в 

технике типов задач. Теория пластичности, является основой для 

современных расчетов технологических процессов ковки, прокатки, 

штамповки. Использование расчетов с учетом пластических деформаций 

позволяет более точно оценить работоспособность конструкций имеющих так 

называемые концентраторы напряжений, т.е. резкое изменение границ. 

Поэтому одним из основных направлений развития технических 

расчетов в настоящее время становиться учет возможных малых 

пластических деформаций и оценка их влияния на ресурс конструкции в 

целом. Если ранее конструктор любым образом старался исключить 

появление локальных пластических деформаций за счет увеличения размеров 
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детали, то в настоящее время в связи с резким снижением массо-габаритных 

характеристик и одновременным увеличением нагруженности элементов 

конструкций приходиться мириться с присутствием локальных пластических 

деформаций в элементах конструкций, где это не оказывает влияние на 

общую работоспособность.  

Важность учета пластических деформаций определяется тем, что их 

вклад в удлинение образца до его разрушения несоизмеримо больше, чем 

вклад упругих деформаций. 

Однако, очевидно, прежде чем проводить расчеты необходимо 

определить модель пластического деформирования. Как и в случае с 

упругими деформациями рассмотрим более детально процесс 

деформирования цилиндрического образца при одномерном нагружении 

(осевом растяжении). В этом простейшем случае будем предполагать, что 

материал является изотропным (Рисунок 21). 

 

 
Рисунок 21. Связь между деформациями и напряжениями за пределами 

упругости при одноосном растяжении 

 

Как обсуждалось выше зависимость напряжений σ от деформаций ε для 

металлов (и большинства машиностроительных материалов) в начале имеет 

линейный или очень близкий линейному участок. Величина напряжений, за 

пределом которой линейная связь между деформациями и напряжениями 

нарушается, называется пределом пропорциональности σпц. 

Таким образом, до напряжения σпц выполняется закон Гука и деталь 

после снятия нагрузки возвращается в исходное состояние (геометрическую 

форму). При привышении, действующим в образце напряжением значения 

σпц закон деформирования перестает быть линейным. При этом некоторые 
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материалы имеют выраженную площадку текучести (Рисунок 21) 

(напряжение σT остается постоянным при увеличеснии деформаций), а 

некоторые нет. Однако в обоих случаях важно лишь то, что деформации 

образца уже состоят из обратимых деформаций εе, которые исчезнут после 

снятия нагрузки, и пластических (остаточных) деформаций εр, остающихся у 

образца после снятия нагрузки (Рисунок 21). 

Даже если материал не имеет выраженной площадки течения, то в 

качестве предела текучести σT выбирается условный предел текучести – это 

определенный уровень напряжений, соответствующий некоторому 

критическому значению остаточной деформации образца. 

Выберем на диаграмме точку A. При разгрузке образца зависимость 

между напряжениями и деформациями носит линейный характер, причем 

наклон соответствующей прямой такой же, как и первоначального участка 

(линия, проходящая через точку A и параллельная начальному участку 

нагружения). Таким образом, при разгрузке материал ведет себя как упругий. 

Если образец после полной разгрузки снова нагрузить растяжением, то 

линейный участок будет продолжаться до больших значений, т.е. пц
  и Т

  

возрастут это явление называется наклепом (упрочнением). Однако если этот 

образец повторно (после пластической деформации) сжать, то предел 

пропорциональности пц
  и предел текучести T

  образца при сжатии 

уменьшаться по сравнению с соответствующими пределами предварительно 

недеформированного материала. В этом состоит суть эффекта Баушингера. 

Отметим, что если при этом выполняется равенство 2T T T
     , то 

материал называют циклически идеальным. Это равенство означает для 

пластически деформируемого образца, что насколько увеличивается предел 

текучести при растяжении, на столько же он уменьшается при сжатии. 

Теория пластичности устанавливает связь между напряжениями и 

деформациями или скоростями деформаций за пределами упругости. 

Очевидно, что решение задач с учетом пластичности гораздо сложнее 

линейных задач теории упругости. Поэтому в ряде случаев для изотропных 

тел используются некоторые упрощения связи ε и σ для реального материала. 

Часто в технических расчетах диаграмму растяжения аппроксимируют в виде 

кусочно-ломаных прямых или так называемых диаграмм Прандтля (Рисунок 

22). 
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Рисунок 22. Диаграмма Прандтля 

 

Наиболее простой является аппроксимация диаграммы растяжения 

образца двумя отрезками (в ANSYS билинейная аппроксимация BKIN и 

BISO), либо диаграммой, не имеющей выраженной площадки течения 

(0< tgα <EX, где EX – модуль упругости), либо диаграммой для идеально 

пластичных материалов (α = 0, например, цветные металлы, чистое железо). 

Если изотропный материал имеет более сложную диаграмму, либо 

исследователь хочет более точно отразить участок перехода упругих 

деформаций в пластические, то используется аппроксимация диаграммы с 

помощью ломаной, содержащей более двух прямолинейных участков (в 

ANSYS многолинейная аппроксимация MKIN и MISO).  

Наличие необратимых деформаций является коренным отличием 

нелинейных пластических деформаций от нелинейных упругих. При этом 

нелинено упруго деформируемые материалы, как правило, вообще не имеют 

значительного (с практической точки зрения) линейного участка связи 

напряжений и деформаций. А пластичность практически всегда (в 

прикладных исследованиях) рассматривается как продолжение 

деформирования за пределами упругости. 

 

Билинейное кинематическое упрочнение 

Билинейное кинематическое упрочнение предполагает, что материалы 

циклически идеальны (см. пред. раздел.) и учитывает эффект Баушингера. 

Переход изотропных материалов из упругого состояния в пластическое 

определяется критерием Мизеса.  

З а м е ч а н и е! Экспериментально установлено, что модель 

удовлетворительно описывает деформации большинства металлов 
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Поведение материалов описывается билинейной кривой 

деформирования, начинающейся в начале координат с положительными 

значениями деформаций и напряжений. Наклон первого участка кривой 

определяется исходя из упругих характеристик материалов. В точке с 

указанным пользователем значением предела текучести, кривая продолжается 

вдоль второй линии (Рисунок 22) определяемой касательным модулем, 

имеющим те же единицы измерения, что и модуль упругости. Касательный 

модуль не может быть меньше нуля и не больше модуля упругости. Выбор 

данной модели деформирования осуществляется с помощью следующего 

пункта в окне Define Material Model Behavior: 

Define Material Model Behavior> Material Models Available> Structural> 

Nonlinear> Inelastic> Rate Independent> Kinematic Hardening Plasticity> 

Mises Plasticity> Bilinear 

При использовании этого пункта главного меню, если упругие свойства 

изотропного материала (модуль упругости и коэффициент Пуассона) с 

текущим номером не были определены ранее, то ANSYS делает замечание 

(Рисунок 23): 

 

 
Рисунок 23. Вид окна с замечанием 

 

После подтверждения пользователя об ознакомлении с содержанием 

замечания (OK), ANSYS предлагает заполнить недостающие данные в окне 

Linear Isotropic Properties for Material Number … (см. раздел касающийся 

упругих характериатик). После их заполнения и подтверждения (OK), 

пользователь получает возможность заполнить значения параметров, 

относящихся к определению предела текучести угла второго прямолинейного 

отрезка в билинейной аппроксимации в окне 

Bilinear Kinematic Hardening for Material Number …. При этом пользователю 

в поле Stress-Strain Options необходимо установить соответствующую 

опцию. Опцией No stress relaxation рекомендуется пользоваться только для 

изотермических задач и задач, в которых модель испытывает циклические 

нагрузки.  
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З а м е ч а н и е! Просмотр графика диаграммы растяжения при 

пластических деформациях осуществляется также как в случае с 

нелинейной упругостью. 

 

Многолинейное кинематическое упрочнение (общее) 

Модель абсолютно аналогична модели билинейного кинематического 

упрочнения и учитывает эффект Баушингера. Однако, следует отметить, что 

многолинейное упрочнение позволяет более точно, чем билинейное, описать 

диаграмму растяжения.  

Пункт меню окна Define Material Model Behavior: 

Define Material Model Behavior> Material Models Available> Structural> 

Nonlinear> Inelastic> Rate Independent> Kinematic Hardening Plasticity> 

Mises Plasticity> Multililinear (General) 

Как и в предыдущем случае, если упругие свойства изотропного 

материала (модуль упругости и коэффициент Пуассона) с текущим номером 

не были определены, то ANSYS делает замечание и после подтверждения 

пользователя (OK) предлагает заполнить недостающие данные в окне 

Linear Isotropic Properties for Material Number … (см. раздел, касающийся 

упругих характеристик). После их заполнения и подтверждения (OK). 

Пользователь получает возможность заполнить поля таблицы Strain / Stress 

уже относящейся к определению диаграммы растяжения за пределами 

упругости в окне Multilinear Kinematic Hardening for Material Number …. 

Добавление пары значений Strain / Stress осуществляется при помощи кнопки 

Add Point.  

З а м е ч а н и е! При решении с учетом билинейного кинетического 

упрочнения пользователь имеет возможность определить параметры 

деформационной кривой, содержащей до 100 пар значений деформаций и 

напряжений для 20 различных температур. Просмотр диаграммы 

растяжения при пластических деформациях осуществляется также как 

в случае с нелинейной упругостью. 

 

Билинейное изотропное упрочнение  

Данная модель не описывает эффект Баушингера. Поведение 

материалов описывается билинейной кривой деформирования, 

начинающейся в начале координат с положительными значениями 
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деформаций и напряжений. Наклон первого участка кривой определяется, 

исходя из упругих характеристик материалов. В точке с указанным 

пользователем значением предела текучести, кривая продолжается вдоль 

второго угла, определяемого касательным модулем, имеющим те же 

единицы, что и модуль упругости. Касательный модуль не может быть 

меньше чем нуль и не больше чем модуль упругости.  

Пункт окна Define Material Model Behavior: 

Define Material Model Behavior> Material Models Available> Structural> 

Nonlinear> Inelastic> Rate Independent> Isotropic Hardening Plasticity> Mises 

Plasticity> Bilinear 

З а м е ч а н и е! Работа с этой моделью полностью аналогична модели 

билинейного кинематического упрочнения 

 

Многолинейное изотропное упрочнение  

Данная модель не описывает эффект Баушингера. При многолинейном 

изотропном упрочнении диаграмма растяжения аппроксимируется ломаной 

линией с более чем двумя прямолинейными участками. Присвоение 

материалу с текущим номером значений соответствующих физических 

констант, определение постоянных, зависящих от температуры, просмотр 

диаграмм растяжения совершенно аналогичен предыдущему случаю, т.е. 

билинейному изотропному упрочнению. Поэтому приведем лишь путь, по 

которому можно вызвать для заполнения окно 

Multilinear Isotropic Hardening for Material Number …: (пункт окна 

Define Material Model Behavior): 

Define Material Model Behavior> Material Models Available> Structural> 

Nonlinear> Inelastic> Rate Independent> Isotropic Hardening Plasticity> 

Mises Plasticity> Multilinear 

 

Редактирование свойств уже использующихся материалов 

Если есть необходимость изменить значения констант, не меняя 

модели, то для этого необходимо вызвать окно 

Define Material Model Behavior с помощью пункта главного меню: 

Main Menu> Preprocessor> Material Props> Material Models 
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Затем используя его левое окно Material Models Defined, содержащее 

нумерованный список уже заданных материалов, двойным щелчком «мыши» 

открыть содержание раздела с номером того материала, свойства которого вы 

хотите отредактировать. Раздел с номером материала содержит название 

физической модели либо список моделей, которые присвоены данному 

материалу. Например, если материал с номером 1 имеет пластические 

свойства, то обязательно в списке физических моделей будет перечисляться и 

упругие свойства. Выбранную физическую модель, принадлежащую разделу 

с номером материала можно удалить, используя раздел Edit окна 

Define Material Model Behavior, копировать, либо вызвать двойным щелчком 

содержимое значений постоянных и изменить их значение в полях ввода с 

соответствующими метками.  

 

Дополнительные средства работы со свойствами материалов в 

ANSYS 

Сохранение созданных моделей материалов в отдельный mp-файл  

Пункт главного меню 

Preprocessor> Material Props> Write to File  

При использовании этого пункта меню появиться окно 

Write Material Properties to File. При этом: 

 С помощью кнопки Browse вызываем окно 

<MPWRITE> Write linear mat1 data.  

 В этом окне выбираем диск, папку и имя файла (без расширения), 

под которым данная модель должна будет сохраниться. 

 Нажимаем кнопку Save. 

 Нажимаем кнопку OK в окне Write Material Properties to File. 

З а м е ч а н и е! Можно сохранить лишь модель с линейными 

свойствами. Расширение файла можно не указывать, «по умолчанию» 

расширение mp. 

Команда  

MPWRITE, Fname, Ext, Dir, LIB, MAT 

где 
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 Fname – имя файла, в который будут записываться данные для 

модели материала. 

 Ext – расширение файла (не более 8 символов). Если параметр 

опущен, то будет создан файл с расширением mp.  

 Dir – директория, в которой будет находиться файл (не более 64 

символов).  

 LIB – метка, позволяющая записывать данные модели с 

нелинейными свойствами. Если метка опущена, то будет 

записаны только линейные свойства. 

 MAT – метка, определяющая, что записываемый файл должен 

быть внесен в библиотеку свойств материалов. Метка может быть 

опущена.  

З а м е ч а н и е! С помощью пункта главного меню записываются только 

линейные свойства материалов. 

 

Чтение файла со свойствами материала 

Пункт главного меню 

Preprocessor> Material Props> Read form File… 

При использовании этого пункта меню появляется окно 

Read Material Properties form File, в котором с помощью кнопки Browse… и 

окна <MPREAD> Read material props необходимо указать на каком 

логическом диске и директории находится файл с моделью. Нажать кнопку 

Open. Затем нажать кнопку OK в окне Read Material Properties form File. 

 

Команда  

Общий вид команды при вводе с клавиатуры: 

MPREAD, Fname, Ext, Dir, LIB 

где 

 Fname – имя файла, из которого будут читаться данные для 

модели материала. 

 Ext – расширение файла (не более 8 символов). Если параметр 

опущен, то читаются файлы с расширением mp.  
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 Dir – директория, в которой находится файл (не более 64 

символов).  

 LIB – метка, позволяющая читать модели с нелинейными 

свойствами. Если метка опущена, то будут прочитаны только 

линейные свойства. 

З а м е ч а н и е! С помощью пункта главного меню читаются только 

линейные свойства материалов. 

Сжатие нумерации свойств модели после редактирования 

Пункт главного меню 

Main Menu> Preprocessor> Numbering Ctrls> Compress Numbers 

При использовании данного пункта меню появляется окно 

Compress Numbers (Рисунок 24). После этого следует выбрать в выпадающем 

списке с меткой Label пункт Material Props и нажать кнопку OK или Apply. 

 

 
Рисунок 24. Окно Compress Numbers 

 

Команда  

Общий вид команды при вводе с клавиатуры: 

NUMCMP, Label 

где в данном случае метка Label имеет значение MAT. 
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Примеры определения свойств материалов средствами ANSYS для 

решения физических задач 

Пример 1. Определение свойств изотропных упругих материалов 

Шаг 1. Чтение существующей модели из db-файла 

Для этого используем пункт меню: 

Utility Menu> File> Resume from… 

При использовании пункта меню утилит появляется окно 

Resume DataBase (Рисунок 25).  

 

 
Рисунок 25. Вид окна Resume DataBase 

 

В этом случае следует: 

 Выбрать в выпадающем списке Drives (Рисунок 26) диск, на 

котором хранится уже созданный файл (например, C: – выбор 

диска «по умолчанию»). 

 

 
Рисунок 26. Выпадающий список для выбора логического диска 

 

 Выбирать в списке Directories папку (Рисунок 27), в которой 

хранится файл (например, папка Ansys_Examples). Выбор папки 

осуществляется двойным нажатием на правую кнопку «мыши») 
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З а м е ч а н и е! После выполнения данных действий в левом списке под 

Resume Database From появиться список имен файлов (Рисунок 28) с 

расширениями db или dbb. 

 

 
Рисунок 27. Окно выбора папки (директории) для хранения файла 

 

 
Рисунок 28. Список файлов 

 

 В списке Resume DataBase From (Рисунок 29) выбирать c 

помощью «мыши» существующий файл из списка, в котором 

хранится твердотельная модель примера 1 (например, 

Example1.db). 

 Нажать кнопку OK. 

 

 
Рисунок 29. Выбор файла 

З а м е ч а н и е! Двойное нажатие левой кнопки «мыши» при выборе 

файла заменяет нажатие кнопки OK при выборе файла. 
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Шаг 2. Определение типа решаемой задачи 

Main Menu> Preferences… 

При его использовании появляется окно Preferences for GUI Filtering. 

 Устанавливаем флажок  в поле с меткой Structural (Рисунок 

30). 

 Нажимаем кнопку OK или Apply для подтверждения выбора 

(Рисунок 31). 

 

 
Рисунок 30. Выбор структурного анализа 

 

 
Рисунок 31. Кнопки окна Preferences for GUI Filtering 

 

Шаг 3. Последовательность действий при определении модуля 

упругости и коэффициента Пуассона  

Рассмотрим последовательность действий при определении свойств 

углеродистой качественной конструкционной 5-й категории стали 10. 

(отожженной или высокоотпущенной). 

 

Модуль упругости (Па) 2E11...2.1E11 

Коэф. Пуассона 0.24...0.3 

 

В данном случае необходимо использовать пункт окна 

Define Material Model Behavior (Рисунок 32): 
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Define Material Model Behavior> Material Models Available> Structural> 

Linear> Elastic> Isotropic 

 

 
Рисунок 32. Расположение пункта меню Isotropic 

 

При его использовании появляется окно 

Linear Isotropic Properties for Material Number 1 (Рисунок 33). В этом случае: 

 определяем требуемые значения упругих постоянных (модуля 

упругости EX = 2.1E11, и коэф. Пуассона PRXY = 0.3). 

 Нажимаем кнопку OK. 

 

 
Рисунок 33. Окно назначения упругих констант 
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З а м е ч а н и е! В окне Define Material Model Behavior> 

Material Models Defined появилась подпись Linear Isotropic это 

свидетельствует о создании модели. 

 Закрываем окно Define Material Model Behavior (Рисунок 34) с 

помощью пункта меню этого окна Material> Exit либо 

воспользоваться значком  в правом верхнем углу окна. 

 

 
Рисунок 34. Результат создания линейного изотропного материала 

 

 Записываем свойства созданного материала в файл с 

использованием пункта меню Preprocessor> Material Props> 

Write to File (Рисунок 35). 

 

 
Рисунок 35. Запись свойств материала в файл 

 

При использовании этого пункта меню появится окно 

Write Material Properties to File (Рисунок 35). При этом: 

 С помощью кнопки Browse вызываем окно 

<MPWRITE> Write linear mat1 data.  
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 В этом окне выбираем диск, папку и имя файла (без расширения) 

под которым данная модель должна будет сохраниться. 

 Нажимаем кнопку Save. 

 Нажимаем кнопку OK в окне Write Material Properties to File 

(Рисунок 35). 

З а м е ч а н и е! После выполнения данных действий файл будет иметь 

расширение mp. 

Шаг 4. Сохранение созданной модели в отдельном db-файле 

Для этого используем пункт меню утилит: 

Utility Menu> File> Save as… 

При использовании пункта меню утилит появляется окно 

Save DataBase. В этом случае следует: 

 Выбрать в выпадающем списке Drives диск, на котором хранится 

уже созданный файл. 

 Выбрать в списке Directories папку, в которой хранится файл 

(например, папка Ansys_Examples). Выбор папки осуществляется 

двойным нажатием на правую кнопку «мыши»). 

З а м е ч а н и е! После выполнения данных действий в левом окне под 

окном ввода имени Save Database to появится список имен файлов 

(Рисунок 36) с расширениями db или dbb. 

Далее необходимо: 

 В списке Save DataBase to (Рисунок 37) выбрать c помощью 

«мыши» существующий файл из списка, в котором хранится 

твердотельная модель примера 1 (например, Example1.db). 

 Нажать кнопку OK. 

 

 
Рисунок 36. Список файлов 
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Рисунок 37. Выбор файла 

 

З а м е ч а н и е! После выполнения данных действий появится 

предупреждающее сообщение о том, что данный файл уже существует 

(Рисунок 38). И пользователь должен подтвердить замену 

существующего файла новым. Нажать кнопку Yes («по умолчанию» 

включена кнопка No). 

 

 
Рисунок 38. Окно с предупреждающим сообщением 

 

Примеры 2 И 3. Определение упруго-пластических свойств изотропных 

материалов (билинейное кинематическое упрочнение)  

Шаг 1. Чтение существующей модели из db-файла 

Для этого используем пункт меню: 

Utility Menu> File> Resume from… 

При использовании пункта главного меню появляется окно 

Resume DataBase. В этом случае последовательность действий, связанная с 

выбором логического диска, папки (директории), в которой хранится уже 

созданный файл полностью соответствует шагу 1 примера 1 данного раздела, 

однако в данном случае необходимо выбрать другой файл (например, 

Example2.db или Example3.db), в котором хранится вторая или третья 

созданная модель, в списке Resume DataBase From. 
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Шаг 2. Определение типа решаемой задачи 

Main Menu> Preferences… 

При его использовании появляется окно Preferences for GUI Filtering 

 Устанавливаем флажок  в поле с меткой Structural. 

 Нажимаем кнопку OK для подтверждения выбора. 

Шаг 3. Последовательность действий определения упруго-

пластических характеристик 

Рассмотрим последовательность действий при определении свойств 

обыкновенного качества углеродистой стали Ст 5 сп. 

 

Предел текучести (Па) 2.6E8...2.9E8 

Модуль упругости (Па) 2.1E11 

Коэф. Пуассона 0.24...0.3 

 

С учетом того, что низкоуглеродистые стали обыкновенного качества 

обычно имеют выраженную площадку текучести, предположим, что угол 

наклона на второго линейного участка равен нулю. 

Наиболее приемлемой моделью деформирования большинства 

металлов, с учетом пластической деформации, является кинематическое 

упрочнение. Выбор данной модели деформирования осуществляется с 

помощью следующего пункта окна Define Material Model Behavior: 

Define Material Model Behavior> Material Models Available> Structural> 

Nonlinear> Inelastic> Rate Independent> Kinematic Hardening Plasticity> 

Mises Plasticity> Bilinear 

З а м е ч а н и е! При описании последовательности действий будем 

считать, что упругие свойства не были определены до использования 

этого пункта. 

При использовании этого пункта главного меню ANSYS сделает 

замечание: 

 Нажимаем в окне Note кнопку OK. 
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 Заполняем в окне Linear Isotropic Properties for 

Material Number 1 упругие характеристики (модуль упругости 

EX = 2.1E11, коэффициент Пуассона PRXY = 0.3, см. пример 1).  

 Нажимаем в окне Linear Isotropic Properties for 

Material Number 1 кнопку OK. 

 Заполняем значения параметров, относящихся к определению 

предела текучести (метка Yield Stss = 2.6E8) и угла второго 

прямолинейного отрезка (метка Tang Mods = 0) в билинейной 

аппроксимации в окне Bilinear Kinematic Hardening 

for Material Number 1 (Рисунок 39). 

 

 
Рисунок 39. Назначение предела текучести и касательного модуля 

 

 В выпадающем списке Stress-Strain Options устанавливаем 

соответствующую опцию. Опцией No stress relaxation 

рекомендуется пользоваться только для изотермических задач и 

задач, в которых модель не испытывает циклические нагрузки.  

 Нажимаем в окне Bilinear Kinematic Hardening for 

Material Number 1 кнопку Graph.  

 Нажимаем в окне Bilinear Kinematic Hardening for 

Material Number 1 кнопку OK (Рисунок 40). 

 Закрываем окно Define Material Model Behavior как это описано в 

замечании к примеру 1. 

З а м е ч а е н и е! В левом окне Material Model Defined, в котором 

указываются созданные при проведений указанных выше действий модели 

для первой модели материала (Material Model Number 1), появится список 

моделей Linear Isotropic и Bilinear Kinematic. 
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 В основном графическом окне ANSYS Graphics просматриваем 

построенную диаграмму (Рисунок 41). 

 

 
Рисунок 40. Результат определения упруго-пластических свойств 

материала 

 

 
Рисунок 41. Результирующая диаграмма 
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Шаг 4. Сохранение созданной модели в отдельном db-файле 

При использовании пункта главного меню появляется окно 

Save DataBase. В этом случае последовательность действий, в которой будет 

храниться файл полностью соответствует шагу 4 примера 1 данного раздела.  

 

Пример 4. Определение коэффициента изотропной теплопроводности  

Шаг 1. Чтение существующей модели из db-файла 

Для этого используем пункт меню: 

Utility Menu> File> Resume from… 

При использовании пункта главного меню появляется окно 

Resume DataBase. В этом случае последовательность действий, связанная с 

выбором логического диска, папки (директории), в которой хранится уже 

созданный файл полностью соответствует шагу 1 примера 1 данного раздела, 

однако в данном случае необходимо выбрать другой файл (например, 

Example4.db), в которым хранится четвертая созданная модель. 

 

Шаг 2. Определение типа решаемой задачи 

Main Menu> Preferences… 

При его использовании появляется окно Preferences for GUI Filtering 

 Устанавливаем флажок  в поле с меткой Thermal. 

 Нажимаем кнопку OK или Apply для подтверждения выбора. 

Шаг 3. Последовательность действий при определении коэффициента 

теплопроводности 

Рассмотрим последовательность действий при определении изотропной 

теплопроводности стенового камня из аэрированного легкого бетона. 

 

Тепопроводность (Вт/мК) 0.28 

 

Наиболее приемлемой моделью деформирования большинства 

металлов с учетом пластической деформации является кинематическое 

упрочнение. Выбор данной модели деформирования осуществляется с 

помощью следующего пункта окна Define Material Model Behavior: 



 

 

50 

Define Material Model Behavior> Material Models Available> Thermal> 

Conductivity> Isotropic 

При его использовании появляется окно 

Conductivity for Material Number 1. После этого:  

 Заполняем поле с меткой KXX, соответствующее вводу 

коэффициента теплопроводности для изотропного тела (значение 

0.28, Рисунок 42).  

 Нажимаем кнопку OK (Рисунок 43). 

 Закрываем окно Define Material Model Behavior с помощью 

пункта меню этого окна Material> Exit либо воспользоваться 

значком  в правом верхнем углу окна. 

 

 
Рисунок 42. Окно определения коэффициента теплопроводности 

 

 
Рисунок 43. Результат определения изотропной теплопроводности 
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Шаг 4. Сохранение созданной модели в отдельном db-файле 

При использовании пункта главного меню появляется окно 

Save DataBase. В этом случае последовательность действий, в которой будет 

храниться файл полностью соответствует примеру 1 данного раздела.  

 

Пример 5. Последовательность действий при использовании ранее созданной 

модели линейного изотропного материала  

Шаг 1. Чтение существующей модели из db-файла 

Для этого используем пункт меню: 

Utility Menu> File> Resume from… 

При использовании пункта главного меню появляется окно 

Resume DataBase. В этом случае последовательность действий, связанная с 

выбором логического диска, папки (директории), в которой хранится уже 

созданный файл полностью соответствует шагу 1 примера 1 данного раздела, 

однако в данном случае необходимо выбрать другой файл (например, 

Example5.db), в которым хранится пятая созданная модель, в списке 

Resume DataBase From. 

 

Шаг 2. Определение типа решаемой задачи 

Main Menu> Preferences… 

При его использовании появляется окно Preferences for GUI Filtering 

 Устанавливаем флажок  в поле с меткой Structural. 

 Нажимаем кнопку OK или Apply для подтверждения выбора. 

Шаг 3. Последовательность действий при определении механических 

свойств материала 

Используем модель линейного изотропного материала, записанную в 

отдельный файл (Material1.mp) в примере 1. Для того чтобы использовать 

модель, созданную в предыдущем примере, необходимо воспользоваться 

пунктом меню: 

Preprocessor> Material Props> Read form File… 

При использовании этого пункта меню появляется окно 

Read Material Properties form File, в котором с помощью кнопки Browse… и 

окна <MPREAD> Read material props необходимо указать на каком 
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логическом диске и директории находится файл с моделью (Material1.mp, 

Рисунок 44). Нажать кнопку Open. Затем нажать кнопку OK в окне 

Read Material Properties form File. 

 

 
Рисунок 44. Выбор файла, содержащего модель материала 

 

 

Шаг 4. Последовательность действий при определении плотности 

материала 

Пункт окна Define Material Model Behavior: 

Define Material Model Behavior> Material Models Available> Structural> 

Density 

При его использовании появляется окно Density for Material Number 1. 

После этого:  

 Заполняем поле с меткой DENS – вводим значение плотности 

(значение, например, 14000 кг/м
3
, Рисунок 45).  

 Нажимаем кнопку OK.  

 Закрываем окно Define Material Model Behavior с помощью 

пункта меню этого окна Material> Exit либо воспользоваться 

значком  в правом верхнем углу окна. 
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Рисунок 45. Окно определения коэффициента плотности 

 

Шаг 5. Сохранение созданной модели в отдельном db-файле 

При использовании пункта главного меню появляется окно выбора 

Save DataBase. В этом случае последовательность действий, в которой будет 

храниться файл, полностью соответствует шагу 4 примера 1 данного раздела.  
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Конечноэлементное разбиение модели 

Элементы. Общие сведения 

В ANSYS имеется более 100 различных типов элементов. Как правило, 

в различных вариантах программы доступны не все виды элементов. Это 

зависит от того, какие виды расчета могут использоваться в данном варианте 

программы. 

Каждый тип элементов имеет свое имя, например BEAM3. Имя может 

состоять не более чем из 8 символов, и имеет две части: буквенную, 

обозначающую категорию элемента, и цифровую, обозначающую его номер. 

В приведенном выше примере BEAM обозначает то, что элемент 

предназначен для использования в балочных моделях, а 3 это его порядковый 

номер. 

Узлы, объединяемые элементом, обозначаются в описании элемента 

латинскими буквами, начиная с буквы I, обозначающей первый узел 

элемента. 

Свойства элемента, которые не могут быть получены исходя из 

расположения узлов и свойств материала этого элемента, описываются как 

вещественные константы. Например, для оболочечных элементов это 

толщина оболочки, для элементов трубообразной формы - это внешний и 

внутренний радиус трубы, и так далее. 

Каждый тип элементов использует значения свойств материала, 

описанных в предыдущей главе. Например, для элементов, используемых в 

расчетах на прочность, чаще всего необходимо определить модуль Юнга и 

коэффициент Пуассона, и иногда плотность. 

Кроме того, многие элементы могут иметь собственные системы 

координат. В основном они используются в случае применения ортотропных 

материалов. 

 

Вырожденные элементы 

Вырожденные элементы - это элементы, имеющие изначально 

четырехугольную или шестигранную форму, но путем совмещения двух или 

более узлов принявшие форму треугольника для плоских элементов или 

четырехгранника, призмы либо клина для объемных. Примером может 

служить элемент PLANE42 принявший треугольную форму (Рисунок 45). 
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Рисунок 46. Обычная и вырожденная форма элемента PLANE42 

 

Обычно подобные элементы возникают в местах перехода от более 

грубого к более мелкому разбиению, а также при моделировании тел сложной 

(нерегулярной) формы.  

Обычные и квадратичные элементы 

У многих конечных элементов, используемых системой ANSYS, 

существует два варианта – обычный и квадратичный. Обычный элемент 

имеет узлы только на вершинах, в то время как квадратичный элемент имеет 

также промежуточные узлы на серединах ребер. В связи с этим, если у 

обычных элементов ребра всегда прямолинейные, у квадратичных они могут 

быть криволинейными.  

Достоинства квадратичных элементов 

Квадратичные элементы позволяют производить расчеты с большей 

точностью для тел с криволинейными границами. 

Квадратичные элементы обеспечивают большую точность для 

нерегулярных (свободных) сеток. 

Недостаток квадратичных элементов 

Значительно увеличивается время расчета при использовании 

квадратичных элементов. Поэтому, для тел с небольшой кривизной и 

упорядоченным разбиением, безусловно, предпочтительным является 

использование обычных элементов. Кроме того, для достижения требуемой 

точности на неупорядоченных разбиениях, можно попробовать просто 

увеличить плотность с обычными элементами, а не применять квадратичные. 

Выбор используемых элементов 

Пункт главного меню 

Чтобы выбрать элементы, которые будут использоваться в модели, 

необходимо выбрать пункт меню: 
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Main Menu> Preprocessor> Element Type> Add/ Edit/ Delete 

При выборе данного пункта появится диалоговое окно Element Types 

(Рисунок 46). 

 

 
Рисунок 47. Диалоговое окно управления типами элементов 

 

Список Defined Element Types содержит типы элементов, которые 

выбраны для использования в текущей модели. В списке приводятся 

следующие данные (Рисунок 47): 

 номер, который присвоен данному типу элемента в модели; 

 название типа элемента; 

Если выбранных типов элементов нет, в списке появляется надпись 

NONE DEFINED. 

В диалоговом окне находятся несколько кнопок выполняющих 

следующие действия: 

 Add... – позволяет  добавить к списку используемых типов 

элементов новый тип. 

 Options – позволяет настроить выбранный в списке тип 

элементов. При ее нажатии появляется диалоговое окно 

настройки типов элементов. Данное окно имеет свой вид для 

каждого типа элементов. 

 Delete – кнопка, позволяющая удалить выбранный в данный 

момент тип элементов. 
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 Close – закрывает диалоговое окно. 

 Help – выводит на экран справку. 

При нажатии кнопки Add на экран выводится диалоговое окно 

Library of Element Types, содержащее библиотеку типов элементов (Рисунок 

47).  

 

 
Рисунок 48. Диалоговое окно выбора типа элементов 

 

Основные типы задач и категории элементов 

В левом списке Library Element Types расположены основные типы 

задач и соответствующие им категории элементов (Рисунок 49).  

 

 
Рисунок 49. Список типов и категорий элементов 

 

Первым в данном списке указывается тип задачи, для решения которой 

предназначаются типы элементов:  

 Structural – обычные задачи расчетов на прочность.  

 Hyperelastic – задачи с использованием гиперэластичных 

материалов, например, резин. 

 Contact – контактные задачи. 

 Thermal – термические задачи. 

 LS-Dyna Explicit – задачи расчета задач с большими 

деформациями и разрушения с помощью Explicit-решателя от LS-

Dyna. 

 и др. 
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Некоторые из этих пунктов сами состоят из нескольких категорий, 

связанных с особенностями задачи. Так типы элементов для структурных 

задач (Structural) делятся на категории: 

 Mass – элементы применяющиеся для создания 

концентрированных масс в модели. 

 Link – элементы для моделирования различных связей и пружин. 

 Beam – элементы для моделирования стержневых конструкций. 

 Pipe – элементы для моделирования труб. 

 Solid – элементы применяющиеся в расчетах твердотельных 

моделей (объемных и плоских). 

 Shell – элементы для моделирования тонких оболочек. 

 Solid-Shell – элементы для моделирования оболочечные 

структуры с широким диапазоном толщины (от тонкого до 

умеренно толстого). 

 Constraint – элементы, используемые для моделирования 

сложных кинематических соединений. 

При выборе категории в левом списке, в правом появляется список 

элементов, относящихся к данной категории. Первым в каждой строке идет 

описание элемента. Как правило, оно содержит данные о форме элемента, 

количестве узлов и особенностях физических моделей материала, для 

которых он используется. Описание элемента сильно различается для 

различных категорий элементов.  

Некоторые элементы могут использоваться при решении задач с 

различными типами материалов, и поэтому появляются в списке в разных 

категориях. Так, например, тип элементов 182 может использоваться как в 

обычных расчетах на прочность, так и в расчетах с использованием 

гиперэластичных  материалов, поэтому он появляется и в разделе Solid и в 

разделе Hyperelastic. 

 

Пример 

1) В типе Structural категории Solid имеется элемент Triangle 6 node 2. 

Это плоский элемент треугольной формы с шестью узлами, имеющий номер 

2 (Рисунок 50).  
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Рисунок 50. Выбор элемента Triangle 6node 2 

 

2) В типе Structural категории Beam имеется элемент 2D Plastic 23. Это 

балочный элемент для двумерных расчетов, позволяющий моделировать 

пластические деформации и имеющий номер 32 (Рисунок 51). 

 

 
Рисунок 51. Выбор элемента 2D Plastic 23 

 

Основные элементы 

В данном разделе будут описаны наиболее часто используемые типы 

элементов системы ANSYS. Основное внимание будет уделено элементам, 

используемым при структурном анализе. 

Элементы раздела Structural 

Элементы категории Link 

Элементы данной категории обычно используются в инженерных 

задачах для моделирования пружин и связей. Элементы типов перечисленных 

в этой категории работают только на сжатие и растяжение, изгиб для них не 

учитывается. Все эти элементы имеют два узла на концах.  

 2D Spar 1 – элемент LINK1 используется в решении двумерных 

задач, его свойства задаются с помощью поперечного сечения, и 

свойств материала элемента. 

 3-D Spar 8 – элемент LINK8 аналогичен предыдущему, но 

используется в решении трехмерных задач. 

 3-D Bilinear 10 – элемент LINK10 отличается от LINK8 тем, что 

может работать либо на сжатие, либо на растяжение. Если он 

работает на растяжение, то при сжатии у него отсутствует 



 

 

60 

жесткость. Подобный эффект используется при моделировании 

связей сделанных с помощью цепей или гибких тросов. 

Элементы категории Beam 

Элементы данной категории обычно используются для моделирования 

стержней. В отличие от LINK элементов, они работают не только на 

растяжение – сжатие, но и на изгиб. Данные  элементы имеют либо два узла 

на концах элемента, либо три узла – два на концах и один посередине. 

 2D Elastic 3 – элемент BEAM3 предназначен для решения 

двумерных задач, его свойства задаются с помощью поперечного 

сечения и свойств материала. Данный элемент не предназначен 

для расчетов с использованием пластических и прочих 

нелинейных материалов. 

 2D tapered 54 – элемент BEAM54 отличается от предыдущего 

тем, что для него можно задать различные характеристики 

сечения стержня на его концах 

 2D plastic 23 – элемент BEAM23 аналогичен элементу BEAM3, но 

в отличие от него может использоваться в расчетах с 

пластическими и другими нелинейными материалами. 

 3D elastic 4 – элемент BEAM4 предназначен для решения 

трехмерных задач, его свойства задаются с помощью поперечного 

сечения и свойств материала. Данный тип элементов 

используется в задачах с линейными материалами. 

 3D tapered 44 – элемент BEAM44 отличается от предыдущего 

тем, что для него можно задать различные характеристики 

сечения стержня на его концах 

 3D plastic 24 – элемент BEAM24 аналогичен типу BEAM4, с той 

разницей, что его можно использовать с пластическими и 

другими нелинейными материалами.  

 3D finite strain 2 node 188 – элемент BEAM188 может 

применяться для расчетов стержневых конструкций с большими 

деформациями, он также допускает использование как линейных, 

так и нелинейных материалов. 

 3D finite strain 3 node 189 – элемент BEAM189 аналогичен 

предыдущему, но имеет кроме двух узлов на концах элемента 

промежуточный узел по середине. Использование элементов 

этого типа позволяет значительно увеличить точность расчетов 
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(особенно нелинейных задач) при умеренных затратах 

вычислительных ресурсов. 

 

Выбор вида поперечного сечения балочных элементов 

При использовании балочных элементов, следует выбрать форму и 

размеры их поперечного сечения, с помощью которого система определяет 

необходимые характеристики элемента. ANSYS позволяет использовать 

несколько разных сечений в одной модели, то есть в одной модели балочные 

элементы могут иметь разный профиль и размеры поперечного сечения. 

Поперечные сечения можно выбрать из набора стандартных сечений, либо 

создавать самостоятельно. В большинстве случаев достаточно выбрать 

подходящее сечение из 11 стандартных и ввести его параметры. 

Main Menu> Preprocessor> Sections> Beam> Common Sections 

При его использовании появиться окно BeamTool (Рисунок 52). 

 

 
Рисунок 52. Окно настройки сечений балочных элементов 
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В диалоговом окне BeamTool имеются следующие компоненты: 

 ID – поле ввода номера сечения. С помощью этого поля задается 

номер создаваемого сечения. 

 Name – поле ввода имени сечения. С помощью этого поля можно 

задать имя создаваемого сечения (максимум 8 символов). 

 Sub-Type – список, позволяющий выбрать один из стандартных 

профилей сечения. Профили выводятся в списке в виде картинок 

(Рисунок 53): 

 

 
Рисунок 53. Содержание выпадающего меню Sub-Type окна BeamTool 

 

 Offset To – данный пункт определяет привязку узла элемента к 

определенной точке на сечении. В выпадающем списке можно 

выбрать один из следующих пунктов: 

 Centroid – узел находится в центре сечения. 

 Shear Cent – узел находится в центре сдвига. 

 Origin – узел находится в начале координат сечения. 

 Location – положение узла задается двумя координатами, 

вводимыми в полях расположенных ниже. Поля OffsetY и OffsetZ 

содержат координаты узла на сечении. 

Ниже расположена картинка, изображающая выбранное сечение и его 

основные параметры (Рисунок 54). 

 

 
Рисунок 54. Пример выбора круглого сечения и поля ввода его основных 

параметров 
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Под картинкой расположены поля ввода, с помощью которых можно 

ввести размеры основных параметров сечения. Для каждого сечения набор 

параметров индивидуален, значение основных параметров можно определить 

по изображенному выше рисунку (Рисунок 54). 

Например, для круглого сечения имеются следующие значения: 

 R – радиус сечения. 

 N – количество делений сечения вдоль окружности. 

 T – количество делений сечения вдоль радиуса. 

Чтобы запомнить созданное сечение и закрыть окно BeamTool следует 

нажать кнопку OK. Чтобы запомнить сечение, но не закрывать BeamTool, 

следует нажать кнопку Apply. Чтобы закрыть окно BeamTool следует нажать 

кнопку Close. Чтобы вывести окно справки по BeamTool следует нажать 

кнопку Help. 

Элементы категории Pipe 

В этой категории собраны типы элементов, имеющих форму трубы. 

Основными параметрами данных элементов являются: материал, внешний 

диаметр трубы и толщина ее стенок. Данные элементы основаны на 

элементах категории BEAM. 

 Elast straight 16 – элементы типа PIPE16 предназначены для 

моделирования прямолинейных отрезков труб. Данные элементы 

можно применять только с линейными материалами. 

 Elast tee 17 – элементы типа PIPE17 имеют форму буквы T и 

представляют собой соединение двух труб. 

 Elast elbow 18 – элементы типа PIPE18 предназначены для 

моделирования криволинейных отрезков труб. Данные элементы 

можно применять только с линейными материалами. 

 Plast straight 20 – элементы типа PIPE20 предназначены для 

моделирования прямолинейных отрезков труб. В отличие от 

элементов типа PIPE16, их можно применять  с нелинейными 

материалами. 

 Plast elbow 60 – элементы типа PIPE60 предназначены для 

моделирования криволинейных отрезков труб. В отличие от 

элементов типа PIPE18, их можно применять с нелинейными 

материалами. 
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Элементы категории Solid 

Элементы данной категории предназначены для использования при 

расчете твердотельных моделей. Количество узлов у данных элементов 

может быть от 3 до 20, в зависимости от геометрии элемента. Данная 

категория содержит элементы, которые могут применяться для расчета как 

плоских, так и трехмерных моделей. Типы элементов для плоских моделей 

имеют название PLANE, а для трехмерных SOLID 

Плоские типы элементов 

 Quad 4node 42 – элемент PLANE42 представляет собой плоский 

четырехугольник и может использоваться в расчетах на 

прочность с использованием линейных, а также  пластических и 

других нелинейных материалов, за исключением 

гиперэластичных. Данный элемент может вырождаться и 

принимать треугольную форму. Использование данных 

элементов треугольной формы не рекомендуется, так как 

уменьшает точность расчета. Для подобных случаев лучше 

использовать элементы PLANE82, описанные ниже (Рисунок 55). 

 Quad 4node 182 – элемент PLANE182 аналогичен предыдущему, 

но может применяться для расчетов с использованием 

гиперэластичных материалов. 

 Quad 8node 82 – элемент PLANE82 представляет собой плоский 

четырехугольник, подобный PLANE42. В отличие от PLANE42, 

он имеет не четыре, а восемь узлов, и позволяет получать более 

точные результаты без увеличения количества элементов в 

модели. Особенно это касается полученных автоматически сеток 

из трех и четырехугольных элементов. Кроме того, подобные 

элементы точнее описывают геометрические компоненты с 

большой кривизной. Этот элемент может вырождаться в 

треугольник (Рисунок 55). 
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Рисунок 55. Обычная и вырожденная форма элемента PLANE82 
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 Quad 8node 183 – элемент PLANE183 аналогичен предыдущему, 

но может применяться для расчетов с использованием 

гиперэластичных материалов. 

 Triangle 6node 2 – элемент PLANE2 представляет собой 

треугольник с шестью узлами – тремя по углам и тремя 

промежуточными в серединах сторон. 

 Последний элемент совместим с элементом PLANE82, то есть 

может использоваться в смешанных сетках, где есть как 

треугольные, так и четырехугольные элементы. Как правило, он 

применяется для неупорядоченных сеток. 

Объемные типы элементов 

 Brick 8node 45 – элемент SOLID45 представляет собой объемный 

шестигранник с восемью узлами, расположенными в вершинах. 

Данный тип элементов позволяет использовать изотропные 

пластичные и другие нелинейные виды материалов, за 

исключением гиперэластичных. Элементы данного типа могут 

принимать вырожденные формы, например призматическую или 

четырехгранную (Рисунок 56). Тем не менее, использование 

данного типа элементов в сетках с вырожденными элементами не 

рекомендуется. Вместо него следует использовать SOLID95, 

описанный ниже. 
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Рисунок 56. Обычная и вырожденные формы элемента SOLID45 

 

 Brick 8node 185 – элемент SOLID185 аналогичен элементу 

SOLID45, но позволяет использовать гиперэластичные 

материалы. 

 Brick 20node 95 – элемент SOLID95 представляет собой 

объемный шестигранник, подобный SOLID45, но имеющий не 8, 

а 20 узлов. К узлам, находящимся в вершинах, добавлены 

промежуточные узлы на серединах сторон. Данный тип 
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элементов лучше, чем SOLID45, приспособлен для 

использования в нерегулярных сетках. Он поддерживает 

элементы вырожденной формы: четырехгранные, 

призматические, пирамидальные (Рисунок 57). Данный тип 

элементов позволяет использовать изотропные пластичные и 

другие нелинейные виды материалов, за исключением 

гиперэластичных. 
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Рисунок 57. Обычная и вырожденные формы элемента SOLID95 

 

 Brick 8node 186 – элемент SOLID186 аналогичен элементу 

SOLID95, но позволяет использовать гиперэластичные 

материалы. 

 Brick aniso 64 – элемент SOLID64 аналогичен элементу 

SOLID45, но позволяет использовать анизотропные материалы. 

 Brick concret 65 – элемент SOLID65 аналогичен элементу 

SOLID45, но позволяет моделировать поведение бетона, в 

частности, разрушение при сжатии. 

 Tet 10node 92 – элемент SOLID92 представляет собой объемный 

четырехгранник с десятью узлами, расположенными в вершинах 

и серединах сторон. Элементы данного типа лучше всего 

использовать для нерегулярных сеток, полученных свободным 

разбиением. Данный тип элементов позволяет использовать 



 

 

67 

изотропные пластичные и другие нелинейные виды материалов, 

за исключением гиперэластичных.  

 Tet 10node 187 – элемент SOLID187 аналогичен элементу 

SOLID92 но позволяет использовать гиперэластичные материалы. 

 

Элементы категории Shell 

Элементы данной категории используются для моделирования 

тонкостенных оболочечных конструкций. Элементы данных типов имеют 

название SHELL. 

 Elastic 4node 63 – элементы типа SHELL63 имеют форму 

четырехугольной тонкой пластины с четырьмя узлами по углам. 

Данный тип элементов позволяет использовать только линейные 

материалы. Элементы этого типа могут принимать вырожденную 

треугольную форму. 

 Elastic 8node 93 – элементы типа SHELL93 имеют форму 

четырехугольной тонкой пластины с восемью узлами: четырьмя 

узлами по углам и четырьмя по серединам ребер пластины. 

Данные элементы лучше всего подходят для моделирования 

пластин с большой кривизной. Также элементы этого типа 

позволяют использовать нелинейные материалы. 

 Plastic 4node 43 – элементы типа SHELL43 подобны элементам 

SHELL63, но допускают использование нелинейных материалов, 

кроме того пластины, моделируемые данными элементами, могут 

быть достаточно толстыми. 

 Hyper 4node 181 – элементы типа SHELL181 подобны SHELL43, 

но могут также использоваться в расчетах с большими 

деформациями, а также в задачах с гиперэластичными 

материалами. 

 

Элементы категории Solid-Shell. 

 3d finite strain 190 – элементы типа SOLSH190 элементы для 

моделирования оболочечные структуры с широким диапазоном 

толщины (от тонкого до умеренно толстого). Данный тип 

элементов позволяет использовать нелинейно-деформируемые 

материалы, а также моделировать композиционные слоистые 

конструкции. Элементы данного типа представляют собой 
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объемный шестигранник с восемью узлами, расположенными в 

вершинах в отличие от элементов категории Shell. 

Элементы категории Constraint 

 Nonlinear MPC 184 – элементы типа MPC184 используются для 

моделирования сложных кинематических соединений. 

 

 

Элементы раздела Thermal 

Элементы, находящиеся в данном разделе, в основном используются 

для решения задач теплопроводности. 

Элементы категории Link 

 Link 2D Conduction 32 – элемент LINK32 предназначен для 

двумерных расчетов, и представляет собой стержень с двумя 

узлами на концах. Единственная выполняемая им функция – 

пропускание тепла от одного узла к другому. Свойства данного 

элемента задаются с помощью свойств материала и поперечного 

сечения стержня. 

 Link 3D Conduction 33 – элемент LINK33 аналогичен 

предыдущему, но предназначен для использования в трехмерных 

задачах. 

Элементы категории Solid  

Элементы данной категории используются для моделирования 

теплопроводности в твердотельных моделях. Они могут иметь от 4 до 20 

узлов и применяться в плоских и объемных задачах. Типы элементов для 

плоских моделей имеют название PLANE а для трехмерных SOLID. 

Плоские типы элементов 

 Quad 4node 55 – элемент PLANE55 представляет собой 

четырехугольник с четырьмя узлами по углам элемента. 

Элементы данного типа могут также принимать вырожденную 

треугольную форму. 

 Quad 8node 77 – элемент PLANE77 аналогичен PLANE55 но 

имеет восемь узлов: четыре не углах и четыре на серединах 

сторон. 
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 Triangl 6node 35 – элемент PLANE35 представляет собой 

треугольник с шестью узлами – тремя на вершинах и тремя на 

серединах сторон. Данные элементы предназначены для 

использования в нерегулярных сетках, а также в сетках с 

элементами разной формы вместе с элементами PLANE77.  

Объемные типы элементов 

 Brick 8node 70 – элемент SOLID70 представляет собой 

шестигранник с восемью узлами на углах. Элементы данного 

типа могут иметь также вырожденную форму в виде призмы или 

четырехгранника. 

 Brick 20node 90 – элемент SOLID90 аналогичен элементу 

SOLID70, но имеет не восемь, а двадцать узлов – восемь на 

вершинах и двенадцать на серединах сторон. Элементы данного 

типа больше подходят для моделирования объектов с большой 

кривизной. 

 Tet 10node 87 – элемент SOLID87 представляет собой 

четырехгранник с десятью узлами – четырьмя на вершинах и 

шестью на серединах сторон. Данный тип элементов 

предназначен для использования в нерегулярных сетках. 

 

Общие сведения о MeshTool 

В данном разделе описываются средства ANSYS для разбиения 

твердотельной модели на элементы. Наиболее удобным средством при 

построении разбиения является не использование пунктов главного меню, а 

применение средств MeshTool. Поэтому, по возможности, в порядке 

убывания наглядности, вначале каждого раздела описываются средства 

MeshTool, а уже затем пункты главного меню и команды.  

MeshTool (пункт главного меню: Main Menu> Preprocessor> Meshing> 

MeshTool) представляет собой диалоговое окно, в котором собраны 

практически все инструменты, необходимые для настройки и создания 

конечно-элементной сетки (Рисунок 58). Оно остается на экране до тех пор, 

пока пользователь не закроет его с помощью кнопки Close или не выйдет с 

помощью команды PREP7. 

Используя MeshTool, можно не вводить длинных команд с клавиатуры 

и не использовать громоздкие многоуровневые меню. Это окно аналогично 

«палитрам» современных САПР, хотя, безусловно, менее наглядно. 
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Функции доступные через MeshTool включают: 

 Управление уровнями SmartSizing; 

 Управление размерами элементов; 

 Определение формы элемента; 

 Определение типа разбиения (свободный или упорядоченный); 

 Разбиение компонентов твердотельной модели; 

 Очистку разбиения; 

 Уточнение сеток; 

Для детализированного изучения MeshTool, вызовите его, используя 

пункт меню, указанный выше, и нажмите на клавишу Help. 

 

 
Рисунок 58. Диалоговое окно MeshTool 
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Указание размеров элементов 

Установка размеров элементов «по умолчанию» 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

Manual Size> Global> Other 

При использовании указанного выше пункта меню появляется 

диалоговое окно Other Global Sizing Options (Рисунок 59). 

 

 
Рисунок 59. Вид окна Other Global Sizing Options: MINL, MINH – поля 

ввода минимального количество элементов, создаваемых на линии для 

обычных и квадратичных элементов соответственно; MXEL –поле ввода 

максимального количества элементов, создаваемых на линии; ANGL, 

ANGH – поля ввода максимального угла, приходящегося на один элемент при 

разбиении дуг для обычных и квадратичных элементов соответственно; 

EDGMN, EDGMX – поля ввода минимальной и максимальной длинны ребра 

элемента при разбиении; ADJF, ADJM – поля ввода соотношений размеров 

элементов для смежных линий для свободного и упорядоченного разбиения 

соответственно 
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Команда  

Команда DESIZE позволяет изменять такие установки «по умолчанию» 

как минимальное и максимальное количество элементов, которые будут 

присоединены к линии, максимальный угол занимаемый ребром элемента на 

дуге, а также максимальную и минимальную длину ребра элемента.  

Общий вид команды DESIZE при вводе с клавиатуры  

DESIZE, MINL, MINH, MXEL, ANGL, ANGH, EDGMN, EDGMX, ADJF, 

ADJM 

где параметры MINL, MINH, MXEL, ANGL, ANGH, EDGMN, EDGMX, 

ADJF, ADJM описаны выше (Рисунок 59). 

Установка размеров элементов для отдельных компонентов модели 

Во многих случаях сетка, созданная на основе размеров элементов «по 

умолчанию», не приемлема из-за особенностей модели. В качестве примеров 

можно привести модели с концентраторами напряжений или 

сингулярностями. В таких случаях пользователю следует проявить несколько 

большее участие в процессе разбиения. ANSYS позволяет установить 

плотность разбиения для конкретного компонента модели. 

Средства MeshTool 

Для установки или очистки размеров элементов с помощью MeshTool 

следует пользоваться кнопками из третьей сверху секции диалогового окна 

(Рисунок 60).  

 

 
Рисунок 60. Третья секция окна MeshTool 
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Слева от кнопок находятся метки, указывающие, для каких 

компонентов устанавливаются размеры элементов: 

 Global – при использовании данных кнопок размеры элементов 

указываются для всех компонентов модели (команда ESIZE). 

 Areas – при использовании данных кнопок размеры элементов 

указываются для поверхностей (команда AESIZE). 

 Lines – при использовании данных кнопок размеры элементов 

указываются для линий (команда LESIZE). 

 Keypts – при использовании данных кнопок размеры элементов 

указываются в районе ключевых точек (команда KESIZE). 

В случае нажатия кнопки Set с меткой Global появляется окно 

Global Element Sizes (Рисунок 61), в котором можно установить размеры для 

всех активных компонентов модели.  

 

 
Рисунок 61. Вид окна Global Element Sizes: SIZE – поле ввода длинны ребра 

элемента, используемой «по умолчанию» на границах разбиваемого 

компонента; NDIV – поле ввода количества делений на границе разбиваемого 

компонента 

 

З а м е ч а н и е! Если параметр SIZE пропущен или равен 0, то следует 

использовать параметр NDIV. 

Во всех остальных случаях, при нажатии кнопки Set сначала появляется 

диалоговое окно выбора Elem Size at Picked … (вместо многоточия будет 

написан тип компоненты, например: Areas, Lines или Keypts), с помощью 

которого следует выбрать (с помощью «мыши» или командной строки), для 

каких конкретно компонентов следует установить размер элемента. После 

выбора компонентов появляется диалоговое окно, в котором следует ввести 

необходимый размер (или размеры) элементов.  
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З а м е ч а н и е! С помощью MeshTool можно также удалить 

установленные размеры элементов. Это производится с помощью кнопок 

Clear находящихся рядом с соответствующими кнопками Set.  

Указание размеров элементов для всех компонентов 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Global> Size 

При его использовании появляется диалоговое окно 

Global Element Sizes, описанное выше, в котором следует ввести размер 

элемента «по умолчанию» и нажать OK. 

Команда  

Общий вид при вводе с клавиатуры: 

ESIZE, SIZE, NDIV  

где: 

 SIZE – длинна ребра элемента используемая «по умолчанию» на 

границах разбиваемого компонента. Если данный параметр 

пропущен или равен 0, следует использовать параметр NDIV. 

 NDIV – количество делений на границе разбиваемого 

компонента. Данный параметр используется, если не задан SIZE. 

Указание размеров элементов на поверхностях 

Первый пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Areas> All Areas  

При использовании этого пункта появиться диалоговое окно, в котором 

необходимо указать в поле ввода SIZE длину ребра элементов, используемую 

«по умолчанию» на всех поверхностях модели. 
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Второй пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Areas> Picked Areas 

При использовании этого пункта появится диалоговое окно выбора, с 

помощью которого необходимо указать поверхности, для которых будут 

установлены размеры элементов. После подтверждения выбора (нажатия 

кнопки OK) появится окно, в котором в поле ввода SIZE следует указать 

длину ребра элементов выбранных поверхностей. 

Третий пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Areas> Clr Size  

Данный пункт меню служит для удаления ранее установленных 

размеров элементов на поверхности. 

Команда  

AESIZE, ANUM, SIZE 

где  

 ANUM – номер поверхности, к которой будут применены 

ограничения на размер элементов; 

 SIZE - длинна ребра элементов, используемая на указанных 

поверхностях. 

Установка размеров элементов, создаваемых на линиях 

Первый пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Lines> All Lines 
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Второй пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Lines> Picked Lines 

Третий пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Lines> Clr Size 

Данный пункт меню служит для удаления ранее установленных 

размеров элементов на линиях. 

Команда  

Общий вид команды при вводе с клавиатуры: 

LESIZE, NL1, SIZE, ANGSIZ, NDIV, SPACE, KFORC, LAYER1, LAYER2, 

KYNDIV 

где: 

 NL1 – номер линии, к которой будут применены указанные 

размеры. Если этот параметр равен All, то размеры элементов 

будут применены ко всем активным линиям. Если этот параметр 

равен P, то линии должны быть указаны на экране с помощью 

мыши; 

 SIZE – длинна ребра элемента, создаваемого на линии 

(применяется если параметр NDIV пропущен). Если данный 

параметр равен 0, то применяется один из следующих 

параметров; 

 ANGSIZ – длинна дуги, занимаемой ребром одного элемента; 

 NDIV – количество элементов, на которые делится линия; 

 SPACE – отношение длинны последнего элемента на линии к 

длине первого; 

З а м е ч а н и е! Если вы используете графический интерфейс, чтобы 

установить количество элементов на линиях, и хотя бы одна из этих 

линий соединена с другими линиями или плоскостями, которые разбиты 

на элементы, то ANSYS выдаст запрос на очистку данных компонентов 
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от разбиения. При положительном ответе ANSYS очистит их от 

конечно-элементной сетки. Следует отметить, что данный запрос 

возникает только при использовании графического интерфейса. При 

выполнении команды LESIZE с помощью командной строки никаких 

запросов не выдается. 

Указание размеров элементов в районе ключевых точек 

Первый пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Keypoints> All KPs 

Второй пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Keypoints> Picked KPs 

Команда 

Общий вид команды при вводе с клавиатуры: 

KESIZE, NPT, SIZE, FACT1, FACT2  

где: 

 NPT – номер ключевой точки, к которой будут применены 

указанные размеры. Если этот параметр равен All, то размеры 

элементов будут применены ко всем активным ключевым точкам. 

Если этот параметр равен P, то точки должны быть указаны на 

экране с помощью мыши. 

 SIZE – длинна ребра элемента, создаваемого на линиях, 

примыкающих к данной ключевой точке. Если данный параметр 

равен 0, то применяется один из следующих параметров. 

 FACT1 – коэффициент масштабирования, применяемый к 

существовавшим ранее настройкам.  

 FACT2 – коэффициент масштабирования, применяемый к 

наименьшему делению на линии, соединенной с данной 

ключевой точкой. 
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Понятие о свободном и упорядоченном разбиении модели 

Общие сведения 

Перед разбиением модели и даже перед созданием геометрии модели, 

важно определить какое разбиение соответствует вашему анализу: свободное 

или упорядоченное (Рисунок 62). 

 

 
Рисунок 62. Пример упорядоченного (слева) и свободного (справа) 

разбиений 

 

 Свободное разбиение предназначено для построения конечно 

элементной сетки на компонентах со сложной геометрией. Оно не 

накладывает жестких ограничений на геометрию модели, и сетка 

в результате его работы будет не упорядоченной. Кроме того, 

сетка, созданная с помощью свободного разбиения, может 

содержать элементы различной формы. Так, при построении 

разбиения на поверхности, сетка может содержать и 

четырехугольные и треугольные элементы. 

 Упорядоченное разбиение предназначено для построения 

конечно-элементной сетки на компонентах с простой геометрией, 

как правило близких (в топологическом смысле) к 

четырехугольнику в двумерном случае и шестиграннику 

(паралелепипеду) в трехмерном. При упорядоченном разбиении 

сетка является регулярной, состоящей из четко прослеживаемых 

рядов элементов. Сетка, созданная с помощью упорядоченного 

разбиения, состоит из элементов только одной формы. Плоские 

элементы могут быть либо четырехугольной, либо треугольной 



 

 

79 

формы. Объемные элементы при упорядоченном разбиении могут 

быть только шестигранными. 

З а м е ч а н и е! Если есть возможность, желательно использовать 

упорядоченное разбиение, так как оно обычно приводит к созданию 

элементов правильной формы, что увеличивает точность решения 

задачи. 

Даже если включено свободное разбиение, ANSYS автоматически ищет 

форму элементов, которые соответствуют шаблонам упорядоченного 

разбиения. Если соответствие найдено, объем будет разбит с помощью 

упорядоченного переходного разбиения (за исключением тех случаев, когда 

такое разбиение будет приводить к созданию элементов неправильной 

формы). 

 

Упорядоченное разбиение 

Шаблоны упорядоченного разбиения 

Если на четырех сторонах поверхности имеется различное количество 

делений на элементы, то упорядоченное разбиение будет построено только в 

случае соответствия этого количества одному из шаблонов переходного 

упорядоченного разбиения (Рисунок 63). Для поверхностей существует два 

шаблона упорядоченного переходного разбиения: 

 

A

C

BD

 
Рисунок 63. Разбиваемая поверхность 

 

1. При построении упорядоченного разбиения с помощью первого 

шаблона, количество делений на сторонах D и B должно быть равным 
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(Рисунок 63), а количество делений на стороне A должно быть больше 

количества делений на стороне C на четное число (Рисунок 64). 

 

 
Рисунок 64. Первый шаблон упорядоченного разбиения 

 

2. При разбиении с помощью второго шаблона упорядоченного 

разбиения, разности делений сторон A, C и D, B должны быть равны, то есть 

 A-C = D-B. Результатом будет разбиение приведенное на Рисунок 65. 

 

 
Рисунок 65. Второй шаблон упорядоченного разбиения 

 

Особенности указания размеров элементов при упорядоченном 

разбиении 

При использовании упорядоченного разбиения можно указать 

программе использовать только четырехугольные плоскостные элементы, 

только треугольные элементы, только шестигранные объемные элементы для 

создания упорядоченной сетки. Упорядоченное разбиение подразумевает, что 
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разбиваемая поверхность или объем должны быть правильной формы (это 

указано в начале главы). 

При упорядоченном разбиении размеры элементов основаны на 

установках, сделанных с помощью пунктов главного меню рассмотренных 

выше в разделе «УКАЗАНИЕ РАЗМЕРОВ ЭЛЕМЕНТОВ» и далее.  

З а м е ч а н и е! Команда DESIZE всегда применяется для установки 

размеров элементов при упорядоченном разбиении. 

Критерии для проведения упорядоченного разбиения плоскостей  

Упорядоченное разбиение плоскости может состоять либо только из 

четырехугольных элементов, либо только из треугольных. 

Поверхность, разбиваемая упорядоченным разбиением, должна 

соответствовать следующим критериям: 

1. Поверхность должна быть ограничена либо тремя, либо четырьмя 

линиями. 

З а м е ч а н и е! Если поверхность ограничена более чем четырьмя 

линиями, она не может быть разбита упорядоченным разбиением. Тем 

не менее, некоторые линии могут быть объединены, что уменьшит 

количество линий до четырех. 

2. На противоположных сторонах поверхности должно быть 

установлено одинаковое количество делений на элементы, либо деления 

должны соответствовать одному из шаблонов упорядоченного разбиения.  

З а м е ч а н и е! Нет необходимости назначать количество элементов 

для всех линий. Если применяется упорядоченное разбиение (MSHKEY,1) 

программа перенесет количество элементов с одной линии на 

противоположную ей.  

3. Если поверхность ограничена тремя линиями, общее количество 

делений на элементы должно быть четным. 

4. Должна быть включена опция MSHKEY (вид команды при вводе 

с клавиатуры MSHKEY,1), включающая упорядоченное разбиение. При 

использовании данной опции будет создана сетка только из 

четырехугольных, либо только из треугольных элементов, в зависимости от 

текущего типа элемента и установок команды MSHAPE. 

5. Если целью является создание упорядоченной сетки из 

треугольных элементов, можно также указать ANSYSу какой шаблон для 
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разбиения использовать с помощью команды MSHPATTERN. Если шаблон 

не указан, ANSYS выберет его самостоятельно. 

 

Средства автоматического соединения линий при проведении 

упорядоченного разбиения 

Вместо объединения линий, может быть использован пункт главного 

меню Main Menu> Preprocessor> Meshing> Mesh> Areas> Mapped> 

By Corners и команда AMAP, которые описаны в следующем разделе. 

З а м е ч а н и е! Если поверхность ограничена более чем четырьмя 

линиями, чтобы уменьшить общее количество линий до четырех, можно 

объединить некоторые линии командой LCOMB или соединить командой 

LCCAT. Там, где можно использовать команду LCOMB (если линии в 

точке соединения имеют общую касательную, и относятся к одной и 

той же поверхности) ее следует предпочитать команде LCCAT. 

Критерии построения упорядоченного разбиения объемов.  

Чтобы разбить объем с помощью шестигранных элементов, должны 

быть удовлетворены следующие условия: 

1. Объем должен иметь форму близкую к:  

 паралелепипеду (объем должен быть шестигранным);  

 клину или призме (объем ограничен пятью поверхностями);  

 тетраэдру (объем ограничен четырьмя поверхностями); 

2. Объем должен иметь одинаковое количество делений на 

элементы, заданное на противоположных сторонах, либо деления должны 

соответствовать одному из шаблонов упорядоченных сеток. 

3. Количество элементов на границах треугольных поверхностей 

должно быть четным, в случае использования призматических или 

четырехгранных элементов. 

 

Средства соединения поверхностей для проведения упорядоченного 

разбиения 

Поверхности, также как и линии можно складывать (команда AADD) 

или соединять (команда ACCAT) если следует уменьшить количество 

поверхностей, ограничивающих объем, для упорядоченного разбиения.  
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З а м е ч ан и е! Везде, где это возможно, следует предпочитать команду 

AADD (сложение) команде ACCAT (соединение). 

После соединения поверхностей (например, с использованием команды 

ACCAT) следует соединять линии, их ограничивающие (т.е. использовать 

команду LCCAT). 

В случае, когда обе соединяемые поверхности ограничены четырьмя 

линиями, операция соединения линий будет выполнена автоматически. 

Следовательно, если поверхности ограничены четырьмя линиями, 

выполнение команды LCCAT не требуется. Также следует отметить, что 

удаление соединенной поверхности, не вызовет автоматического удаления 

соединенных линий связанных с ней. 

З а м е ч а н и е! Команда ACCAT не используется для моделей, 

импортированных из IGES файлов. Для объединения поверхностей у 

таких моделей следует использовать команду ARMERGE. 

Свободное разбиение 

Использование SmartSizing 

З а м е ч а н и е! Установки, заданные командой DESIZE используются 

«по умолчанию» при свободном разбиении. Однако при свободном 

разбиении рекомендуется использовать SmartSizing. 

SmartSizing это функция разбиения, позволяющая задать базовый 

размер элементов для операций свободного разбиения. SmartSizing дает 

пользователю большую вероятность создания сетки с элементами 

правильного размера и формы при автоматическом создании сетки. Эта 

функция, которая обычно управляется с помощью команды SMRTSIZE 

позволяет установить плотность разбиения от грубой до точной сетки. 

При использовании SmartSizing рекомендуется указать желаемые 

установки и затем разбивать сразу всю модель, нежели разбивать 

поверхности или объемы по одному.  

З а м е ч а н и е! Разбиение модели по частям с использованием 

SmartSizing может привести к созданию неудовлетворительной сетки. 

Алгоритм SmartSizing сначала вычисляет ожидаемую длину ребра 

элемента для всех линий в разбиваемых на элементы поверхностях или 
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объемах. Далее длины уточняются с учетом кривизны и близости 

геометрических компонент. Так как для всех поверхностей и линий 

вычисляются размеры до того, как производится разбиение, качество 

создаваемой сетки не зависит от того, в каком порядке разбиваются 

поверхности или объемы.  

Если для разбиения поверхностей используются четырехугольные 

элементы, SmartSizing пытается установить четное количество делений на 

всех линиях, составляющий периметр поверхности, чтобы можно было 

создать сетку, состоящую только из четырехугольных элементов. 

Треугольные элементы будут включены в сетку, только если разбиение 

приводит к созданию элементов с нарушениями формы, или на границах 

существует нечетное количество элементов. 

З а м е ч а н и е! У SmartSizing есть две группы настроек: базовые и 

продвинутые опции. Рассмотрение продвинутых настроек не входит в 

задачи данного пособия, поэтому ограничимся рассмотрением базовых 

настроек. 

Включение SmartSizing средствами MeshTool 

Для включения SmartSizing следует во втором разделе MeshTool 

выбрать пункт Smart Size ( ) и с помощью расположенного ниже ползунка 

установить уровень плотности сетки (Рисунок 66). 

 

 
Рисунок 66. Вид второй секции MeshTool: Fine – плотное (хорошее) 

разбиение; Coarse – грубое разбиение 

 

При использовании MeshTool уровень размера элементов сетки от 1 

(наиболее мелкая сетка) до 10 (наиболее грубая) указывается в виде числа под 

полосой прокрутки (Рисунок 67).  
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Рисунок 67. Разбиение с различными уровнями SmartSizing 

 

Включение SmartSizing с помощью главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls> 

SmartSize> Basic 

При использовании данного пункта меню появляется диалоговое окно 

Basic SmartSize Settings (Рисунок 68). В выпадающем списке следует выбрать 

плотность разбиения (значения от 1 до 10), либо Off, чтобы отключить 

SmartSizing. 

 

 
Рисунок 68. Вид окна Basic SmartSize Settings 
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Включение SmartSizing с помощью командной строки  

SMRTSIZE, SIZLVL 

При использовании базовых опций просто следует указать уровень 

размера элементов сетки от 1 (наиболее мелкая сетка) до 10 (наиболее грубая) 

в качестве значений параметра SIZLVL.  

З а м е ч а н и е! Для включения SmartSizing с использованием командной 

строки следует просто указать уровень размера элементов с помощью 

команды SMRTSIZE. 

Некоторые правила разрешения конфликтов при включенном 

Smart Size (команда SMRTSIZE) или DESIZE 

Для любой заданной линии размеры элементов, находящихся на ней, 

определяются следующим образом:  

 Всегда сохраняются размеры элементов, заданные на линиях; 

 Если не задано количество делений на линии, используются 

размеры, заданные в ее ключевых точках. Однако, данные 

размеры могут быть изменены в случае кривизны и малых 

геометрических компонентов модели. 

 Если размеры элементов не заданы ни на линии, ни в ключевых 

точках, используются размеры, заданные для всех компонентов 

(команда ESIZE) как начальные, но они могут быть изменены в 

случае кривизны и малых геометрических компонентов модели. 

 Если размеры не указаны ни одним из вышеуказанных способов, 

они устанавливаются исходя из настроек команды SMRTSIZE 

либо DESIZE (в зависимости от того, что используется). 

З а м е ч а н и е! «По умолчанию» SmartSizing выключен, и для разбиения 

используются установки, указанные с помощью команды DESIZE. 

Создание сетки с элементами переменного размера 

Большинство настроек разбиения касаются установки количества 

элементов на границах компонентов модели. Тем не менее есть способы 

настройки плотности разбиения во внутренних областях поверхностей и 

объемов. 
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Для поверхностей 

Так как обычно высокая плотность разбиения требуется на границах 

поверхностей, а в центре разбиение может быть более грубым без потери 

точности результатов, существует возможность уменьшить плотность сетки в 

центре. Для этого следует использовать пункты меню: 

Main Menu> Preprocessor> Meshing> Size Cntrls> ManualSize> Global> 

Area Cntrls 

При выборе данного пункта появляется диалоговое окно 

Global Element Sizes (Рисунок 69).  

 

 
Рисунок 69. Диалоговое окно Global Element Sizes 

 

Поле ввода EXPND позволяет указать коэффициент увеличения 

элементов внутри области. Если он равен 1, увеличения не происходит, если 

он равен 2 элементы внутри области будут примерно в 2 раза больше 

элементов на границе. Данный коэффициент может принимать значения от 

0.5 до 4. Если значение меньше 1, элементы внутри области будут меньше 

элементов на границе. В приведенном ниже рисунке, первая область разбита с 

коэффициентом равным 1, а вторая – с коэффициентом равным 2. Первая 

сетка имеет в своем составе 401 элемент, а вторая 135 элементов. К 

сожалению, во втором случае некоторые элементы имеют слишком 

неправильную форму, что может отрицательно сказаться на результатах 

расчета. Для того, чтобы этого не призошло, служит второе поле ввода окна 

Global Element Sizes – поле TRANS. В нем можно указать коэффициент 

задающий отношение размеров соседних элементов. «По умолчанию» он 

равен 2, то есть соседние элементы могут отличаться по размеру в 2 раза. 

Если задать его равным 1.5, то получится сетка изображенная на рисунке 

внизу. Элементы составляющие ее имеют более правильную форму, чем у 
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второй, при этом количество элементов в ней равно 173, что более чем в 2 

раза меньше количества элементов в первой сетке (Рисунок 70). 

 

 
Рисунок 70. Сетки с элементами переменного размера 

 

Для объемов 

Если необходимо задать изменение размера элементов для объемных 

сеток следует использовать пункт меню  

Main Menu> Preprocessor> Meshing> Size Cntrls> ManualSize> Global> 

Volu Cntrls 

При его выполнении появится диалоговое окно 

Interior Tet Element Sizing Control for RV52, в котором в поле TETEXPND 

следует указать коэффициент изменения размера элементов и нажать OK. 
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Чтобы задать создание сетки с переменным размером элементов с 

помощью командной строки, следует использовать команду MOPT, EXPND, 

третьим параметром в которой следует указать значение коэффициента. Для 

трехмерного случая используется команда MOPT, TETEXPND, . Чтобы 

задать более плавный переход между размерами элементов, следует 

использовать команду MOPT, TRANS, где третьим параметром также 

указывается значение коэффициента. 

Дополнительные параметры, используемые при разбиении модели 

Ознакомление с этим разделом необходимо только в одном из ниже 

перечисленных случаев:  

 модель содержит компоненты, выполненные из различных 

материалов; 

 необходимо провести разбиение различными типами элементов 

либо одним типом элементов, но с разными значениями 

параметров; 

З а м е ч а н и е! При первом знакомстве с ANSYS и решении простейших 

задач для моделей простейшей структуры (для всей модели используется 

один материал и одни и те же элементы и т.д.) содержание этого 

раздела можно пропустить. 

Пред созданием разбиения на узлы и элементы пользователь должен 

определить следующее: 

 Номер типа элемента; 

 Набор вещественных констант (обычно содержащих 

геометрические свойства элементов, таких как толщина и др.); 

 Номер материала; 

Кроме того, для балочных элементов: 

 Номер, описывающий сечение балочных элементов;  

 Для балочного разбиения также необходимо задать ключевые 

точки ориентации; 

Пользователю не обязательно для каждого компонента модели каждый 

раз определять опции. Достаточно имеет возможность определить атрибуты 

которые будут использоваться в дальнейшем «по умолчанию». При этом 

пользователь имеет возможность изменить в дальнейшем созданные им 

установки «по умолчанию» для каждого компонента модели в отдельности. 
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Назначение пользователем атрибутов, используемых «по умолчанию» 

Средства MeshTool 

Чтобы назначить для модели атрибуты, которые будут использоваться 

«по умолчанию», в верхней секции окна MeshTool из выпадающего списка 

Element Attributes следует выбрать пункт Global и нажать кнопку Set 

(Рисунок 71). 

 

 
Рисунок 71. Верхняя секция окна MeshTool 

 

В результате появится диалоговое окно Meshing Attributes, в котором 

следует выбрать используемые «по умолчанию» номер типа элемента, номер 

материала, номер набора вещественных констант и координатные системы 

элементов (Рисунок 72). 

 

 
Рисунок 72. Вид окна Meshing Attributes 

 

За выбор номера типа элемента отвечает выпадающий список 

Element type number, за выбор номера материала отвечает список 

Material number, за константы и системы координат Real constant set number 
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и Element coordinate sys соответственно. Наиболее используемыми списками 

являются первые два, а остальные используются в особых случаях. 

После выбора необходимых номеров следует нажать кнопку OK, чтобы 

подтвердить ввод данных, либо отменить ввод новых установок – т.е. нажать 

Cancel. 

З а м е ч а н и е! Для балочного разбиения следует также указать номер 

сечения в списке Section number. 

Пункт главного меню и команды 

При использовании главного меню следует выбрать пункт:  

Main Menu> Preprocessor> Meshing> Mesh Attributes> Default Attribs 

В этом случае появится описанное выше диалоговое окно 

Meshing Attributes (Рисунок 72). Если необходимо назначить номер элемента 

и другие атрибуты, используемые «по умолчанию» с помощью команд, 

вводимых с клавиатуры, надо использовать следующие команды: TYPE, 

REAL, MAT, ESYS, SECNUM. 

З а м е ч а н и е! Если используется один материал и один тип конечных 

элементов, то они и будут использоваться «по умолчанию», и указывать 

их специально нет необходимости. 

Назначение атрибутов отдельным объемам 

Средства MeshTool 

Для того, чтобы назначить атрибуты отдельным объемам модели 

следует:  

1. В выпадающем списке Element Attributes (Рисунок 71) окна 

MeshTool выбрать тип компонента (в данном случае Volumes).  

2. Нажать кнопку Set; 

3. После появления окна выбора Volumes Attributes необходимо 

выбрать с помощью «мыши» или командной строки объем или объемы, 

параметры которого (которых) должны быть установлены. 

4. Подтвердить выбор нажатием кнопки OK или Apply. 

5. Выбрать в появившемся диалоговом окне необходимые 

установки  
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З а м е ч а н и е! Появившееся окно полностью аналогично описанному в 

разделе «Назначение пользователем атрибутов, используемых «по 

умолчанию» окну Meshing Attributes. 

Пункты главного меню 

Выполнение пункта первого и второго из описанной 

последовательности действий с применением MeshTool соответствует 

следующему пункту главного меню: 

Main Menu> Preprocessor> Meshing> Mesh Attributes> Picked Volumes 

При выборе данного пункта появляется диалоговое окно выбора, в 

котором следует указать, каким конкретно объемам модели будут присвоены 

данные атрибуты. После выбора объемов, и нажатия кнопки OK или Apply, 

появится диалоговое окно, аналогичное окну Meshing Attributes, описанному 

выше. 

Если следует присвоить атрибуты всем объемам модели, то следует 

выбрать следующий пункт главного меню: 

Main Menu> Preprocessor> Meshing> Mesh Attributes> All Volumes 

Команда  

VATT, MAT, REAL, TYPE, ESYS 

где MAT, REAL, TYPE, ESYS – номера материала, набора вещественных 

констант, типа элементов и систем координат элементов, присваиваемые 

объемам. 

Команда VATT присваивает указанные атрибуты всем объемам, 

которые в настоящее время выбраны командой VSEL. В случае, если у какого 

либо атрибута следует оставить исходное значение, для него следует указать 

величину –1.  

Назначение атрибутов отдельным поверхностям 

Средства MeshTool 

Для того чтобы назначить атрибуты отдельным поверхностям модели 

следует:  

1. В выпадающем списке Element Attributes (Рисунок 71) окна 

MeshTool выбрать тип компонента (в данном случае Areas).  

2. Нажать кнопку Set. 
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3. После появления окна выбора Areas Attributes необходимо 

выбрать с помощью «мыши» или командной строки поверхность или 

поверхности, параметры которой (которых) должны быть установлены. 

4. Подтвердить выбор нажатием кнопки OK или Apply. 

5. Выбрать в появившемся диалоговом окне необходимые 

установки.  

З а м е ч а н и е! Появившееся окно полностью аналогично описанному в 

разделе «Назначение пользователем атрибутов, используемых «по 

умолчанию» окну Meshing Attributes. 

Пункты главного меню 

Выполнение пункта первого и второго из описанной 

последовательности действий с применением MeshTool, соответствует 

следующему пункту главного меню: 

Main Menu> Preprocessor> Meshing> Mesh Attributes> Picked Areas 

При выборе данного пункта появляется диалоговое окно выбора, в 

котором следует указать, каким конкретно поверхностям модели будут 

присвоены данные атрибуты. После выбора поверхностей и нажатия кнопки 

OK или Apply, появится диалоговое окно аналогичное окну 

Meshing Attributes, описанному выше. 

Если следует присвоить атрибуты всем поверхностям модели, то 

следует выбрать один из следующих пунктов главного меню: 

Main Menu> Preprocessor> Meshing> Mesh Attributes> All Areas 

 

Команда  

Общий вид команды при вводе с клавиатуры: 

AATT, MAT, REAL, TYPE, ESYS  

где MAT, REAL, TYPE, ESYS – номера материала, набора вещественных 

констант, типа элементов и систем координат элементов присваиваемые 

поверхностям. 

Команда AATT присваивает указанные атрибуты всем поверхностям, 

которые в настоящее время выбраны командой ASEL. В случае, если у какого 

либо атрибута следует оставить исходное значение, для него следует указать 

величину –1. 
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Назначение атрибутов отдельным линиям 

Средства MeshTool 

Для того чтобы назначить атрибуты отдельным линиям модели, 

следует:  

1. В выпадающем списке Element Attributes (Рисунок 71) окна 

MeshTool выбрать тип компонента (в данном случае Lines).  

2. Нажать кнопку Set. 

3. После появления окна выбора Lines Attributes необходимо 

выбрать с помощью «мыши» или командной строки линию или линии, 

параметры которой (которых) должны быть установлены. 

4. Подтвердить выбор нажатием кнопки OK или Apply. 

5. Выбрать в появившемся диалоговом окне необходимые 

установки.  

З а м е ч а н и е! Появившееся окно полностью аналогично описанному в 

разделе «Назначение пользователем атрибутов, используемых «по 

умолчанию» окну Meshing Attributes 

 

Пункты главного меню 

Выполнение пункта первого и второго из описанной 

последовательности действий с применением MeshTool соответствует 

следующему пункту главного меню: 

Main Menu> Preprocessor> Meshing> Mesh Attributes> Picked Lines 

При выборе данного пункта появляется диалоговое окно выбора, в 

котором следует указать, каким конкретно линиям модели будут присвоены 

данные атрибуты. После выбора компонентов и нажатия кнопки OK или 

Apply, появится диалоговое окно аналогичное окну Meshing Attributes, 

описанному выше. 

Если следует присвоить атрибуты всем линиям модели, то следует 

выбрать следующий пункт главного меню: 

Main Menu> Preprocessor> Meshing> Mesh Attributes> All Lines 
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Команда 

Общий вид команды при вводе с клавиатуры: 

LATT, MAT, REAL, TYPE, --, KB, KE, SECNUM  

где  

 MAT, REAL, TYPE – номера материала, набора вещественных 

констант, типа элементов присваиваемые линиям. 

 -- - не используемое поле 

 KB, KE – начальная и конечная точки ориентации для линии. 

Если одна или обе точки ориентации не требуются, их номера 

просто следует опустить. 

 SECNUM – номер сечения для линии (для балочных элементов). 

Команда LATT присваивает указанные атрибуты всем линиям, которые 

в настоящее время выбраны командой LSEL. В случае, если у одного или 

нескольких атрибута из MAT, REAL, TYPE следует оставить исходное 

значение, для него следует указать величину –1. 

 

Назначение атрибутов отдельным ключевым точкам 

Средства MeshTool 

Для того чтобы назначить атрибуты отдельным ключевым точкам 

модели, следует:  

1. В выпадающем списке Element Attributes (Рисунок 71) окна 

MeshTool выбрать тип компонента (в данном случае KeyPoints).  

2. Нажать кнопку Set. 

3. После появления окна выбора KeyPoints Attributes необходимо 

выбрать с помощью «мыши» или командной строки ключевую точку или 

точки, параметры которой (которых) должны быть установлены. 

4. Подтвердить выбор нажатием кнопки OK или Apply. 

5. Выбрать в появившемся диалоговом окне необходимые 

установки.  

З а м е ч а н и е! Появившееся окно полностью аналогично описанному в 

пункте «Назначение пользователем атрибутов, используемых «по 

умолчанию» окну Meshing Attributes. 
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Пункты главного меню 

Выполнение пункта первого и второго из описанной 

последовательности действий с применением MeshTool соответствует 

следующему пункту главного меню: 

Main Menu> Preprocessor> Meshing> Mesh Attributes> Picked KPs 

При выборе данного пункта появляется диалоговое окно выбора, в 

котором следует указать, каким конкретно ключевым точкам модели будут 

присвоены данные атрибуты. После выбора компонентов и нажатия кнопки 

OK или Apply, появится диалоговое окно, аналогичное окну 

Meshing Attributes, описанному выше. 

Если следует присвоить атрибуты всем ключевым точкам модели, надо 

выбрать следующий пункт главного меню: 

Main Menu> Preprocessor> Meshing> Mesh Attributes> All Keypoints 

Команда  

Общий вид команды при вводе с клавиатуры: 

KATT, MAT, REAL, TYPE, ESYS  

где MAT, REAL, TYPE, ESYS – номера материала, набора вещественных 

констант, типа элементов и систем координат элементов присваиваемые 

ключевым точкам. 

Команда KATT присваивает указанные атрибуты всем точкам, которые 

в настоящее время выбраны командой KSEL. В случае, если у какого либо 

атрибута следует оставить исходное значение, для него следует указать 

величину –1. 

 

Построение разбиения модели 

После того как построена геометрическая модель, выбраны атрибуты 

элементов, сделаны настройки конечно-элементной сетки, можно приступать 

непосредственно к разбиению модели на конечные элементы. 

Перед этим рекомендуется:  

1. сохранить созданную модель с помощью пунктов меню утилит:  

Utility Menu> File> Save as Jobname.db 

Utility Menu> File> Save as ... 

Либо команды SAVE. 
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2. Включить (по желанию пользователя) с помощью пункта меню: 

Main Menu> Preprocessor> Meshing> Mesher Opts режим, при котором после 

построения сетки будет выводится запрос, следует ли оставить или удалить 

созданное разбиение. Если разбиение отменено, все узлы и элементы 

удаляются. После этого можно изменить установки указанные в предыдущих 

пунктах и повторить операцию разбиения. 

З а м е ч а н и е! Данная опция может быть включена только с помощью 

меню. 

Режим запроса на принятие / отмену можно использовать для 

разбиения поверхностей и объемов. Достоинство его использования 

заключается в том, что не требуется вручную удалять сетку в случае 

неудачного разбиения. 

 

Выбор геометрии элементов 

Как уже было показано ранее, некоторые типы элементов могут иметь 

различную форму. Например, ряд элементов, имеющих четырехугольную 

форму «по умолчанию», могут выродиться в треугольную. Использование 

обоих форм (формы «по умолчанию» и вырожденной) в одном и том же 

разбиении не рекомендуется. (Исключение составляет применение 

переходных пирамидных элементов). 

Поэтому, если пользователь планирует провести разбиение с 

использованием типа элементов, которые могут иметь различную форму в 

рамках одного и того же разбиения, то необходимо установить форму 

элементов, которая должна преобладать.  

 

Разбиение объемов 

Средства MeshTool 

Чтобы разбить объемы модели на конечные элементы с помощью 

MeshTool, следует:  

 в выпадающем списке Mesh: (четвертый раздел MeshTool) 

выбрать тип компонента, который будет разбиваться. В данном 

случае это должен быть Volumes – пункт используемый при 

разбиении объемов (Рисунок 73). 
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Рисунок 73. Четвертая секция MeshTool с установленной опцией Volume 

 

 Указать тип разбиения (Free или Mapped). 

 Указать форму элемента (метка Shape):  

1. Tet соответствует четырехгранным элементам. 

2. Hex - шестигранным элементам.  

 Нажать кнопку Mesh.  

После этого появится диалоговое окно выбора с помощью которого 

следует выбрать разбиваемые компоненты и нажать OK. 

 

Упорядоченное разбиение 

Main Menu> Preprocessor> Meshing> Mesh> Volumes> Mapped> 4 to 6 sided 

При использовании этого пункта появится окно выбора Mesh Volumes, 

с помощью которого необходимо указать объемы, имеющие от 4 до 6 граней, 

которые необходимо разбить. После окончания выбора необходимо нажать 

кнопку OK или Apply.  

 

Свободное разбиение 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Mesh> Volumes> Free 

При использовании этого пункта появится окно выбора Mesh Volumes, 

с помощью которого необходимо указать объемы, которые необходимо 

разбить. После окончания выбора необходимо нажать кнопку OK или Apply. 
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Команда 

Общий вид команды VMESH при вводе с клавиатуры: 

VMESH, NV1, NV2, NINC 

где: 

 NV1 - номер первого разбиваемого объема, если он равен ALL, то 

разбиваются все объемы, а два последующих параметра 

игнорируются. Если данный параметр равен P, то пользователь 

должен выбрать на экране объемы, которые будут разбиты. В 

этом случае все остальные параметры команды игнорируются. 

Если указан номер объема, но два остальных параметра команды 

опущены, будет разбита только один этот объем. 

 NV2 - номер последнего разбиваемого объема. 

 NINC - шаг с которым изменяются номера разбиваемых объемов. 

 

Разбиение поверхностей 

Средства MeshTool  

Чтобы разбить поверхности модели на конечные элементы с помощью 

MeshTool, следует: 

 В выпадающем списке Mesh: (четвертый раздел MeshTool) 

выбрать Areas (Рисунок 74): 

 

 
Рисунок 74. Четвертая секция MeshTool с установленной опцией Areas 

 

 Указать тип разбиения (Free или Mapped). 

 Указать форму элемента (метка Shape):  

1. Tri соответствует элементам треугольной формы. 
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2. Quad – четырехугольным элементам.  

 Нажать кнопку Mesh.  

После этого появится диалоговое окно выбора, с помощью которого 

следует указать разбиваемые компоненты и нажать OK. 

 

 

Упорядоченное разбиение 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Mesh> Areas> Mapped> By Corners 

При использовании данного пункта меню: 

 с помощью первого окна выбора Map Mesh Area by Conners 

необходимо указать поверхность, на которой будет строиться 

упорядоченное разбиение на элементы; 

 с помощью второго окна выбора Map Mesh Area by Conners 

необходимо указать четыре ключевые точки поверхности, на 

которой будет строиться упорядоченное разбиение; 

Команда  

Общий вид команды AMAP при вводе с клавиатуры: 

AMAP, AREA, KP1, KP2, KP3, KP4  

где: 

 AREA – номер разбиваемой поверхности. Если этот параметр 

равен P, то поверхность и угловые точки выбираются «мышью» 

на экране, а остальные параметры данной команды 

игнорируются.  

 KP1, KP2, KP3, KP4 – ключевые точки, находящиеся в углах 

разбиваемой поверхности. 

З а м е ч а н и е! При использовании указанного пункта меню или команды 

AMAP поверхность автоматически разбивается с помощью только 

четырехугольных или треугольных элементов. Если указываются 

находящиеся в углах ключевые точки, то перед разбиением нет 

необходимости в объединении линий, объединение будет выполнено самой 

командой и после построения сетки удалено. Таким образом, 

геометрическая модель останется неизменной. 
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Свободное разбиение 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Mesh> Areas> Free 

При использовании этого пункта появится окно выбора Mesh Areas, с 

помощью которого необходимо указать поверхности, которые следует 

разбить. После окончания выбора необходимо нажать кнопку OK или Apply.  

Команда  

Общий вид команды AMESH при вводе с клавиатуры: 

AMESH, NA1, NA2, NINC  

где: 

 NA1 - номер первой разбиваемой поверхности, если он равен 

ALL, то разбиваются все поверхности, а два последующих 

параметра игнорируются. Если данный параметр равен P, то 

пользователь должен выбрать на экране поверхности, которые 

будут разбиты. В этом случае все остальные параметры команды 

игнорируются. Если указан номер поверхности, но два остальных 

параметра команды опущены, будет разбита только одна эта 

поверхность. 

 NA2 - номер последней разбиваемой поверхности. 

 NINC – шаг, с которым изменяются номера разбиваемых 

поверхностей. 

Дополнительные пункты меню 

Main Menu> Preprocessor> Meshing> Mesh> Areas> Mapped> 3 or 4 sided 

Main Menu> Preprocessor> Meshing> Mesh> Areas> Target Surf 

 

Разбиение линий 

Средства MeshTool  

Чтобы разбить линии модели на конечные элементы с помощью 

MeshTool следует в выпадающем списке Mesh: (четвертый раздел MeshTool) 

выбрать Lines (Рисунок 75). 
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Рисунок 75. Четвертая секция MeshTool с установленной опцией Lines 

 

Далее следует нажать кнопку Mesh. После этого появится диалоговое 

окно выбора, с помощью которого следует указать разбиваемые компоненты 

и нажать OK. 

З а м е ч а н и е! При разбиении линий тип разбиения (Free или Mapped) и 

форма элементов (метка Shape) не указывается. 

Особенности разбиения линий можно прочитать в разделе о создании 

линейной сетки с узлами ориентации. 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Mesh> Lines 

При использовании этого пункта появится окно выбора Mesh Lines, с 

помощью которого необходимо указать линии, которые следует разбить. 

После окончания выбора необходимо нажать кнопку OK или Apply.  

Команда  

Общий вид команды при вводе с клавиатуры: 

LMESH, NL1, NL2, NINC  

где: 

 NL1 - номер первой разбиваемой линии, если он равен ALL, то 

разбиваются все линии а два последующих параметра 

игнорируются. Если данный параметр равен P, то пользователь 

должен выбрать на экране линии, которые будут разбиваться. В 

этом случае все остальные параметры команды игнорируются. 

Если указан номер линии но два остальных параметра команды 

опущены, будет разбита только одна эта линия. 
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 NL2 - номер последней разбиваемой линии. 

 NINC – шаг, с которым изменяются номера разбиваемых линий. 

Разбиение ключевых точек 

Средства MeshTool  

Для создания точечного элемента в ключевой точке с помощью 

MeshTool следует в выпадающем списке Mesh: (четвертый раздел MeshTool) 

выбрать KeyPoints. Далее следует нажать кнопку Mesh. После этого появится 

диалоговое окно выбора с помощью которого следует указать ключевые 

точки и нажать OK. 

З а м е ч а н и е! При создании точечных элементов в ключевых точках 

также как и при разбиении линий тип разбиения (Free или Mapped) и 

форма элементов (метка Shape) не указывается. 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Mesh> Keypoints 

При использовании этого пункта появится окно выбора Mesh Keypoints, 

с помощью которого необходимо указать ключевые точки, в которых следует 

создать элементы, и после окончания выбора нажать кнопку OK или Apply.  

Команда  

Общий вид команды при вводе с клавиатуры: 

KMESH, NP1, NP2, NINC 

где: 

 NP1 - Номер первой разбиваемой ключевой точки, если он равен 

ALL, то элементы создаются на всех точках, а два последующих 

параметра игнорируются. Если данный параметр равен P, то 

пользователь должен выбрать на экране точки, на которых 

создаются элементы. В этом случае все остальные параметры 

команды игнорируются. Если указан номер первой точки и два 

остальных параметра команды опущены, разбивается одна эта 

точка. 

 NP2 - номер последней ключевой точки. 

 NINC – шаг, с которым изменяются номера ключевых точек. 
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Экстренное прерывание операции разбиения 

Когда выполняется разбиение, на экран выводится окно состояния. 

Окно содержит сообщение, отражающее текущий статус операции разбиения 

и шкалу, показывающую, какой процент операции уже выполнен. И 

сообщение, и шкала несколько раз обновляются во время операции. Нажатие 

кнопки STOP, расположенной внизу окна состояния, отменяет операцию 

разбиения, при этом незаконченные сетки удаляются. Однако, сетка на 

поверхностях и объемах, которая была закончена на отдельных компонентах 

до нажатия этой кнопки, остается. Геометрическая и конечно-элементная 

модели остаются в том же состоянии, в котором были до выполнения 

команды разбиения. 

Окно состояния появляется только при работе с графическим 

интерфейсом пользователя. Окна состояния появляются «по умолчанию», но 

могут быть отключены выполнением команды /UIS,ABORT,OFF. В 

неграфическом режиме, процесс разбиения может быть остановлен нажатием 

сочетания клавиш CTRL-C или CTRL-P. 

Проверка формы элементов 

Элементы с «плохой формой» могут привести к значительным ошибкам 

при расчетах. Из-за этого ANSYS производит проверку формы элементов, 

чтобы предупредить пользователя о том, что одна из операций создала 

элемент с неправильной формой. К сожалению, не существует универсальных 

критериев, которые позволяли бы определить плохие элементы. Другими 

словами, элемент, который приводит к неправильным результатам в одном 

виде расчета, дает вполне приемлемые результаты в другом. Следует 

понимать, что используемые программой критерии для определения плохих 

элементов являются средними. Поэтому даже если получено сообщение о 

сотнях элементов, имеющих неправильную форму, это не обязательно 

означает что в результатах расчета будут какие либо неточности. С другой 

стороны, если не получено ни одного замечания о элементах, это не означает 

автоматического получения точных результатов.  

Таким образом, определение допустимости формы элементов для 

данной задачи, является обязанностью пользователя. 

Кроме того, что ANSYS выполняет проверку формы элементов «по 

умолчанию», существует некоторое количество настроек, для управления 

проверкой формы элементов.  

Для изменения настроек проверки формы элементов следует 

использовать пункты меню: 
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Main Menu> Preprocessor> Checking Ctrls> Shape Checking 

Main Menu> Preprocessor> Checking Ctrls> Toggle Checks 

 

Выключение проверки формы элементов, или режима только замечаний 

Как было сказано ранее, ANSYS выполняет проверку формы элементов 

«по умолчанию». Когда выполняется проверка формы, любой новый элемент 

в не зависимости от того как он был создан, проверяется с учетом 

допускаемых отклонений формы. Если элемент нарушает любой из пределов 

соответствующих ошибке, ANSYS не только выдает сообщение об ошибке, 

но также либо останавливает процесс разбиения, либо (если сетка создается 

командами отличными от AMESH или VMESH) созданная сетка не 

сохраняется. 

В ряде случаев может быть полезным либо полное отключение 

проверки формы элементов, либо проведение ее в режиме только замечаний. 

Отключение проверки формы элементов производится командой 

SHPP,OFF,ALL. При переводе проверки в режим только замечаний (команда 

SHPP,WARN) проверка производится, но при ошибках разбиение 

продолжается и элементы сохраняются. 

При использовании графического интерфейса пользователя, можно 

отключить проверку формы элементов или перевести ее в режим только 

замечаний, выбирая пункт меню  

Main Menu> Preprocessor> Checking Ctrls> Shape Checking 

При этом появится диалоговое окно Shape Checking Controls (Рисунок 

76), в выпадающем списке которого следует выбрать пункт 

On w/Warning msg (включение режима только замечаний) либо пункт Off 

(выключение проверки формы элементов), установть «флаг»  и затем 

нажать OK. 

 

 
Рисунок 76. Вид окна Shape Checking Controls 
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З а м е ч а н и е! Присутствие в модели элементов неправильной формы, 

может привести к ошибкам в вычислених, которые в свою очередь могут 

вызвать прекращение расчета. Таким образом, существует опасность, 

что выключение проверки элементов полностью, проведение проверки в 

режиме только замечаний и др. может привести к тому, что расчет 

модели станет невозможным. 

Удаление сетки 

Конечно-элементную сетку следует удалять, если требуется изменить 

геометрическую модель. Однако удалять ее перед переразбиением не всегда 

необходимо.  

Удаление сетки с объемных компонентов 

Средства MeshTool 

Для выполнения данной операции с помощью MeshTool, следует в 

выпадающем списке Mesh: выбрать Volume (объем), а затем нажать кнопку 

Clear (Рисунок 73). После этого появится диалоговое окно выбора 

Clear Volumes. Затем, следует указать с помощью «мыши» очищаемые 

компоненты и нажать кнопку ОК или Apply. 

 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Clear> Volumes 

При использовании этого пункта появится диалоговое окно выбора 

Clear Volumes. После этого следует указать с помощью «мыши» очищаемые 

компоненты и нажать кнопку ОК или Apply. 

 

Команда  

Общий вид команды VCLEAR при вводе с клавиатуры: 

VCLEAR, NV1, NV2, NINC  

где: 

 NV1 - Номер первого очищаемого объема, если он равен ALL, то 

очищаются все объемы, а два последующих параметра 

игнорируются. Если данный параметр равен P, то пользователь 

должен выбрать на экране объемы, которые будут очищены. В 
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этом случае все остальные параметры команды игнорируются. 

Если указан номер объема, но два остальных параметра команды 

опущены, будет очищен только один этот объем. 

 NV2 - номер последнего очищаемого объема. 

 NINC – шаг, с которым изменяются номера очищаемых объемов. 

 

Удаление сетки с поверхностей 

Средства MeshTool 

Для выполнения данной операции с помощью MeshTool, следует в 

выпадающем списке Mesh: выбрать Areas (поверхности), а затем нажать 

кнопку Clear (Рисунок 74). После этого появится диалоговое окно выбора 

Clear Areas. Затем, следует указать с помощью «мыши» очищаемые 

компоненты и нажать кнопку ОК или Apply. 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Clear> Areas 

При использовании этого пункта появится диалоговое окно выбора 

Clear Areas. После этого следует указать с помощью «мыши» очищаемые 

компоненты и нажать кнопку ОК или Apply. 

Команда  

Общий вид команды при вводе с клавиатуры: 

ACLEAR, NA1, NA2, NINC  

где: 

 NA1 - номер первой очищаемой поверхности, если он равен ALL, 

то элементы удаляются на всех поверхностях, а два последующих 

параметра игнорируются. Если данный параметр равен P, то 

пользователь должен выбрать на экране поверхности, на которых 

удаляются элементы. В этом случае все остальные параметры 

команды игнорируются. Если указан номер первой поверхности и 

два остальных параметра команды опущены, очищается одна эта 

поверхность. 

 NA2 - номер последней поверхности. 

 NINC – шаг, с которым изменяются номера поверхностей. 
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Удаление сетки с линий 

Средства MeshTool 

Для выполнения данной операции с помощью MeshTool, следует в 

выпадающем списке Mesh: выбрать Lines (линии), а затем нажать кнопку 

Clear (Рисунок 75). После этого появится диалоговое окно выбора 

Clear Lines. Затем следует указать с помощью «мыши» очищаемые 

компоненты и нажать кнопку ОК или Apply. 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Clear> Lines 

При использовании этого пункта появится диалоговое окно выбора 

Clear Lines. После этого следует указать с помощью «мыши» очищаемые 

компоненты и нажать кнопку ОК или Apply. 

Команда  

Общий вид команды при вводе с клавиатуры: 

LCLEAR, NL1, NL2, NINC 

где: 

 NL1 - Номер первой очищаемой линии, если он равен ALL, то 

элементы удаляются на всех линиях, а два последующих 

параметра игнорируются. Если данный параметр равен P, то 

пользователь должен выбрать на экране линии, на которых 

удаляются элементы. В этом случае все остальные параметры 

команды игнорируются. Если указан номер первой линии и два 

остальных параметра команды опущены, очищается одна эта 

линия. 

 NL2 - номер последней линии. 

 NINC – шаг, с которым изменяются номера линий. 

 

Удаление элементов с ключевых точек 

Средства MeshTool 

Для выполнения данной операции с помощью MeshTool, следует в 

выпадающем списке Mesh: выбрать KeyPoints (ключевые точки), а затем 

нажать кнопку Clear. После этого появится диалоговое окно выбора 
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Clear KeyPoints. После этого следует указать с помощью «мыши» очищаемые 

компоненты и нажать кнопку ОК или Apply. 

 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Clear> KeyPoints 

При использовании этого пункта появится диалоговое окно выбора 

Clear KeyPoints. После этого следует указать с помощью «мыши» очищаемые 

компоненты и нажать кнопку ОК или Apply. 

Команда  

Общий вид команды при вводе с клавиатуры: 

KCLEAR, NP1, NP2, NINC  

где: 

 NP1 - Номер первой очищаемой ключевой точки, если он равен 

ALL, то элементы удаляются на всех точках а два последующих 

параметра игнорируются. Если данный параметр равен P, то 

пользователь должен выбрать на экране точки, на которых 

удаляются элементы. В этом случае все остальные параметры 

команды игнорируются. Если указан номер первой точки и два 

остальных параметра команды опущены, очищается одна эта 

точка. 

 NP2 - номер последней ключевой точки. 

 NINC – шаг, с которым изменяются номера ключевых точек. 

 

Изменение разбиения модели 

Если вы решили, что созданная конечно-элементная сетка не подходит, 

ее можно легко изменить одним из следующих способов: 

 Использовать запрос на принятие / отмену сетки для ее удаления 

и затем разбить заново (если этот режим был включен до 

проведения операции разбиения). 

 Очистить сетку, изменить ее настройки и повторить разбиение. 

 Повторить разбиение с другими размерами элементов. 

 Уточнять сетку локально. 



 

 

110 

З а м е ч а н и е! При переразбиении линий необходимо вначале очистить 

уже созданное разбиение, изменить настройки размеров элементов и 

повторить разбиение. 

Переразбиение может применяться только, если работа осуществляется 

с помощью графического интерфейса пользователя. Если команды вводятся 

из командной строки, сначала в любом случае следует очистить старую сетку. 

Локальное уточнение сетки 

Если пользователь в целом удовлетворен созданной сеткой, но хотел бы 

иметь больше элементов в определенной области модели, то можно уточнить 

сетку локально вокруг выбранных узлов, элементов, ключевых точек, линий  

или поверхностей. Элементы, окружающие выбранные компоненты будут 

«измельчены». Можно управлять процессом уточнения указывая: 

 Требуемый размер элементов в уточняемой области, 

относительно размера исходных элементов. 

 Глубину, на которую должно быть производится уточнение, 

задавая количество элементов от выбранного компонента. 

 Тип обработки, которая должна быть выполнена после того, как 

исходные элементы будут уточнены (сглаживание, очистка и др). 

 

Уточнение разбиения в окрестности узлов конечно-элементной сетки 

Средства MeshTool 

Для выполнения данной операции с помощью MeshTool, следует в 

выпадающем списке Refine At (пятый сверху раздел MeshTool) выбрать тип 

компонента, около которого будет выполняться уточнение (в данном случае 

Nodes) и нажать кнопку Refine (Рисунок 77). 

 

 
Рисунок 77. Пятый раздел MeshTool с выбранным разделом Nodes 

 

При этом появится диалоговое окно выбора Refine Mesh at Node 

(Рисунок 78). После этого с помощью «мыши» или командной строки следует 

указать узлы, около которых следует уточнить сетку. После выбора узлов, 
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следует в появившемся втором диалоговом окне Refine Mesh at Node выбрать 

уровень уточнения (в выпадающем списке Level of refinement) и нажать 

кнопку OK. 

 

 
Рисунок 78. Вид окна Refine Mesh at Nodes 

 

З а м е ч а н и е! Пользователь получает доступ к дополнительным 

опциям указания глубины уточнения и типа обработки после уточнения 

при включении «флага»  с меткой Advanced Options во втором окне 

Refine mesh at nodes и нажатия кнопки OK. 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Modify Mesh> Refine At> Nodes 

При использовании этого пункта появится диалоговое окно выбора 

Refine mesh at nodes. После этого с помощью «мыши» или командной строки 

следует указать узлы около которых следует уточнить сетку. После выбора 

узлов, следует в появившемся диалоговом окне Refine Mesh at Nodes выбрать 

уровень уточнения (в выпадающем списке Level of refinement) и нажать 

кнопку OK.  

З а м е ч а н и е! Вид окон и правила доступа к дополнительным опциям 

такие же как и с использование MeshTool. 

Уточнение разбиения в окрестности элементов 

Средства MeshTool 

Для выполнения данной операции с помощью MeshTool, следует в 

выпадающем списке Refine At (пятый сверху раздел MeshTool) выбрать тип 

компонента, около которого будет выполняться уточнение (в данном случае 

Elements) и нажать кнопку Refine (Рисунок 79). 
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Рисунок 79. Пятый раздел MeshTool с выбранным разделом Elements 

 

При этом появится диалоговое окно выбора Refine mesh at elements. 

После этого с помощью «мыши» или командной строки следует указать 

элементы, около которых следует уточнить сетку. После выбора элементов, 

следует в появившемся диалоговом окне Refine Mesh at Elements выбрать 

уровень уточнения (в выпадающем списке Level of refinement) и нажать 

кнопку OK. 

З а м е ч а н и е! Пользователь получает доступ к дополнительным 

опциям указания глубины уточнения и типа обработки после уточнения 

при включении «флага»  Advanced Options во втором окне 

Refine mesh at elements и нажатия кнопки OK. 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Modify Mesh> Refine At> Elements 

При использовании этого пункта появится диалоговое окно выбора 

Refine mesh at elements. После этого с помощью «мыши» или командной 

строки следует указать элементы, около которых следует уточнить сетку. 

После выбора элементов, следует в появившемся втором диалоговом окне 

Refine Mesh at Elements выбрать уровень уточнения (в выпадающем списке 

Level of refinement) и нажать кнопку OK.  

З а м е ч а н и е! Вид окон и правила доступа к дополнительным опциям 

такие же как и с использование MeshTool. 

Уточнение разбиения в окрестности ключевых точек 

Средства MeshTool 

Для выполнения данной операции с помощью MeshTool, следует в 

выпадающем списке Refine At (пятый сверху раздел MeshTool) выбрать тип 

компонента, около которого будет выполняться уточнение (в данном случае 

KeyPoints) и нажать кнопку Refine. При этом появится диалоговое окно 
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выбора Refine mesh at keypoints. После этого с помощью «мыши» или 

командной строки следует указать ключевые точки, около которых следует 

уточнить сетку. После выбора ключевых точек, следует в появившемся 

диалоговом окне Refine Mesh at Keypoints выбрать уровень уточнения (в 

выпадающем списке Level of refinement) и нажать кнопку OK. 

З а м е ч а н и е! Пользователь получает доступ к дополнительным 

опциям указания глубины уточнения и типа обработки после уточнения 

при включении «флага»  Advanced Options во втором окне 

Refine mesh at elements и нажатия кнопки OK. 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Modify Mesh> Refine At> Keypoints 

При использовании этого пункта появится диалоговое окно выбора 

Refine Mesh at Keypoints. После этого с помощью «мыши» или командной 

строки следует указать ключевые точки, около которых следует уточнить 

сетку. После выбора ключевых точек, следует в появившемся диалоговом 

окне Refine Mesh at Keypoints выбрать уровень уточнения (в выпадающем 

списке Level of refinement) и нажать кнопку OK.  

З а м е ч а н и е! Вид окон и правила доступа к дополнительным опциям 

такие же как и с использование MeshTool. 

Уточнение разбиения в окрестности линий 

Средства MeshTool 

Для выполнения данной операции с помощью MeshTool, следует в 

выпадающем списке Refine At (пятый сверху раздел MeshTool) выбрать тип 

компонента, около которого будет выполняться уточнение (в данном случае 

Lines), и нажать кнопку Refine. При этом появится диалоговое окно выбора 

Refine Mesh at Lines. После этого с помощью «мыши» или командной строки 

следует указать линии, около которых следует уточнить сетку. После выбора 

линий, следует в появившемся диалоговом окне Refine Mesh at Lines выбрать 

уровень уточнения (в выпадающем списке Level of refinement) и нажать 

кнопку OK. 

З а м е ч а н и е! Пользователь получает доступ к дополнительным 

опциям указания глубины уточнения и типа обработки после уточнения 
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при включении «флага»  с меткой Advanced Options во втором окне 

Refine mesh at elements и нажатия кнопки OK. 

 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Modify Mesh> Refine At> Lines 

При использовании этого пункта появится диалоговое окно выбора 

Refine mesh at lines. После этого с помощью «мыши» или командной строки 

следует указать линии, около которых следует уточнить сетку. После выбора 

линий, следует в появившемся диалоговом окне Refine Mesh at Lines выбрать 

уровень уточнения (в выпадающем списке Level of refinement) и нажать 

кнопку OK.  

З а м е ч а н и е! Вид окон и правила доступа к дополнительным опциям 

такие же как и с использование MeshTool. 

 

Уточнение разбиения в окрестности поверхностей 

Средства MeshTool 

Для выполнения данной операции с помощью MeshTool, следует в 

выпадающем списке Refine At (пятый сверху раздел MeshTool) выбрать тип 

компонента, около которого будет выполняться уточнение (в данном случае 

Areas), и нажать кнопку Refine. При этом появится диалоговое окно выбора 

Refine mesh at areas. После этого с помощью «мыши» или командной строки 

следует указать поверхности, около которых следует уточнить сетку. После 

выбора поверхностей, следует в появившемся втором диалоговом окне 

Refine Mesh at Areas выбрать уровень уточнения (в выпадающем списке 

Level of refinement) и нажать кнопку OK. 

З а м е ч а н и е! Пользователь получает доступ к дополнительным 

опциям указания глубины уточнения и типа обработки после уточнения 

при включении «флага»  Advanced Options во втором окне 

Refine mesh at elements и нажатия кнопки OK. 
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Пункт главного меню 

Main Menu> Preprocessor> Meshing> Modify Mesh> Refine At> Areas 

При использовании этого пункта появится диалоговое окно выбора 

Refine mesh at areas. После этого с помощью «мыши» или командной строки 

следует указать поверхности, около которых следует уточнить сетку. После 

выбора поверхностей, следует в появившемся втором диалоговом окне 

Refine Mesh at Areas выбрать уровень уточнения (в выпадающем списке 

Level of refinement) и нажать кнопку OK.  

З а м е ч а н и е! Вид окон и правила доступа к дополнительным опциям 

такие же как и с использование MeshTool. 

Уточнение разбиения в окрестности всех выбранных элементов 

Средства MeshTool 

Для выполнения данной операции с помощью MeshTool, следует в 

выпадающем списке Refine At (пятый сверху раздел MeshTool) выбрать тип 

компонента, около которого будет выполняться уточнение (в данном случае 

All Elems), и нажать кнопку Refine. При этом в появившемся диалоговом 

окне Refine mesh at all selected elements выбрать уровень уточнения (в 

выпадающем списке Level of refinement) и нажать кнопку OK. 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Modify Mesh> Refine At> All 

При этом в появившемся диалоговом окне 

Refine mesh at all selected elements выбрать уровень уточнения (в 

выпадающем списке Level of refinement) и нажать кнопку OK. 

 

Дополнительные возможности построения разбиения в ANSYS 

Создание разбиения на балочные элементы с узлами ориентации 

Ключевые точки ориентации можно задать как атрибуты линии, точно 

так же, как ей можно присвоить набор вещественных констант, или номер 

материала. Ключевые точки ориентации не зависят от линии, которая будет 

разбиваться. Основываясь на расположении этих ключевых точек, ANSYS 
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автоматически создаст узлы ориентации вместе с балочными элементами. 

Линейное разбиение с автоматическим созданием узлов ориентации 

поддерживается для элементов BEAM4, BEAM24, BEAM44, BEAM161, 

BEAM188, и BEAM189. 

Средства MeshTool 

При использовании графического интерфейса ANSYS для создания 

балочного разбиения, следует выполнить следующие шаги: 

 В разделе Element Attributes окна MeshTool следует выбрать 

Lines из меню опций (Рисунок 80) слева и нажать кнопку Set. 

Появится диалоговое окно Line Attributes выбора линий, для 

которых следует указать атрибуты элементов. 

 

 
Рисунок 80. Верхняя секция окна MeshTool с опцией Lines 

 

 В главном окне ANSYS следует мышью выбрать те линии, 

которым  должны быть присвоены атрибуты (включая ключевые 

точки ориентации), и затем нажать OK в диалоговом окне выбора.  

 Появится второе диалоговое окно Line Attributes. В диалоговом 

окне Line Attributes необходимо ввести требуемые значения для 

параметров MAT, REAL, TYPE, ESYS и SECT и щелкнуть 

«мышью» на опции Pick Orientation Keypoint(s), чтобы появилась 

надпись Yes и затем нажмите OK.  

 Появится третье окно выбора Line Attributes. В главном окне 

ANSYS следует выбрать ключевые точки ориентации и затем 

нажмите OK в диалоговом окне выбора. 

 Вернувшись в MeshTool, следует установить (если есть 

необходимость) требуемую опцию, задающую другие размеры 

элементов.  

 Выбирать в меню опций Mesh (четвертый раздел MeshTool) 

пункт Lines (Рисунок 75) и затем нажать на кнопку MESH.  

 Появится диалоговое окно выбора Mesh Lines. В главном окне 

ANSYS необходимо выбрать линии, которые следует разбить, и 

затем нажать кнопку OK в диалоговом окне выбора. ANSYS 

выполнит разбиение линий. 
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После построение балочной сетки всегда следует проверить 

ориентацию балочных элементов графически (пункт меню утилит): 

Utility Menu> PlotCtrls> Style> Size and Shape  

Нажмите на опцию /ESHAPE чтобы включить ее и нажмите OK. 

З а м е ч а н и е! Можно вывести список выбранных линий с 

присвоенными им ключевыми точками ориентации и номерами сечений. 

Чтобы это сделать следует использовать пункт меню Utility Menu> List> 

Lines. Появится диалоговое окно LLIST Listing Format. Следует выбрать 

Orientation KP и нажать OK. 

 

Пункты главного меню 

Main Menu> Preprocessor> Meshing> Mesh Attributes> All Lines 

Main Menu> Preprocessor> Meshing> Mesh Attributes> Picked Lines 

Средства командной строки 

Этот раздел описывает, как создать балочное разбиение с узлами 

ориентации используя командную строку. Подразумевается, что 

геометрическая модель уже создана, заданы элементы и их атрибуты, и 

теперь можно задавать специальные атрибуты линиям для балочного 

разбиения. В этом случае следует использовать следующую 

последовательность команд: 

 LSEL для выбора линий, которые будут разбиты с 

использованием узлов ориентации. 

 LATT для присвоения выбранным неразбитым линиям атрибутов 

элементов. Общий вид команды при вводе с клавиатуры: 

LATT, MAT, REAL, TYPE, --, KB, KE, SECNUM 

где  

 MAT, REAL, TYPE – номер материала, номер набора 

вещественных констант, тип элементов для неразбитых линий. 

 -- - неиспользуемое поле. 

 KB, KE - номера ключевых точек ориентации начала и конца 

линии. 
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 SECNUM – идентификатор сечения неразбитой линии. Номер 

сечения определяет сечение, используемое балочными 

элементами, генерируемыми при разбиении линии. 

При выборе значения для аргумента TYPE команды LATT следует 

удостовериться, что выбранный тип элементов, присваиваемый линии 

поддерживает балочное разбиение с ориентацией. На данный момент это 

элементы BEAM4, BEAM24, BEAM44, BEAM161, BEAM188, и BEAM189. 

При разбиении с использованием элементов BEAM24, BEAM161, 

BEAM188, или BEAM189 следует задавать как минимум одну точку 

ориентации. Когда программа будет создавать сетку по команде LMESH 

каждый элемент на линии будет иметь два узла на концах и один узел 

ориентации. Задавать ключевые точки ориентации при использовании 

элементов BEAM4 и BEAM44 не обязательно. Если для этих элементов 

ключевые точки заданы, каждый элемент на разбиваемой линии будет иметь 

два узла на концах и один узел ориентации. Если ключевые точки ориентации 

не заданы, элементы будут иметь два узла на концах и не будут иметь 

ориентационного узла. 

З а м е ч а н и е! Если с помощью балочных элементов разбивается линия, 

представляющая собой дугу окружности длинной более 90 градусов, 

элементы будут вывернуты в точке 90 градусов. Для того чтобы 

избежать этого, ключевая точка ориентации в конце линии должна 

совпадать с ключевой точкой ориентации в начале линии, либо линию 

следует разбить на несколько участков длинной менее 90 градусов. 

При использовании элементов BEAM44, BEAM188 или BEAM189 

следует использовать аргумент SECNUM команды LATT, чтобы присвоить 

номер сечения. 

 Присвоить количество элементов, создаваемых на линии с 

помощью команды LESIZE. 

 Использовать команду LMESH, чтобы разбить линии. 

После разбиения балочными элементами, следует использовать 

команду /ESHAPE,1, чтобы графически проверить ориентацию балочных 

элементов. 

З а м е ч а н и е! Можно использовать команду LLIST,,,,ORIENT, чтобы 

отобразить список выбранных линий вместе с присвоенными им 

ключевыми точками ориентации и сечениями. 
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Определение узлов ориентации 

Если линия ограничена двумя ключевыми точками (KP1 и KP2) и для 

нее как атрибуты были заданы две ключевые точки ориентации (KB и KE), 

вектор ориентации начала линии будет проведен от точки KP1 к KB, а вектор 

ориентации в конце линии будет проведен от точки KP2 к KE. ANSYS будет 

вычислять узлы ориентации, путем интерполяции ориентаций, заданных 

двумя указанными выше векторами. 

 

Особенности балочного разбиения с узлами ориентации  

Направления, в которых сориентированы сечения балочных элементов, 

существенно влияют на сетку и результаты анализа. Узлы ориентации, 

автоматически создаваемые программой, основанные на заданных ключевых 

точках ориентации, определяют ориентацию сечений балочных элементов в 

пространстве. 

З а м е ч а н и е! Так как для двухмерных балочных элементов не 

требуется узлов ориентации, процедура построения балочного разбиения 

описанная выше не поддерживает двумерные балочные элементы. 

Кроме того, следует помнить: 

 Любые операции на линиях (копирование линии, перемещение 

линии и т.д.) нарушат атрибуты - определенные ключевые точки 

ориентации. 

 Если удаляется ключевая точка ориентации, ANSYS выдаст 

предупреждающее сообщение. 

 Если ключевая точка ориентации перемещается, она остается 

ключевой точкой ориентации. Тем не менее если ключевая точка 

ориентации переопределяется (команда K, NPT, X, Y, Z), она 

перестает быть ключевой точкой ориентации. 

 

Создание объемной сетки вытягиванием  

Используя вытягивание в объеме, можно заполнить существующий 

объем конечными элементами, вытягивая сетку одной из поверхностей, 

ограничивающей его (она называется исходной поверхностью или 

источником). Если сетка на исходной поверхности состоит из 

четырехугольных элементов, объем будет заполнен шестигранными 

элементами. Если сетка на исходной поверхности состоит из треугольных 
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элементов, объем будет заполнен клинообразными элементами. Если сетка 

состоит из смеси четырехугольных и треугольных элементов, объем будет 

заполнен смесью шестигранных и клинообразных элементов. 

 

Достоинства вытягивания в объеме 

В отличие от других методов выдавливания сетки с поверхности на 

объем (команды VROTAT, VEXT, VOFFST и VDRAG), вытягивание в объеме 

предназначено для использования на уже существующих объемах. Оно может 

быть особенно полезным в следующих случаях: 

 Имеется твердотельная модель, созданная в другой программе, и 

ее следует разбить на конечные элементы в ANSYSе. 

 Надо создать сетку из шестигранников в объеме неправильной 

формы. В таком случае требуется разделить объем на несколько 

частей, каждая из которых может быть заполнена вытягиванием. 

 Следует либо создать сетку, отличную от созданной другими 

методами выдавливания, или вы забыли создать сетку во время 

одной из таких операций. 

 Если сетка на поверхности источнике не была создана до 

вытягивания, ANSYS разобьет поверхность в ходе выполнения 

операции вытягивания в объеме. Другие методы требуют 

создания сетки на поверхности источнике, в противном случае 

будет создан только объем но не разбиение. 

 

Действия, выполняемые перед вытягисанием в объеме  

1. Определите, сколько объемов следует вытягивать. Команда 

VSWEEP может выполнить вытягивание в одном объеме или во всех 

активных объемах (VSWEEP,ALL). 

2. Определите, может ли объем (по своей геометрии) быть 

вытянутым. Объем не может быть вытянутым, если любое из ниже 

перечисленных утверждений является истинным: 

 Если исходная и конечные поверхности содержат жестко 

заданное различное количество элементов на соответствующих 

линиях. 

 Объем имеет внутреннюю полость (либо отверстие, которое не 

проходит через исходную и конечную поверхности).. 

 Исходная поверхность и конечная поверхности не являются 

противоположными в геометрической структуре объема.  
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З а м е ч а н и е! Если в объеме не может быть произведено вытягивание, 

возможно имеет смысл перед выполнением команды VSWEEP разделить 

его на части, в каждой из которых вытягивание можно сделать 

3. Убедитесь, что были определены подходящие типы двух и 

трехмерных элементов. Например, если требуется разбить исходную 

поверхность для создания в объеме квадратичных шестигранных элементов, 

следует при ее разбиении использовать квадратичные двумерные элементы. 

4. Определите, каким образом вы хотите управлять количеством 

слоев элементов, которые будут созданы во время вытягивания в объеме, то 

есть количеством элементов, создаваемых вдоль направления вытягивания. 

Для этого можно использовать один из следующих способов. 

Пункты меню  

Main Menu> Preprocessor> Meshing> Size Cntrls>  

SmartSize> Adv Opts 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Global> Size 

соответствующих использованию команды ESIZE,SIZE, можно задать 

базовый размер элемента для операции VSWEEP.  

З а м е ч а н и е! Этот метод считается предпочтительным. 

Пункты меню 

Main Menu> Preprocessor> Modeling> Operate> Extrude> 

Extrude Elem Ext Opts 

соответствующего использованию команды EXTOPT,ESIZE,Val1,Val2 

можно задать количество слоев элементов(и если необходимо отношение 

длин) вдоль боковых линий объема (напомним, что Val1 это количество слоев 

элементов, а Val2 отношение). Следует отметить, что количество слоев 

элементов, задаваемое командой EXTOPT будет применено для всех 

неразбитых боковых линий объема.  

З а м е ч а н и е! Для любой линии которая была предварительно разбита, 

или для которой было задано количество элементов командой LESIZE 

значения задаваемые EXTOPT игнорируются. 
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Пункт меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Lines> Picked Lines 

соответствующего использованию команды LESIZE, на одной или 

нескольких боковых линиях объема можно задать количество элементов. 

Кроме того: 

 Создать упорядоченное разбиение для одной или нескольких 

боковых поверхностях объема, или поверхности, которая связана 

с боковой поверхностью или боковой линией. 

 Создать сетку из балочных элементов на одной или нескольких 

боковых линиях с помощью команды LMESH. 

 Включить Smart sizing с помощью команды SMRT. Команда 

VSWEEP будет учитывать параметры Smart sizing для 

вычислений количества слоев элементов. Следует учитывать, что 

из-за ограниченности шестигранных элементов, и того, что 

Smart sizing пытается изменять размер элементов в разных местах 

модели, качество элементов полученный помощью данного 

способа может быть не удовлетворительным.  

 Если количество слоев элементов не задано ни одним из 

вышеуказанных методов, VSWEEP будет использовать параметр 

DESIZE для его вычисления. 

5. Следует определить, какая поверхность будет исходной и 

конечной. Конечная или целевая поверхность - это поверхность, в которой 

вытягивание будет завершено. Если вытягивание производится более чем в 

одном объеме, выбор пользователем исходной и результирующей 

поверхностей игнорируется. 

З а м е ч а н и е! Если пользователем не были заданы исходная и конечная 

поверхности, команда VSWEEP попытается автоматически определить, 

какие из ограничивающих объем поверхностей подходят для этого. Если 

команда оказывается не в состоянии определить исходную и 

результирующую поверхности, ее выполнение будет прекращено. При 

использовании командной строки можно включить автоматическое 

определение исходной и конечной поверхностей с помощью команды 

EXTOPT,VSWE,AUTO. 

6. Обычно разбиение для исходной поверхности создается 

пользователем перед вытягиванием. Если разбиение создано не было, 
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программа автоматически его произведет в процессе вытягивания. Когда 

принимается решение разбивать или нет поверхность перед вытягиванием, 

следует учитывать следующее: 

 Если разбиение поверхности не было создано предварительно, 

ANSYS использует настройки формы элемента MSHAPE, чтобы 

определить элементами какой формы будет разбиваться 

поверхность (команда MSHAPE,0,2D приведет к разбиению на 

четырехугольные элементы MSHAPE,1,2D приведет к разбиению 

на треугольные элементы). Исключение из этого правила 

возможно, если с помощью одного вызова команды VSWEEP 

будут разбиваться несколько объемов. В таком случае исходные 

поверхности всегда будут разбиваться на четырехугольные 

элементы. 

 Если предварительно разбиваются и исходная и конечная 

поверхности, их сетки должны совпадать. Однако, не обязательно 

разбивать эти поверхности упорядоченным разбиением. 

 

Выполнение разбиения в объеме. Использование главного меню 

При использовании графического интерфейса, процесс разбиения будет 

зависеть от установки опции EXTOPT,VSWE,AUTO. Если 

EXTOPT,VSWE,AUTO равно ON («по умолчанию»), то следует выполнить 

следующие шаги: 

1. Выберите пункт меню  

Main Menu> Preprocessor> Meshing> Mesh> Volume Sweep> Sweep 

2. Появится окно выбора Volume Sweeping. Выберите объем или 

объемы, которые необходимо разбить вытягиванием и нажмите OK в окне 

выбора. 

Если EXTOPT,VSWE,AUTO равно OFF, то следует выполнить 

следующие шаги: 

1. Выберите пункт меню  

Main Menu> Preprocessor> Meshing> Mesh> Volume Sweep> Sweep 

2. Появится окно выбора Volume Sweeping. Выберите объем, 

который необходимо разбить, и нажмите Apply. 

3. Выберите исходную поверхность и нажмите Apply. 

4. Выберите конечную поверхность и нажмите OK в диалоговом 

окне выбора. 
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З а м е ч а н и е! При использовании графического интерфейса, 

невозможно управлять сглаживанием линий. ANSYS не выполняет 

сглаживание линий при выполнении команды через графический 

интерфейс. 

Команда  

VSWEEP, VNUM, SRCA, TRGA, LSMO 

где 

 Аргумент VNUM используется для указания объема, в котором 

будет производится разбиение. 

 Желательно использовать аргумент SRCA для задания 

поверхности источника. 

 Можно использовать аргумент TRGA, чтобы задать конечную 

поверхность. 

 Можно использовать аргумент LSMO, чтобы определить, должна 

ли программ выполнять сглаживание линий во время операции 

вытягивания. 

 

Способы исправления ошибок во время операции вытягивания  

Если операция вытягивания в объеме завершилась с ошибкой в связи с 

неправильной формой элементов, то для ее исправления следует 

использовать один или несколько способов, описанных ниже. Рекомендуется 

использовать их в том порядке, в каком они указаны в списке: 

1. Если не были заданы исходная и конечная поверхности, следует 

указать их и снова выполнить операцию вытягивания. 

2. Поменять местами исходную и конечную поверхности и снова 

выполнить вытягивание в объеме. Например, если поверхность A1 указана 

как исходная, а A2 как конечная, следует попробовать указать A2 как 

исходную и A1 как конечную. 

3. Выберите другие исходную и конечную поверхности и повторите 

операцию вытягивания (с некоторыми объемами операция вытягивания 

может выполняться не только в одном направлении). Например, если 

поверхности A1 и A2 не подходят, можно попробовать A5 и A6. 

4. Используйте контроль формы как инструмент, с помощью 

которого можно узнать, какая часть модели вызывает возникновение ошибки. 

Для этого следует уменьшить уровень предупреждений(команда 

SHPP,WARN) так, что элементы, которые будут нарушать ограничения 
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формы, будут вызывать предупреждения, а не ошибки. Затем следует 

выполнить операцию вытягивания. Из появившихся предупреждений можно 

узнать в каких именно местах модели возникают ошибки. После этого 

созданную сетку следует удалить(VCLEAR), включить ошибки (SHPP,ON). 

Затем следует изменить ту часть модели, которая вызывает ошибки. После 

этого модель можно разбивать снова. Вот некоторые рекомендации по 

изменению модели:  

 Если на одной из линий модели элементов слишком много или 

слишком мало, следует указать другое количество элементов. 

 Можно установить меньший размер элемента или другое 

количество слоев элементов. 

 Разделите объем на два или больше объемов(команды 

VSBA,VSBW) которые сократят расстояние на которое 

производится вытягивание. Желательно разделить объем рядом с 

тем местом, где находятся элементы неправильной формы. После 

этого следует применить команду VSWEEP для каждого из 

объемов по отдельности. 

 

Примеры создания конечно-элементных разбиений твердотельных 

моделей 

Перед демонстрацией способов построения разбиения отметим 

следующее:  

 Необходимо стремиться, чтобы в исследуемой области (части 

модели) не было элементов с плохой формой. Это существенно 

улучшит достоверность получаемых результатов. 

 В исследуемой области разбиение должно быть более мелким и 

увеличиаваться с удалением от рассматриваемой области. Это 

позволит получать достоверные результаты с наименьшими 

затратами времени. 

 Вид построенного разбиения должен быть как можно ближе к 

регулярному. 

Ниже приведены примеры выполнения этих, на первый взгляд, 

несложных требований. Некоторые из примеров содержат несколько попыток 

перестройки разбиения, что полностью соответствует реальному процессу 

выполнения расчета модели, т.к. обычно, прежде чем будет создано 

удовлетворительное разбиение, следует пробовать несколько вариантов. При 

этом исходное разбиение либо удаляется, либо уточняется.  
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Большинство шагов по построению конечно-элементных сеток может 

быть выполнено тремя способами: с помощью инструментов MeshTool, с 

помощью пунктов главного меню и с помощью команд, вводимых в 

командной строке. В данных примерах, там, где это возможно, описаны все 

три способа. Поэтому большинство пунктов примеров состоят из трех частей.  

Пример 1. Построение упорядоченного разбиения плоского образца с 

концентратором 

Шаг 1. Чтение существующей модели из db-файла 

Для этого используем пункт меню: 

Utility Menu> File> Resume from… 

При использовании пункта главного меню появляется окно Resume DataBase 

(Рисунок 81).  

 

 
Рисунок 81. Вид окна Resume DataBase 

 

В этом случае следует: 

 Выбраем в выпадающем списоке Drives (Рисунок 82) диск, на 

котором хранится уже созданный файл (например C: – выбор 

диска «по умолчанию»). 

 

 
Рисунок 82. Выпадающий список для выбора логического диска 



 

 

127 

 

 Выбраем в списке Directories папку (Рисунок 83), в которой 

хранится файл (например, папка Ansys_Examples). Выбор папки 

осуществляется двойным нажатием на правую кнопку «мыши»). 

 

 
Рисунок 83. Окно выбора папки (директории) для хранения файла 

 

З а м е ч а н и е! После выполнения данных действий в левом окне под 

окном ввода имени Resume Database From появится список имен файлов 

(Рисунок 84) с расширениями db или dbb. 

 

 
Рисунок 84. Список файлов 

 

 В списке Resume DataBase From (Рисунок 85) выбираем c 

помощью «мыши» существующий файл, в котором хранится 

твердотельная модель модель примера 1 (например, 

Example1.db). 

 Нажимаем кнопку OK. 

 

 
Рисунок 85. Выбор файла 
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Шаг 2. Выбор типа элемента для разбиения 

Указываем тип элементов, с помощью которых будем создавать 

разбиение. Будем пользоваться при этом пунктом главного меню: 

Main Menu> Preprocessor> Element Type> Add/Edit/Delete 

 

 
Рисунок 86. Вид окна Elements Types 

 

 При его использовании появляется окно Element Types (Рисунок 

86) с надписью None Defined, означающей, что к настоящему 

моменту ни один из типов элементов не выбран для 

использования при разбиении. В этом случае: 

 Нажимаем кнопку Add… .  

 В появившемся окне Library of Elements Types (Рисунок 87) 

следует выбрать из раздела Structural Solid (т.к. решается задача 

структурного анализа) элемент Quad 4node 182. 
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Рисунок 87. Выбор из раздела Structural Solid окна Library of Elements 

элемента Quad 4node 182 

 

 Нажать кнопку OK в окне Library of Elements Types. 

 Нажать кнопку Options… в окне Element Types.  

 В выпадающем списке K3 появившегося окна 

PLANE182 element type options (Рисунок 88) выбираем раздел 

Plane stress, т.к. предполагаем, что толщина образца мала и 

имеют место деформации вдоль оси 0Z. 

 Нажать кнопку OK в окне PLANE182 element type options. 

 Нажимаем кнопку Close в окне Element Types (Рисунок 86). 

 

 
Рисунок 88. Вид окна PLANE182 element type options 

 

 

Шаг 3. Включение нумерации линий 

Для того чтобы правильно выполнить разбиение, сначала следует 

настроить плотность разбиения, установив количество делений на линиях. 
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Для облегчения этой задачи следует знать номера линий. На данном шаге 

будет включено отображение номеров линий, при отрисовке модели. 

Пункт меню утилит 

Utility Menu> PlotCtrl> Numbering… 

При использовании данного пункта меню появляется окно 

Plot Numbering Controls. Далее выполняем следующие действия: 

 устанавливаем флаг  в пункте LINE; 

 Нажимаем кнопку OK для подтверждения окончания выбора 

(Рисунок 89); 

Команда 

/PNUM,LINE,1 

З а м е ч а н и е! После выполнения команд иногда необходимо 

перерисовать отображаемую фигуру с помощью пункта меню утилит 

Utility Menu> Plot> Replot … 

Результаты выполнения шага 3 

 
Рисунок 89. Модель примера 1 с включенной нумерацией линий 
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Шаг 4. Назначение количества делений на линиях при разбиении 

Можно воспользоваться любым из трех перечисленных ниже способов 

(средствами Meshtool, пунктом главного меню или командой LESIZE) для 

назначений количества делений на выбранных линиях. 

Средства MeshTool 

Main Menu> Preprocessor> Meshing> MeshTool… 

Для установки количества делений (или размеров элементов) на линиях 

с помощью MeshTool:  

 Воспользуемся кнопкой Set с меткой Lines из третьей сверху 

секции диалогового окна MeshTool (Рисунок 90).  

 

 
Рисунок 90. Третья сверху секция окна MeshTool 

 

 С помощью окна выбора Element Size on Picked Lines (Рисунок 

91) выбираем линии L3, L4, L8, L9 и L10. 

 

 
Рисунок 91. Окно выбора Element Size on Picked Lines 
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 Нажимаем в окне OK или Apply. 

 В поле NDIV появившегося окна Element Sizes on Picked Lines 

указываем количество разбиений выбранных линий. В данном 

случае указываем, что линия делится на 10 отрезков узлами 

конечноэлементной сетки. 

 

 
Рисунок 92. Вид окна Element Sizes on Picked Lines 

 

 Нажимаем Apply в окне Element Sizes on Picked Lines (Рисунок 

92), т.к. еще будем продолжать назначать количество разбиений 

на других линиях. 

 С помощью окна выбора Element Size on Picked Lines выбираем 

линии L2. 

 Нажимаем в окне OK или Apply. 

 В поле с меткой NDIV появившегося окна 

Element Sizes on Picked Lines указываем количество разбиений 

выбранных линий. В данном случае указываем, что линии 

делиться на 4 отрезка узлами конечноэлементной сетки. 

 Нажимаем в окне OK. 
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Пункт главного меню 

Main Menu> Preprocessor> Meshing> Size Cntrls>  

ManualSize> Lines> Picked Lines 

При его использовании: 

 С помощью окна выбора Element Size on Picked Lines выбираем 

линии L3, L4, L8, L9 и L10. 

 Нажимаем в окне OK или Apply. 

 В поле с меткой NDIV появившегося окна 

Element Sizes on Picked Lines указываем количество разбиений 

выбранных линий. В данном случае указываем, что линия 

делится на 10 отрезков узлами конечноэлементной сетки. 

 Нажимаем Apply в окне Element Sizes on Picked Lines, т.к. еще 

будем продолжать назначать количество разбиений на других 

линиях. 

 С помощью окна выбора Element Size on Picked Lines выбираем 

линии L2. 

 Нажимаем в окне OK или Apply. 

 В поле с меткой NDIV появившегося окна 

Element Sizes on Picked Lines указываем количество разбиений 

выбранных линий. В данном случае указываем, что линии 

делиться на 4 отрезка узлами конечноэлементной сетки. 

 Нажимаем в окне OK. 

Список команд 

LESIZE,3,,,10 

LESIZE,4,,,10 

LESIZE,8,,,10 

LESIZE,9,,,10 

LESIZE,10,,,10 

LESIZE,2,,,4 
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Шаг 5. Включение нумерации ключевых точек и выключение нумерации 

линий 

Пункт меню утилит 

Utility Menu> PlotCtrl> Numbering… 

При использовании данного пункта меню появляется окно 

Plot Numbering Controls. Далее выполняем следующие действия: 

 устанавливаем флаг  в пункте KP; 

 устанавливаем флаг  в пункте LINE; 

 Нажимаем кнопку OK для подтверждения окончания выбора 

(Рисунок 93); 

З а м е ч а н и е! После выполнения пунктов меню иногда необходимо 

перерисовать отображаемую фигуру с помощью пункта меню утилит 

Utility Menu> Plot> Replot 

Список команда 

/PNUM,LINE,0 

/PNUM,KP,1 

/REPLOT 

Результаты выполнения шага 5 

 
Рисунок 93. Результат включения нумерации ключевых точек и 

выключения нумерации линий 
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Шаг 6. Построение упорядоченного разбиения области с помощью 

выбора угловых ключевых точек (неявная конкатенация) 

З а м е ч а н и е! Следующие три шага даны для иллюстрации процесса 

разбиения и появления возможных ошибок. Разбиение, которое будет 

создано на этом шаге, в дальнейшем будет удалено, т. к. при его 

выполнении будут созданы элементы «опасной» формы. Разбиение без 

ошибок будет создано начиная с шага 9, поэтому можно переходить 

сразу к нему. 

Средства MeshTool 

Main Menu> Preprocessor> MeshTool… 

Для построения разбиения используются средства, находящиеся в 

четвертом (сверху) разделе MeshTool. Для построения упорядоченного 

разбиения области с помощью выбора угловых точек средствами MeshTool:  

 В первом выпадающем списке выбираем раздел Area – т.к. будут 

разбиваться поверхности. 

 Выбираем форму элементов, а именно пункт Quad – для того 

чтобы разбиение было выполнено четырехсторонними 

элементами. 

 Указываем во втором выпадающем списке четвертого (сверху) 

раздела MeshTool (Рисунок 94), что выбор области для 

регулярного разбиения осуществляется назначением угловых 

точек (Pick corners). 

 

 
Рисунок 94. Четвертый раздел MeshTool 
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 Нажимаем в окне кнопку Mesh. 

 Выбраем поверхность, которую необходимо разбить на элементы 

с помощью первого появившегося окна выбора 

Map Mesh Area by Corners (Рисунок 95). 

 

 
Рисунок 95. Окно выбора Map Mesh Area by Corners 

 

 Нажимаем кнопку OK в первом окне Map Mesh Area by Corners. 

 Указываем ключевые точки 2, 3, 10, 9, являющиеся углами 

разбиваемой поверхности (Рисунок 93) с помощью второго 

появившегося окна выбора Map Mesh Area by Corners (Рисунок 

96). 
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Рисунок 96. Выбор четырех угловых точек для упорядоченного 

разбиения 

 

З а м е ч а н и е! После выбора четвертой угловой точки (например, номер 

9) ANSYS автоматически разобъет указанную поверхность  

 Нажимаем кнопку Cancel во втором окне 

Map Mesh Area by Corners. 

З а м е ч а н и е! Неявно конкатенация (логическое объединение линий для 

построения разбъения в одну линию) выполнена для двух групп линий 

(первая: L8, L3, L10, L4, L9 и вторая: L1, L7, L6). Перечисленные группы 

линий стали одной из четырех сторон разбиваемой области. 

Пункты главного меню 

Установка вида разбиения и формы элементов выполняется с помощью 

пункта главного меню: 

Main Menu> Preprocessor> Meshing> Mesher Opts… 

 В данном случае необходимо во втором разделе окна 

Mesher Options установить в поле с меткой KEY Mesher Type тип 

разбиения Mapped  

 Нажимаем кнопку OK. 
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 В выпадающем списке появившегося окна Set Element Shape 

устанавливаем форму элементов Quad – т.е. элементы 

используемые при разбиении должны быть четырехугольными. 

 Нажимаем кнопку OK. 

Построение упорядоченного разбиения с помощью пункта меню: 

Main Menu> Preprocessor> Meshing> Mesh> Areas> Mapped> By Corners 

При его использовании появляется первое окно выбора 

Map Mesh Area by Corners. В этом случае: 

 Выбраем поверхность, которую необходимо разбить на элементы 

(Рисунок 96). 

 Нажимаем кнопку OK. 

 Указываем ключевые точки 2, 3, 10, 9, являющиеся углами 

поверхности, которую необходимо разбить на элементы с 

помощью второго появившегося окна выбора 

Map Mesh Area by Corners (Рисунок 97). 

Команда 

AMAP,1,2,3,10,9 

Результаты выполнения шага 6 

 

 
Рисунок 97. Результаты построения уорядоченного разбиения по 

четырем угловым точкам (неявной конкатенации) 
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З а м е ч а н и е! После построения разбиения ANSYS выдаст 

предупреждающее сообщение (окно Warning) о наличии элементов 

нарушающих допустимые пределы изменения их формы (Рисунок 98) и 

окно Accept/Reject Mesh для подтверждения удовлетворительности 

разбиения (Рисунок 99). Для того чтобы оставить созданное разбиение 

следует нажать OK в Accept/Reject Mesh либо для удаления разбиения 

необходимо установить «флаг»  в поле Accept Current Mesh? и 

нажать OK.  

Окно Warning закрывается нажатием кнопки Close. 

 

 
Рисунок 98. Предупреждающее сообщение ANSYS 

 

 
Рисунок 99. Окно Accept/Reject Mesh 

 

 

 

Шаг 7. Проверка качества разбиения 

При получении предупреждающего сообщения следует посмотреть, где 

расположены элементы с отклонениями формы и какова степень отклонения 

их формы от нормальной.  

З а м е ч а н и е! Выполнение проверки качества разбиения не доступно с 

помощью средств MeshTool. 
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Пункт главного меню 

Main Menu> Preprocessor> Meshing> Check Mesh>  

Individual Elm> Plot Warning/Error Elements 

При его использовании появляется первое окно Plot Warning/Error 

Elements (Рисунок 100). «По умолчанию» в нем стоят необходимые 

установки. Необходимо подтвердить установки, нажав OK (Рисунок 101).  

 

 
Рисунок 100. Вид окна Plot Warning/Error Elements 

 

Список команд 

CHECK 

/REPLOT 
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Результаты выполнения шага 7 

 
Рисунок 101. Отображение "опасных" элементов модели 

 

З а м е ч а н и е! Наличие «опасных» и «плохих» элементов в указанных 

областях (Рисунок 101) оказывает существенное влияние на качество 

расчета в интересующей нас области (центральной выточке образца). И 

должно быть исправлено на следующих шагах. 

 

 

Шаг 8. Удаление разбиения  

Средства MeshTool 

Main Menu> Preprocessor> Meshing> MeshTool… 

Для удаления разбиения средствами MeshTool:  

 Нажимаем кнопку Clear в четвертом разделе (Рисунок 102) окна 

MeshTool. 
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Рисунок 102. Четвертый раздел окна MeshTool 

 

 Выбраем поверхность, которую необходимо очистить от 

разбиения с помощью окна Clear Areas. 

 Нажимаем кнопку OK в окне Clear Areas. 

 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Clear> Areas 

При использовании данного пункта меню появиться окно выбора 

Clear Areas. При этом: 

 Выбраем поверхность, которую необходимо очистить от 

разбиения. 

 Нажимаем кнопку OK. 

 

Команда 

ACLEAR,1 

З а м е ч а н и е! Данный пункт обычно может быть пропущен. Это 

связано с тем, что при выполнении разбиения на уже разбитой области, 

старое разбиение, как правило, может быть удалено автоматически. 

При этом во время повторного разбиения ANSYS выдаст 

предупреждение-запрос (Рисунок 103) o том, что область уже была 

разбита и пользователь должен подтвердить повторное разбиение с 

измененными параметрами. В этом случае пользователь для 

«перестроения» разбиения должен нажать кнопку OK. 
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Рисунок 103. Запрос о выполнении нового разбиения 

 

Шаг 9. Построение вспомогательной линии, норамальной к основанию 

модели 

Пункт главного меню 

Main Menu> Preprocessor> Modeling> Create> Lines> Lines> Normal to Line 

При его использовании появляется первое окно выбора 

Line Normal to Line (Рисунок 104), с помощью которого: 

 

 
Рисунок 104. Первое меню выбора Line Normal to Line 

 

 Выбираем линию L7 (Рисунок 89);  

 Выбираем ключевую точку с номером 5 (Рисунок 93); 

 Нажимаем OK; 
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Список команд 

LANG,7,5,90,, 

 

Шаг 10. Отображение линий 

Пункт главного меню 

Для отображения линий необходимо воспользоваться пунктом меню 

(Рисунок 105): 

Utility Menu> Plot> Lines 

Список команд 

LPLOT 

З а м е ч а н и е! Данная команда «по умолчанию» соответствует 

команде LPLOT, All 

Результаты выполнения шага 10 

 
Рисунок 105. Построение вспомогательной линии, нормальной к 

основанию модели 
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Шаг 11. Построение вспомогательных линий вытягиванием 

Пункт главного меню 

Main Menu> Preprocessor> Modeling> Operate> Extrude> Keypoints> Along 

Lines 

При использовании данного пункта меню: 

 c помощью первого окна выбора Sweep KPs along Lines выбираем 

ключевые точки 6, 13, 12; 

 нажимаем OK; 

 с помощью второго окна выбора указываем построенную на шаге 

9 линию между ключевыми точками 4 и 5 (Рисунок 105); 

 Нажимаем OK (Рисунок 106); 

Список команд 

LDRAG,6,13,12,,,,12,,,,, 

 

Результаты выполнения шага 11 

 
Рисунок 106. Результат построения вспомогательных линий 

вытягиванием 
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Шаг 12. Деление модели вспомогательными линиями 

Пункт главного меню 

Main Menu> Preprocessor> Modeling> Operate> Booleans> Divide> Area by 

Line 

При использовании пункта главного меню: 

 c помощью первого окна выбора Divide Area by Line выбираем 

модель; 

 нажимаем OK; 

 с помощью второго окна выбора указываем построенные на 

предыдущих шагах вспомогательные линии (Рисунок 106); 

 Нажимаем OK; 

Список команд 

ASBL,1,12,,DELETE,KEEP 

ASBL,3,13,,DELETE,KEEP 

ASBL,4,15,,DELETE,KEEP 

ASBL,3,14,,DELETE,KEEP 

 

Шаг 13. Включение нумерации линий и выключение нумераций точек 

Пункт меню утилит 

Utility Menu> PlotCtrl> Numbering… 

При использовании данного пункта меню появляется окно 

Plot Numbering Controls. Далее выполняем следующие действия: 

 устанавливаем флаг  в пункте LINE; 

 устанавливаем флаг  в пункте KP; 

 нажимаем кнопку OK для подтверждения окончания выбора 

(Рисунок 107); 
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З а м е ч а н и е! После выполнения пунктов меню иногда необходимо 

перерисовать отображаемую фигуру с помощью пункта меню утилит 

Utility Menu> Plot> Replot 

Список команда 

/PNUM,LINE,1 

/PNUM,KP,0 

/REPLOT 

 

Результаты выполнения шага 13 

 
Рисунок 107. Отображение номеров всех линий модели 

 

Шаг 14. Явное выполнение конкатенации линий 

На предыдущих шагах модель образца была разбита на 5 подобластей, 

некоторые из которых имеют более 4 сторон (Рисунок 107). Напомним, что 

построение упорядоченного разбиения возможно лишь для поверхностей, 

имеющих не более четырех линий границы. Использование явной 

конкатенации в случае большего количества ограничивающих линий 
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позволяет «объединить» некоторые линии в одну для проведения 

упорядоченного разбиения. 

З а м е ч а н и е! Явное выполнение конкатенации не доступно в окне 

MeshTool. 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Concatenate> Lines 

При его использовании: 

 С помощью окна выбора Concatenate Lines выбираем линии L1, 

L11 (Рисунок 107), которые при разбиении будут «считаться» 

одной стороной. 

 Нажимаем в окне Apply. 

 С помощью окна выбора Concatenate Lines выбираем линии L6, 

L19 (Рисунок 107), которые при разбиении также будут 

«считаться» одной стороной. 

 Нажимаем в окне OK. 

Список команд 

LCCAT,1,11 

LCCAT,6,19 

 

 

Шаг 15. Построение упорядоченного разбиения по 4 сторонам 

поверхности 

Средства MeshTool 

Main Menu> Preprocessor> MeshTool 

Для построения упорядоченного разбиения используем четвертую 

(сверху) секцию окна MeshTool: 

 В первом выпадающем списке выбираем раздел Area – т.к. будут 

разбиваться поверхности. 
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 Выбираем форму элементов, а именно пункт Quad, – для того 

чтобы разбиение было выполнено четырехсторонними 

элементами. 

 Выбираем вид разбиения, а именно пункт Mapped, – разбиение 

должно быть упорядоченным 

 Во втором выпадающе списке выбираем пункт 3 or 4 sided – 

разбиение четырех или трехсторонней поверхности (Рисунок 

108).  

 Нажимаем кнопку Mesh.  

 С помощью появившегося окна выбора Mesh Areas указываем, 

что собираемся разбивать все поверхности с помощью кнопки 

Pick All. 

 Нажимаем кнопку OK в окне Accept/Reject Mesh (Рисунок 109). 

 

 
Рисунок 108. Вид четвертой секции окна MeshTool с опциями построения 

упорядоченного рабиения по четырем сторонам 

 

 
Рисунок 109. Окно подтверждения приемлимости разбиения 

 

Пункты главного меню 

При построении разбиения необходимо использовать последовательно 

несколько пунктов главного меню: 
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Установка вида разбиения и формы элементов выполняется с помощью 

пункта главного меню: 

Main Menu> Preprocessor> Meshing> Mesher Opts… 

З а м е ч а н и е! Напомним, что «по умолчанию» будут использоваться 

четырехсторонние элементы, и ими будет выполнено упорядоченное 

разбиение, т.к. эти параметры были установлены выше в предлагаемой 

последовательности действий. 

Построение упорядоченного разбиения поверхности выполняется с 

помощью пункта меню: 

Main Menu> Preprocessor> Meshing> Mesh> Areas> Mapped> 3 or 4 sided 

При использовании данного пункта меню появится окно выбора 

Mesh Areas. После этого: 

 С помощью появившегося окна выбора Mesh Areas указываем, 

что собираемся разбивать все поверхности с помощью кнопки 

Pick All. 

Список команд 

MSHAPE,0,2-D 

MSHMID,0 

MSHKEY,1 

AMESH,ALL 

З. а м е ч а н и е! В приведенной последовательности действий опущен 

шаг, касающийся проверки формы элементов, т.к. замечаний в данном 

случае ANSYS не выдает. В следующих примерах он будет описан 

детально. 

 

Шаг 16. Сохранение измененной модели в db-файле 

Utility Menu> Save as … 
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При использовании пункта меню утилит появляется окно выбора 

Save DataBase. Необходимо выбрать диск и директорию, в которой хранится 

файл.  

З а м е ч а н и е! После выполнения данных действий в левом списке под 

окном ввода имени Save Database to появится список имен файлов 

(Рисунок 110) с расширениями db или dbb. 

 
Рисунок 110. Список файлов 

 

Далее необходимо: 

 В списке Save DataBase to выбираем c помощью «мыши» 

существующий файл из списка, в котором хранится 

твердотельная модель модель примера 1 (например, Example1.db) 

(Рисунок 111). 

 

 
Рисунок 111. Выбор файла 

 

 Нажимаем кнопку OK. 

З а м е ч а н и е! После выполнения данных действий появится 

предупреждающее сообщение о том, что данный файл уже существует. 

Пользователь должен подтвердить замену существующего файла новым 

(Рисунок 112). 
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Рисунок 112. Окно с предупреждающим сообщением 

 

 Нажать кнопку Yes («по умолчанию» включена кнопка No, 

Рисунок 113). 

 

Результат построения упорядоченного разбиения для примера 1 

 
Рисунок 113. Результат построения конечноэлементного разбиения 

модели примера 1 

 

Пример 2. Построение разбиения плоской гребенки с трапецоидальными 

зубъями 

Шаг 1. Чтение существующей модели из db-файла 

Для этого используем пункт меню: 

Utility Menu> File> Resume from… 
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При использовании пункта меню утилит появляется окно 

Resume DataBase. В этом случае последовательность действий, связанная с 

выбором логического диска, папки (директории), в которой хранится уже 

созданный файл полностью изложены ранее, однако в данном случае 

необходимо выбрать другой файл (например, Example2.db) в списке 

Resume DataBase From, в котором хранится вторая созданная модель. 

Шаг 2. Выбор типа элемента для разбиения 

Указываем тип элементов Structural Solid (т.к. решается задача 

структурного анализа), элементы Quad 4node 182, с помощью которых будем 

создавать разбиение. Воспользуемся при этом пунктом главного меню: 

Preprocessor> Element Type> Add/Edit/Delete 

Последовательность действий примера 1 данного раздела.  

 

 

Шаг 3. Построение свободного разбиения с использованием SmartSize 

З а м е ч а н и е! Свободное разбиение в данном случае не является 

предпочтительным, так как все компоненты модели (зубы и их 

основание) имеют правильную форму (четырехугольники с прямыми 

сторонами) Соответственно, в данном случае желательно использовать 

упорядоченное разбиение. Шаги 3, 4, 5 в данном примере даны для 

иллюстрации различных способов разбиения. Так разбиение созданное на 

шаге 3 удаляется на шаге 5, поэтому при выполнении примера можно 

сразу после шага 2 переходить к шагу 6. 

Кроме того, напомним, что нумерация поверхностей осталась 

включенной после окончания рисования и определения свойств материалов. 

Средства MeshTool 

Main Menu> Preprocessor> Meshing> MeshTool… 

Для построения свободного разбиения  

 Во второй секции окна MeshTool устанавливается флаг  в 

переключатем Smart Size и устанавливаем уровень разбиения 8 

(Рисунок 114). 
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З а м е ч а н и е! Установить менее грубый уровень разбиения при решении 

занной задачи не позволяют ограничения на количество элементов. 

 

 
Рисунок 114. Вторая секция окна MeshTool 

 

 Выбираем форму элементов, а именно пункт Quad, – для того 

чтобы разбиение было выполнено четырехсторонними 

элементами. 

 Выбираем вид разбиения, а именно пункт Free, – разбиение 

должно быть свободным (Рисунок 115). 

 

 
Рисунок 115. Четвертая секция MeshTool с включенными опциями 

свободного разбиения 

 

 Нажимаем кнопку Mesh.  

 С помощью появившегося окна выбора Mesh Areas указываем с 

помощью кнопки Pick All, что собираемся разбивать все 

созданные поверхности на элементы. 

Пункты главного меню 

Устанавливаем опции разбиения (вид разбиения и форма элементов). 

Для этого используем пункт меню: 

Main Menu> Preprocessor> Meshing> Mesher Options… 

З а м е ч а н и е! В данном случае, в отличие от предыдущего примера нет 

необходимости использовать этот пункт, т.к. «по умолчанию» будут 



 

 

155 

использоваться четырехсторонние элементы, и ими будет выполнено 

свободное разбиение. 

Устанавливаем параметры Smart Size с помощью пункта меню: 

Main Menu> Preprocessor> Meshing> Size Ctrls> SmartSize> Basic 

При использовании данного пункта меню появится окно 

Basic SmartSize Settings (Рисунок 116), в котором необходимо выбрать в 

выпадающем списке уровень размера элементов при разбиении, и после 

выбора нажать OK.  

 

 
Рисунок 116. Вид окна Basic SmartSize Settings 

 

Построение свободного разбиения осуществляется с помощью пункта 

меню: 

Main Menu> Preprocessor> Meshing> Mesh> Areas> Free 

При его использовании появляется окно выбора Mesh Areas, с 

помощью которого указываем все разбиваемые на элементы поверхности c 

помощью кнопки Pick All (Рисунок 117). 

Список команд 

SMRTSIZE,8 

MSHKEY,0 

MSHAPE,0,2-D 

AMESH,1,2 
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Результаты выполнения шага 3 

 
Рисунок 117. Результаты построения свободного разбиения 

З а м е ч а н и е! ANSYS после построения разбиения выдаст 

предупреждающие сообщения о наличии опасных элементов в разбиении.  

 

Шаг 4. Проверка качества разбиения 

При получении предупреждающего сообщения следует посмотреть, где 

расположены элементы с отклонениями формы. 

З а м е ч а н и е! Выполнение проверки качества разбиения не доступно с 

помощью средств MeshTool. 

Main Menu> Preprocessor> Meshing> Check Mesh>  

Individual Elm> Plot Warning/Error Elements 

При его использовании появляется первое окно выбора 

Plot Warning/Error Elements. «По умолчанию» в нем стоят необходимые 

установки. Необходимо подтвердить установки, нажав OK (Рисунок 118).  

Список команд 

CHECK 

/REPLOT 
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Рисунок 118. Отображение «опасных» элементов построенного разбиения 

 

 

Шаг 5. Удаление выполненного разбиения 

Наличие опасных/плохих элементов в указанных областях, видимо, 

будет оказываеть влияние на качество расчета в интересующей нас области 

(рабочей поверхности центральных зубов).  

К сожалению в ANSYS 10 ED средствами MeshTool улучшения 

разбиения добиться нельзя, т.к. существуют жесткие ограничения на 

количество элементов. Возможности улучшения сетки продемонстрированы 

ниже.  

Сейчас удалим сетку и в дальнейшем перейдем к построению 

регулярного разбиения, для чего каждая из областей будет разделена на 

несколоко боле простых подобластей. 

Последовательность действий для удаления сетки cм. в примере 1 

данного раздела. 

 

Шаг 6. Включаем нумерацию ключевых точек и поверхностей 

Пункт меню утилит 

Utility Menu> PlotCtrl> Numbering… 
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При использовании данного пункта меню появляется окно 

Plot Numbering Controls. Далее выполняем следующие действия: 

 устанавливаем флаг  в пункте KP; 

 оставляем флаг  в пункте Areas; 

 Нажимаем кнопку OK для подтверждения окончания выбора; 

Список команд 

/PNUM,KP,1 

/PNUM,AREA,1 

/REPLOT 

 

Шаг 7. Построение вспомогательной прямой линии в области A1  

З а м е ч а н и е! Чтобы получить упорядоченное разбиение имеющейся у 

нас поверхности сложной формы, ее следует разделить на несколько 

более простых. Наиболее очевидным действием будет отделение зубов от 

основания, тогда все создаваемые компоненты будут четырехугольной 

формы и их можно разбить упорядоченным разбиением. Чтобы 

разделить исходную поверхность на части, следует использовать линию, 

которая разрежет ее. Линия должна идти по основанию зубов гребенки. 

В данном случае будут совместно использоваться пункты главного меню 

и меню выбора Select Entities. 

 Используем пункт меню утилит для вызова окна Select Entities: 

Utility Menu> Select> Entities… 

 Выбираем поверхность A1 (нижняя поверхность) с помощью 

меню Select Entities. Для этого:  

 Выбраем пункт Areas в первом выпадающем списке первой 

секции окна Select Entities.  

 Выбраем пункт By Num/Pick во втором выпадающем списке 

первой секции окна Select Entities (Рисунок 118). 
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Рисунок 119. Вид первой секции окна Select Entities с опциями выбора 

поверхности по номеру или с помощью «мыши» 

 

 Нажимаем кнопку Apply. 

 Выбираем с помошью появившегося окна выбора Select areas 

поверхность A1 (нижняя поверхность). Нажимаем OK. 

 Для «перерисовки» компоненты выбираем пункт меню: 

Utility Menu> Plot> Replot 

 Для создания прямой линии между ключевыми точками 1 и 20 

используем пункт главного меню: Main Menu> Preprocessor> 

Modeling> Create> Lines> Lines> Straight Line. 

Последовательность действий см. пример 1 гл. «Средства 

создания геометрической модели детали в ANSYS» (Рисунок 

120). 

 

 
Рисунок 120. Результат создания вспомогательной линии 

 

Команда 

LSTR,1,20 
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Шаг 8. Деление поверхности A1 с помощью вспомогательной линии 

В данном случае нам необходимо для построения регулярного 

разбиения разбить поверхность A1 на несколько частей с общей границей. 

Пункт главного меню 

Main Menu> Preprocessor> Modelling> Operate> Booleans> Divide> 

Area by Line 

При использовании данного пункта появится меню выбора 

Divide Area by Line, с помощью которого следует: 

 Выбрать область A1.  

 Нажать кнопку OK. 

 Выбрать дополнительную линию соединяющию ключевые точки 

1 и 20 (Рисунок 120). 

 Нажать кнопку OK (Рисунок 121). 

Список команд 

ASBL,1,49,,DELETE,DELETE 

/REPLOT 

 
Рисунок 121. Результат деления поверхности A1 с помощью 

вспомагательной линии 
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Шаг 9. Отмена выбора области A1 с помощью Select Entities 

 Выбираем раздел Area в первом выпадающем списке первой 

секции окна Select Entities (Рисунок 119).  

 Выбираем раздел By Num/Pick во втором выпадающем списке 

первой секции окна Select Entities (Рисунок 119).  

 Нажимаем кнопку Sele All (Рисунок 122). 

 Нажимаем кнопку Plot (Рисунок 123) в четвертой секции меню 

Select Entities (Рисунок 124). 

 

 
Рисунок 122. Вид третьей секции окна Select Entities 

 

 
Рисунок 123. Вид четвертой секции меню Select Entities 

 

 
Рисунок 124. Результат отмены ранее сделанного выбора 

 

Шаг 10. Деление на части поверхности A2 с помощью 

вспомагательной линии  

 Повторить шаг 7 данного примера, соединив ключевые точки 27 

и 46 вспомагательной линией (Рисунок 125). 
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 Повторить шаг 8 данного примера (Рисунок 126). 

 Повторить шаг 9 данного примера. 

 

 
Рисунок 125. Результат создания вспомогательной линии 

 

 
Рисунок 126. Результат деления поверхности A2 вспомогательной линией 

 

 

Шаг 11. Выключение нумерации линий 

Utility Menu> PlotCtrl> Numbering… 
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При использовании данного пункта меню появляется окно 

Plot Numbering Controls. Далее выполняем следующие действия: 

 устанавливаем флаг  в пункте KP; 

 оставляем флаг  в пункте Areas; 

 Нажимаем кнопку OK для подтверждения окончания выбора 

(Рисунок 127); 

Список команд 

/PNUM,KP,1 

/PNUM,AREA,1 

/REPLOT 

 
Рисунок 127. Результаты отображения номеров поверхностей 

 

Шаг 12. Указание количества элементов на основании зуба A1 

З а м е ч а н и е! В данном случае будут совместно использоваться 

пункты главного меню и меню выбора Select Entities. 

 Используем пункт меню утилит для вызова диалогового окна 

Select Entities: Utility Menu> Select> Entities… 

 Выбираем поверхность A1 (первый слева верхний зуб, Рисунок 

127) с помощью меню Select Entities. Для этого:  
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1. Выбраем пункт Areas в первом выпадающем списке первой 

секции окна Select Entities (Рисунок 128).  

2. Выбраем пункт By Num/Pick во втором выпадающем 

списке первой секции окна Select Entities (Рисунок 128). 

 

 
Рисунок 128. Вид первой секции окна Select Entities с установленными 

опциями выбора поверхностей с помощью номера или «мыши» 

 

3. Нажимаем кнопку Apply или ОК. 

4. Выбираем с помошью появившегося окна выбора 

Select areas поверхность A1 (первый верхний зуб). 

Нажимаем кнопку ОК. 

5. Для «перерисовки» выбранных компонент используем 

пункт меню утилит Utility Menu> Plot> Replot. 

6. Включаем нумерацию линий с использованием пункта 

меню утилит: Menu Utility> PlotCtrls> Numbering (Рисунок 

129). 

7. Устанавливаем, что количество делений на линии L55 при 

разбиении зуба равно трем (см. последовательность 

использования кнопки Set из третьей сверху секции 

MeshTool, Рисунок 90) 

 

 
Рисунок 129. Результат выбора первой поверхности (зуба) 
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З а м е ч а н и е! Количество делений на сторонах «нецентральных» 

зубьев и верхней и нижней гребенок должно быть минимальным. 

Разбиение же центральных зубов (поверхности A5 и A10) должно быть 

более мелким для получения более точных результатов расчета. 

Минимальное количество элементов по любому ребру твердотельной 

модели в версии ANSYS 10.ED равно 3. 

8. Выключаем нумерацию линий и оставляем нумерацию 

поверхностей с использованием пункта меню утилит: 

Menu Utility> PlotCtrls> Numbering.  

9. Нажимаем кнопку Sele All в меню Select Entities (Рисунок 

122). 

10. Нажимаем кнопку Plot в меню Select Entities (Рисунок 123). 

 

Шаг 13. Указание количества делений при разбиении линий основания 

остальных зубов 

Последовательность действий повторяет действия, рассмотренные на 

предыдущем шаге текущего примера для всех поверхностей кроме A8, A13 

(Рисунок 127). 

 Для линий основания «нецентральных» зубов (поверхности A3, 

A4, A6, A7, A9, A11 и A12) устанавливается колличество делений 

равное 3. 

 Для линий основания центральных зубов (поверхности A5 и A10) 

устанавливаем колличество делений равное 4 (линии L52 и L57).  

 Для контактирующих поверхностей центральных зубов (линии 

L12 и L35) устанавливаем количество делений равное 9. 

 

Шаг 14. Выполнение явной конкатенации линий поверхностей A8 и A13 

 Используем пункт меню утилит для вызова диалогового окна 

Select Entities: Utility Menu> Select> Entities… 

 Выбираем поверхность A8 и А13 с помощью меню Select Entities. 

Для этого:  

1. Выбраем раздел Areas в первом выпадающем списке 

первой секции окна Select Entities (Рисунок 128).  

2. Выбраем раздел By Num/Pick во втором выпадающем 

списке первой секции окна Select Entities (Рисунок 128).  

3. Нажимаем кнопку Apply или ОК. 
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4. Выбираем с помошью появившегося окна выбора 

Select areas поверхность A8 и А13. Нажимаем кнопку ОК. 

5. Для «перерисовки» выбранных компонент используем 

пункт меню утилит Utility Menu> Plot> Replot. 

6. Включаем нумерацию линий с использованием пункта 

меню утилит: Menu Utility> PlotCtrls> Numbering (Рисунок 

129). 

7. Для поверхности A8 и A13 выполняем явную конкатенацию 

линий (Рисунок 130) с помощью пункта главного меню 

Main Menu> Preprocessor> Meshing> Concatenate> Lines. 

Для этого помощью окна выбора Concatenate Lines для 

поверхности A8 выбираем линии L1, L50, L5, L51, L9, L52, 

L13, L53, L17, L54, L21 (Рисунок 130), которые при 

разбиении будут «считаться» одной стороной. Нажимаем в 

окне Apply. 

8. Затем для поверхности A13 выбираем линии L26, L55, L30, 

L56, L34, L57, L38, L58, L42, L59, L46 (Рисунок 130), 

которые при разбиении также будут «считаться» одной 

стороной. 

9. Нажимаем в окне OK. 

10. Выключаем нумерацию линий и оставляем нумерацию 

поверхностей с использованием пункта меню утилит: 

Menu Utility> PlotCtrls> Numbering.  

11. Нажимаем кнопку Sele All в меню Select Entities. 

12. Нажимаем кнопку Plot в меню Select Entities. 

 

 
Рисунок 130. Нумерация линий поверхностей A8 и A13 
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Шаг 15. Создание упорядоченного разбиения поверхностей 

Средства MeshTool 

Main Menu> Preprocessor> MeshTool 

Для построения упорядоченного разбиения используем четвертую 

(сверху) секцию окна MeshTool: 

 В первом выпадающем списке выбираем раздел Area – т.к. будут 

разбиваться поверхности. 

 Выбираем форму элементов, а именно пункт Quad, – для того 

чтобы разбиение было выполнено четырехсторонними 

элементами. 

 Выбираем вид разбиения, а именно пункт Mapped, – разбиение 

должно быть упорядоченным 

 Во втором выпадающем списке выбираем пункт 3 or 4 sided – 

разбиение четырех или трехсторонней поверхности (Рисунок 

108).  

 Нажимаем кнопку Mesh.  

 С помощью появившегося окна выбора Mesh Areas указываем, 

что собираемся разбивать все поверхности с помощью кнопки 

Pick All. 

 Нажимаем кнопку OK в окне Accept/Reject Mesh. 

 

Пункты главного меню 

При построении разбиения необходимо использовать последовательно 

несколько пунктов главного меню: 

Установка вида разбиения и формы элементов выполняется с помощью 

пункта главного меню: 

Main Menu> Preprocessor> Meshing> Mesher Opts… 

З а м е ч а н и е! Напомним, что «по умолчанию» будут использоваться 

четырехсторонние элементы, и ими будет выполнено упорядоченное 

разбиение, т.к. эти параметры были установлены выше в предлагаемой 

последовательности действий. 
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Построение упорядоченного разбиения поверхности выполняется с 

помощью пункта меню: 

Main Menu> Preprocessor> Meshing> Mesh> Areas> Mapped> 3 or 4 sided 

При использовании данного пункта меню появится окно выбора 

Mesh Areas. После этого c помощью появившегося окна выбора Mesh Areas 

указываем, что собираемся разбивать все поверхности с помощью кнопки 

Pick All. 

Список команд 

MSHAPE,0,2-D 

MSHMID,0 

MSHKEY,1 

AMESH,ALL 

 

Шаг 16. Сохранение измененной модели в db-файле 

Для этого используем пункт меню: 

Utility Menu> File> Save as… 

При использовании пункта меню утилит появляется окно 

Save DataBase. В этом случае последовательность действий, связанная с 

выбором логического диска, папки (директории), в которой будет храниться 

файл, полностью соответствует примеру 1 раздела «Средства создания 

геометрической модели детали в ANSYS».  

З а м е ч а н и е! После выполнения данных действий в левом списке 

Save Database to появится список имен файлов (Рисунок 131) с 

расширениями db или dbb. 
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Рисунок 131. Список файлов 

 

Далее необходимо: 

 В списке Save DataBase to выбирать c помощью «мыши» 

существующий файл, в котором хранится твердотельная модель 

примера 2 (например, Example2.db). 

 Нажимаем кнопку OK. 

З а м е ч а н и е! После выполнения данных действий появится 

предупреждающее сообщение о том, что данный файл уже существует. 

И пользователь должен подтвердить замену существующего файла 

новым (Рисунок 132). 

 

 
Рисунок 132. Окно с предупреждающим сообщением 

 

 Нажать кнопку Yes («по умолчанию» включена кнопка No, 

Рисунок 133). 
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Результат построения конечноэлементной модели для примера 2 

 
Рисунок 133. Результат построения упорядоченного разбиения модели 

примера 2 

 

Пример 3. Конечно-элементное разбиение модели кривошипа коленчатого 

вала 

Шаг 1. Чтение существующей модели из db-файла 

Для этого используем пункт меню: 

Utility Menu> File> Resume from… 

При использовании пункта меню утилит появляется окно 

Resume DataBase. В этом случае последовательность действий, связанная с 

выбором логического диска, папки (директории), в которой хранится уже 

созданный файл, полностью соответствует примеру 1 данного раздела, 

однако в данном случае необходимо выбрать другой файл (например, 

Example3.db) в списке Resume DataBase From, в котором хранится третья 

созданная модель. 

 

Шаг 2. Выбор типа элемента для разбиения 

Указываем тип элементов, с помощью которых будем создавать 

разбиение. Будем пользоваться при этом пунктом главного меню: 

Main Menu> Preprocessor> Element Type> Add/Edit/Delete 
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Последовательность действий аналогична соответствующему шагу 

примера 1.  

В этом случае из раздела Structural Solid (т.к. решается задача 

структурного анализа) необходимо выбрать элемент Tet 10node 187 (Рисунок 

134). 

 

 
Рисунок 134. Выбор из раздела Structural Solid окна Library of Elements 

элемента Tet 10node 187 

 

 

Шаг 3. Построение свободного разбиения на тетраэдрические 

элементы с использованием SmartSize 

Средства MeshTool 

Main Menu> Preprocessor> Meshing> MeshTool… 

Для построения свободного разбиения:  

 Во второй секции окна MeshTool устанавливаем флаг  в 

переключателе Smart Size и устанавливаем уровень разбиения 8. 

З а м е ч а н и е! Установить менее грубый уровень разбиения при решении 

занной задачи не позволяют ограничения на количество элементов. 

 Выбираем форму элементов, а именно пункт Tet, – для того 

чтобы разбиение было выполнено тетраэдрами элементами. 

 Выбираем вид разбиения, а именно пункт Free, – разбиение 

должно быть свободным (Рисунок 135). 
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Рисунок 135. Четвертая секция MeshTool с включенными опциями 

свободного разбиения 

 

 Нажимаем кнопку Mesh.  

 С помощью появившегося окна выбора Mesh Volumes указываем 

с помощью кнопки Pick All, что собираемся разбивать все 

созданные объемы. 

 

Пункты главного меню 

Устанавливаем параметры Smart Size с помощью пункта меню: 

Main Menu> Preprocessor> Meshing> Size Ctrls> SmartSize> Basic 

При использовании данного пункта меню появится окно 

Basic SmartSize Settings (Рисунок 136), в котором необходимо выбрать в 

выпадающем списке уровень размера элементов при разбиении и после 

выбора нажать OK.  

 

 
Рисунок 136. Вид окна Basic SmartSize Settings 

 

Построение свободного разбиения осуществляется с помощью пункта 

меню: 

Main Menu> Preprocessor> Meshing> Mesh> Volumes> Free 
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При его использовании появляется окно выбора Mesh Volumes, с 

помощью которого указываем все разбиваемые на элементы поверхности c 

помощью кнопки Pick All (Рисунок 137). 

Список команд 

SMRTSIZE,8 

MSHKEY,0 

MSHAPE,0,3-D 

VMESH,ALL 

Результаты выполнения шага 3 

 
Рисунок 137. Результаты построения свободного разбиения 

 

Шаг 4. Сохранение измененной модели в db-файле 

Для этого используем пункт меню: 

Utility Menu> File> Save as… 

При использовании пункта меню утилит появляется окно 

Save DataBase. В этом случае следует: 

 Выбрать в выпадающем списке Drives диск, на котором хранится 

уже созданный файл. 

 Выбрать в списке Directories папку, в которой хранится файл. 
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 В списке Save DataBase to выбрать имя существующего файла, в 

котором хранится модель примера 3 (например, Example3.db). 

 Нажать кнопку OK (Рисунок 138). 

Результат построения конечноэлементной модели для примера 3 

 
Рисунок 138. Конечноэлементная модель примера 3 

 

Пример 4. Распределение температур в поперечном сечении строительного 

перекрытия  

Шаг 1. Чтение существующей модели из db-файла 

Для этого используем пункт меню: 

Utility Menu> File> Resume from… 

При использовании пункта меню утилит появляется окно 

Resume DataBase From. В этом случае следует: 

 Выбрать в выпадающем списке Drives диск, на котором хранится 

уже созданный файл. 

 Выбрать в списке Directories папку, в которой хранится файл. 

 В списке Resume DataBase From выбрать имя существующего 

файла, в котором хранится модель примера 4 (например, 

Example4.db). 

 Нажать кнопку OK. 
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Шаг 2. Выбор типа элемента для разбиения 

Указываем тип элементов, с помощью которых будем создавать 

разбиение. Будем пользоваться при этом пунктом главного меню: 

Preprocessor> Element Type> Add/Edit/Delete 

В этом случае из раздела Thermal Solid (т.к. решается задача 

теплообмена) необходимо выбрать элемент Triangle 6node 35 (Рисунок 139). 

 

 
Рисунок 139. Выбор из раздела Thermal Solid окна Library Element Types 

элемента Triangle 6node 35 

 

 

Шаг 3. Построение свободного разбиения на треугольные элементы с 

использованием Smartsize 

Средства MeshTool 

Main Menu> Preprocessor> MeshTool… 

Для построения свободного разбиения:  

 Во второй секции окна MeshTool устанавливается флаг  в 

боксе с меткой Smart Size и устанавливаем уровень разбиения 6. 

 Выбираем форму элементов, а именно пункт Tri – для того чтобы 

разбиение было выполнено треугольными элементами (Рисунок 

140). 

З а м е ч а н и е! В данном случае, переключение опций Tri или Quad 

формально, т.к. Triangle 6node 35 являются треугольными элементами. 
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 Выбираем вид разбиения, а именно пункт Free – разбиение 

должно быть свободным (Рисунок 140). 

 

 
Рисунок 140. Четвертая секция MeshTool с включенными опциями 

свободного разбиения 

 

 Нажимаем кнопку Mesh.  

 С помощью появившегося окна выбора Mesh Areas указываем с 

помощью кнопки Pick All, что собираемся разбивать все 

созданные поверхности на элементы. 

 

Пункты главного меню 

Устанавливаем параметры Smart Size с помощью пункта меню: 

Main Menu> Preprocessor> Meshing> Size Ctrls> SmartSize> Basic 

При использовании данного пункта меню появится окно 

Basic SmartSize Settings, в котором необходимо выбрать в выпадающем 

списке уровень размера элементов (в данном случае 6) при разбиении и после 

выбора нажать OK.  

Построение свободного разбиения осуществляется с помощью пункта 

меню: 

Main Menu> Preprocessor> Meshing> Mesh> Areas> Free 

При его использовании появляется окно выбора Mesh Areas, с 

помощью которого указываем все разбиваемые на элементы поверхности c 

помощью кнопки Pick All. 

Список команд 

SMRTSIZE,6 
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MSHKEY,0 

MSHAPE,0,2-D 

AMESH,1 

 

Шаг 4. Сохранение измененной модели в db-файле 

Для этого используем пункт меню: 

Utility Menu> File> Save as… 

При использовании пункта меню утилит появляется окно 

Save DataBase. В этом случае следует: 

 Выбрать в выпадающем списке Drives диск, на котором хранится 

уже созданный файл. 

 Выбрать в списке Directories папку, в которой хранится файл. 

 В окне Save DataBase to выбрать имя существующего файла, в 

котором хранится модель примера 4 (например, Example4.db). 

 Нажать кнопку OK (Рисунок 141). 

 

Результат построения конечноэлементной модели для примера 4 

 
Рисунок 141. Конечноэлементная модель примера 4 
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Пример 5. Изгиб пружины с шагом витка 0,006 m под действием силы 

тяжести 

Шаг 1. Чтение существующей модели из db-файла 

Для этого используем пункт меню: 

Utility Menu> File> Resume from… 

При использовании пункта меню утилит появляется окно 

Resume DataBase From. В этом случае следует: 

 Выбрать в выпадающем списке Drives диск, на котором хранится 

уже созданный файл. 

 Выбрать в списке Directories папку, в которой хранится файл. 

 В списке Resume DataBase From выбрать имя существующего 

файла, в котором хранится модель примера 5 (например, 

Example5.db). 

 Нажать кнопку OK. 

 

Шаг 2. Выбор типа элемента для разбиения. Просмотр эскиза и 

разбиения поперечного сечения 

Указываем тип элементов, с помощью которых будем создавать 

разбиение. Будем пользоваться при этом пунктом главного меню: 

Main Menu> Preprocessor> Element Type> Add/Edit/Delete 

Последовательность действий см. пример 2.  

В этом случае из раздела Structural Beam (т.к. решается задача 

структурного анализа для балок) необходимо выбрать элемент 3D 3 node 189 

(Рисунок 142). 

 

 
Рисунок 142. Выбор из раздела Structural Beam окна Library Element Types 

элемента 3D 3 node 189 
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Шаг 3. Выбор поперечного сечения балочных элементов 

Выбор поперечного сечения осуществяется с помощью окна Beam Tool, 

которое можно вызвать с помощью пункта главного меню: 

Main Menu> Preprocessor> Sections> Beam> Common Sections 

 В выпадающем списке Sub Type первой секции окна Beam Tool 

(Рисунок 143) указываем номер («по умолчанию» - 1, кроме того, 

все балки - одинакового сечения, и другой номер не 

понадобится), выбираем форму поперечного сечения балки (в 

данном случае двутавровое): 

 Во второй секции окна Beam Tool оставляем установки «по 

умолчанию» (Рисунок 144). 

 В третьей секции окна Beam Tool определеяем значения 

параметров сечения в соответствии с чертежом (Рисунок 145). 

 

 
Рисунок 143. Первая секция окна Beam Tool 

 

 
Рисунок 144. Вторая секция окна Beam Tool 

 

 
Рисунок 145. Третья секция окна Beam Tool 
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З а м е ч а н и е! В данном случае, безусловно необходимо было 

использовать круглое сечение балочного элемента по геометрическим 

соображениям. Однако авторами выбрано одно из специфических 

сечений, для того чтобы продемонстрировать технику работы с 

Beam Tool. 

 В четвертой секции окна Beam Tool (Рисунок 146) устанавливаем 

уровень качества разбиения (в данном случае 3). 

 

 
Рисунок 146. Четвертая секция окна Beam Tool 

З а м е ч а н и е! Данная секция для многих видов поперечного сечения 

отсутствует, тогда пользователю предоставляется возможность 

самостоятельно указать количество сечений на элементы по двум 

наравлениям. 

 Для просмотра эскиза поперечного сечения в пятой секции окна 

Beam Tool нажимаем кнопку Preview (Рисунок 147). После этого 

в основном окне ANSYS Graphics появляется эскиз профиля 

сечения. 

 

 
Рисунок 147. Последняя секция окна Beam Tool 

З а м е ч а н и е! Увидеть профиль построенного сечения в окне 

ANSYS Graphics можно также с использованием пункта меню 

Main Menu> Preprocessor> Sections> Beam> Plot Section… . После его 

использования появляется окно Plot Beam Section, в котором необходимо 

указать ID (номер) сечения, которое необходимо просмотреть («по 

умолчанию» равно 1). После этого в основном окне ANSYS Graphics 

появляется эскиз профиля сечения (Рисунок 148). 
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Рисунок 148. Эскиз поперечного сечения балочного элемента 

 

 Для просмотра разбиения поперечного сечения в пятой секции 

окна Beam Tool нажимаем кнопку Meshview. После этого в 

основном окне ANSYS Graphics появляется эскиз 

конечноэлементного разбиения поперечного сечения (Рисунок 

149). Этот же результат можно получить с помощью пункта 

главного меню Main Menu> Preprocessor> Sections> Beam> 

Plot Section… . Для этого в окне Plot Beam Section следует 

установить флаг  в разделе Show section mesh? и нажать 

кнопку OK. 

 

 
Рисунок 149. Конечноэлементное разбиение поперечного сечения 

балочного элемента 
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Шаг 4. Включение нумерации ключевых точек и линий 

Необходимо использовать пункт меню утилит: 

Utility Menu> PlotCtrl> Numbering… 

 

Шаг 5. Отображение ключевых точек 

Пункт меню утилит 

Utility Menu> Plot> Keypoints> Keypoints 

При использовании данного пункта меню утилит останутся 

отображенными только ключевые точки и их порядковые номера (Рисунок 

150).  

Команда 

KPLOT,ALL 

Результаты выполения шага 5 

 
Рисунок 150. Ключевые точки модели примера 5 
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Шаг 6. Создание вспомагательных линий 

Пункт главного меню 

Создаем прямые линии, соединяющие ключевые точки 1 и 2, 3 и 7. 

Используется пункт главного меню (Рисунок 151): 

Main Menu> Preprocessor> Modeling> Create> Lines> Lines> Straight Line 

Список команд 

LSTR,1,2 

LSTR,3,7 

Результаты выполения шага 6 

 
Рисунок 151. Результаты построения вспомогательных линий 

 

 

Шаг 7. Деление сплайна (пружины) на несколько секций с помощью 

вспомагательной прямой линии 

Каждая секция совпадает с полным оборотом спирали. Это позволит на 

следующих шагах назначить отдельные ключевые точки для каждой секции. 
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Пункт главного меню 

Main Menu> Preprocessor> Modeling> Operate> Booleans> Divide> 

Line by Line 

 С помощью появившегося первого окна выбора 

Divide Line by Line выбираем сплайн (L74) 

 Нажимаем OK. 

 С помощью появившегося второго окна выбора 

Divide Line by Line выбираем линию, с помощью которой будем 

делить сплайн (L6) 

 Нажимаем OK. 

Команда 

LSBL,74,6,,DELETE,DELETE 

 

Шаг 8. Создание точек ориентации для каждой секции сплайна с 

помощью деления осевой линии L5 

Совместное использование пунктов главного меню и меню выбора 

Select Entities 

Пункт меню утилит: 

Utility Menu> Select> Entities… 

 Выбраем раздел Lines в первом выпадающем списке первой 

секции окна Select Entities. 

 Во втором выпадающем списке выбираем раздел By Num/Pick. 

 Нажимаем кнопку Apply или OK. 

 Выбираем линию L5 с помощью появившегося окна выбора 

Select Lines.  

 Нажимаем кнопку OK в окнe выбора Select Entities.  

 Перересовываем выбранные компоненты с помощью пункта 

меню утилит Utility Menu> Plot> Replot. 

 Делим линию L5 на 5 отрезков с использованием пункта главного 

меню: Main Menu> Preprocessor> Modeling> Operate> Booleans> 

Divide> Line into N Ln’s 
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 В этом случае выбираем линию L5 с помощью окна выбора 

Div Line into N Lines. 

 Нажимаем кнопку OK. 

 В появившемся втором окне Div Line into N Lines с меткой NDIV 

указываем количество делений 5. 

 Нажимаем кнопку OK (Рисунок 152). 

 

 
Рисунок 152. Результаты деления на отрезки осевой линии 

 

 Удаляем все отрезки оставляя ключевые точки их концов с 

помощью пункта меню Main Menu> Preprocessor> Modeling> 

Delete> Lines Only. С помощью появившегося окна выбора 

выбираем все линии L5, L6, L12, L13, L14, нажимаем кнопку OK. 

 Нажимаем кнопку Sele All в меню Select Entities. 

 Сжимаем нумерацию ключевых точек и линий с помощью пункта 

главного меню: Main Menu> Preprocessor> Numbering Ctrls> 

Compress Numbers…. Для этого в выпадающем списке 

появившегося окна Conpress Numbers выбираем раздел Keypoints, 

нажимаем Apply, а затем Lines и нажимаем OK. 

 Отображаем построенные ключевые точки (Рисунок 153) с 

помощью пункта меню утилит Utility Menu> Plot> Keypoints> 

Keypoints. 

 

З а м е ч а н и е! Пострроенные ключевые точки 1, 2, 12-15 (Рисунок 153) 

являются точками ориентации для отдельных витков пружины.  



 

 

186 

 

 
Рисунок 153. Отображение ключевых точек преобразованной модели 

модели 

 

 Отображаем построенные линии с помощью пункта меню утилит 

Utility Menu> Plot> Lines. 

 Отключаем нумерацию ключевых точек с помощью пункта меню 

(Рисунок 154): Utility Menu> Plot Ctrls> Numbering…. 

 
Рисунок 154. Отображение линий модели примера 5 

 

Шаг 9. Назначение точек ориентации для балочных элементов 

Пункт главного меню 

Main Menu> Preprocessor> Meshing> Mesh Attributes> Pick Lines… 
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 При использовании этого пункта меню появляется первое окно 

выбора Line Attributes, с помощью которого выбираем линии 

линии L1-L4, составляющие окружность. 

 Нажимаем OK. 

 Появляется второе окно Line Attributes, в котором в 

переключателе Pick Orientation Keypoint(s) устанавливаем флаг 

.  

 Нажимаем кнопку OK.  

 Появится третье окно выбора Line Attributes, с помощью 

которого необходимо указать в качестве точек ориентации 

ключевую точку 1. 

 Нажимаем кнопку Apply. 

 Далее с помощью первого окно выбора Line Attributes выбираем 

линии линию L5, представялющую первый (дальний от 

пользователя) виток пружины. 

 Нажимаем OK. 

 Появляется второе окно Line Attributes, в котором в боксе с 

меткой Pick Orientation Keypoint(s) устанавливаем флаг .  

 Появится третье окно выбора Line Attributes с помощью которого 

необходимо указать в качестве точек ориентации 

последовательно две точки ориентации: ключевую точку 1 и 

ключевую точку 12. 

 Повторяем эти действия, назначая ключевые точки ориентации 

для каждого витка пружины: 

Линии Точки ориентации 

L5 1 12 

L7 12 13 

L8 13 14 

L9 14 15 

L6 15 2 

Список команд 

LSEL,S,Line,,1,4,1 
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LATT,1,1,1,,1,1,1 

LSEL,S,Line,,5 

LATT,1,1,1,,1,12,1 

LSEL,S,Line,,6 

LATT,1,1,1,,15,2,1 

LSEL,S,Line,,7 

LATT,1,1,1,,12,13,1 

LSEL,S,Line,,8 

LATT,1,1,1,,13,14,1 

LSEL,S,Line,,9 

LATT,1,1,1,,14,15,1 

LSEL,ALL 

 

Шаг 10. Построение разбиения балочными элементами с 

использованием SmartSize 

Main Menu> Preprocessor> Meshing> MeshTool 

Значение SmartSize равно 4. Форма элементов не выбирается.  

 Нажимаем кнопку Mesh.  

 В окне выбора нажимаем Pick All. 

 

Шаг 11. Сохранение измененной модели в db-файле 

Для этого используем пункт меню: 

Utility Menu> File> Save as… 

При использовании пункта меню утилит появляется окно 

Save DataBase. В этом случае следует: 

 Выбрать в выпадающем списке Drives диск, на котором хранится 

уже созданный файл. 
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 Выбрать в списке Directories папку, в которой хранится файл. 

 В списке Save DataBase to выбрать имя существующего файла, в 

котором хранится модель примера 5 (например, Example5.db). 

 Нажать кнопку OK (Рисунок 155). 

 

Результат построения конечноэлементной модели для примера 5 

 
Рисунок 155. Результаты построения конечноэлементного разбиения 

примера 5 
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